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Caution on Installation

NO LIABILITY IS ASSUMED FOR ANY DAMAGE CAUSED BY IMPROPER INSTALLATION.

Notice on Software

SOFTWARE USED WITH THIS PRINTER MUST SUPPORT THE PRINTER’'S EMULATION MODE. The printer is factory-set to
emulate the PCL. The emulation mode can be changed by following the procedures described in Chapter 1.

Notice on This Guide

The information in this guide is subject to change without notification. Additional pages may be inserted in future editions. The user
is asked to excuse any technical inaccuracies or typographical errors in the present edition.

No responsibility is assumed if accidents occur while the user is following the instructions in this guide. No responsibility is assumed
for defects in the printer’s firmware (contents of its read-only memory).

This guide, any copyrightable subject matter sold or provided with or in connection with the sale of the page printer, are protected by
copyright. All rights are reserved. Copying or other reproduction of all or part of this guide, any copyrightable subject matter without
the prior written consent of Kyocera Corporation is prohibited. Any copies made of all or part of this guide, any copyrightable subject
must contain the same copyright notice as the material from which the copying is done.

Regarding Tradenames

PRESCRIBE is a registered trademark of Kyocera Corporation. KPDL and KIR (Kyocera Image Refinement) are trademarks of Kyo-
cera Corporation.

Diablo 630 is a product of Xerox Corporation. IBM Proprinter X24E is a product of International Business Machines Corporation.
Epson LQ-850 is a product of Seiko Epson Corporation.

Hewlett-Packard, PCL, and PJL are registered trademarks of Hewlett-Packard Company. Centronics is a trade name of Centronics
Data Computer Inc. PostScriptis aregistered trademark of Adobe Systems Incorporated. Macintosh is a registered trademark of Apple
computer, Inc. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation. PowerPC and Microdrive
are trademarks of International Business Machines Corporation. CompactFlash is a trademark of SanDisk Corporation. ENERGY
STAR is a U.S. registered mark. All other brand and product names are registered trademarks or trademarks of their respective
companies.

This Kyocera Mita page printer uses PeerlessPrintXL to provide the HP Laserdet compatible PCL6 language emulation. Peer-
lessPrintXLis a trademark of The Peerless Group, Redondo Beach, CA 90278, U.S.A.

This product was developed using the Tornado™ Real Time Operating System and Tools from Wind River Systems.

AGFA @ This product contains UFST™ and MicroType® from Agfa Corporation.

— usB

©2001, 2002 by KYOCERA CORPORATION. All rights reserved
Revision 1.1 February 2002
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IBM PROGRAM LICENSE AGREEMENT

THE DEVICE YOU HAVE PURCHASED CONTAINS ONE OR MORE SOFTWARE PROGRAMS ("PROGRAMS") WHICH BELONG
TO INTERNATIONAL BUSINESS MACHINES CORPORATION ("IBM"). THIS DOCUMENT DEFINES THE TERMS AND CON-
DITIONS UNDER WHICH THE SOFTWARE ISBEING LICENSED TOYOU BYIBM.IF YOU DO NOT AGREE WITH THE TERMS
AND CONDITIONS OF THIS LICENSE, THEN WITHIN 14 DAYS AFTER YOUR ACQUISITION OF THE DEVICE YOU MAY
RETURN THE DEVICE FORA FULL REFUND. IF YOU DO NOT SO RETURN THE DEVICE WITHIN THE 14 DAYS, THEN YOU
WILL BE ASSUMED TO HAVE AGREED TO THESE TERMS AND CONDITIONS.

The Programs are licensed not sold. IBM, or the applicable IBM country organization, grants you a license for the Programs only in the
country where you acquired the Programs. You obtain no rights other than those granted you under this license.

The term "Programs" means the original and all whole or partial copies of it, including modified copies or portions merged into other
programs. IBM retains title to the Programs. IBM owns, or has licensed from the owner, copyrights in the Programs.

1. License

Under this license, you may use the Programs only with the device on which they are installed and transfer possession of the Programs
and the device to another party.

If you transfer the Programs, you must transfer a copy of this license and any other documentation to the other party. Your license is
then terminated. The other party agrees to these terms and conditions by its first use of the Program.

You may not:

1) use, copy, modify, merge, or transfer copies of the Program except as provided in this license;
2) reverse assemble or reverse compile the Program; or
3) sublicense, rent, lease, or assign the Program.

2. Limited Warranty
The Programs are provided "AS IS."

THERE ARE NO OTHER WARRANTIES COVERING THE PROGRAMS (OR CONDITIONS), EXPRESS OR IMPLIED, INCLUD-
ING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

3. Limitation of Remedies
IBM’s entire liability under this license is the following;

1) For any claim (including fundamental breach), in any form, related in any way to this license, IBM’s liability will be for actual
damages only and will be limited to the greater of:

a) the equivalent of U.S.$25,000 in your local currency; or
b) IBM’s then generally available license fee for the Program

This limitation will not apply to claims for bodily injury or damages to real or tangible personal property for which IBM is legally liable.

IBM will not be liable for any lost profits, lost savings, or any incidental damages or other economic consequential damages, even if
IBM, or its authorized supplier, has been advised of the possibility of such damages. IBM will not be liable for any damages claimed by
you based on any third party claim. This limitation of remedies also applies to any developer of Programs supplied to IBM. IBM’s and
the developer’s limitations of remedies are not cumulative. Such developer is an intended beneficiary of this Section. Some jurisdictions
do not allow these limitations or exclusions, so they may not apply to you.

4. General

You may terminate your license at any time. IBM may terminate your license if you fail to comply with the terms and conditions of this
license. In either event, you must destroy all your copies of the Program. You are responsible for payment of any taxes, including
personal property taxes, resulting from this license. Neither party may bring an action, regardless of form, more than two years after
the cause of action arose. If you acquired the Program in the United States, this license is governed by the laws of the State of New York.
If you acquired the Program in Canada, this license is governed by the laws of the Province of Ontario. Otherwise, this license is
governed by the laws of the country in which you acquired the Program.
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Typeface Trademark Acknowledgement

All resident fonts in this printer are licensed from Agfa Corporation.

Helvetica, Palatino and Times are registered trademarks of Linotype-Hell AG.

ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and ITC Zapf Dingbats are registered trademarks of International Type-
face Corporation.

Agfa Japan License Agreement

1.

10.

11.

12.

“Software” shall mean the digitally encoded, machine readable, scalable outline data as encoded in a special format as well as the
UFST Software.

You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and versions of letters,
numerals, characters and symbols (“Typefaces”) solely for your own customary business or personal purposes at the address stated
on the registration card you return to Agfa Japan. Under the terms of this License Agreement, you have the right to use the Fonts
onup to three printers. If you need to have access to the fonts on more than three printers, you need to acquire a multi-user license
agreement which can be obtained from Agfa Japan. Agfa Japan retains all rights, title and interest to the Software and Typefaces
and no rights are granted to you other than a License to use the Software on the terms expressly set forth in this Agreement.

To protect proprietary rights of Agfa Japan, you agree to maintain the Software and other proprietary information concerning the
Typefaces in strict confidence and to establish reasonable procedures regulating access to and use of the Software and Typefaces.
You agree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy. You agree that any such
copy shall contain the same proprietary notices as those appearing on the original.

This License shall continue until the last use of the Software and Typefaces, unless sooner terminated. This License may be
terminated by Agfa Japan if you fail to comply with the terms of this License and such failure is not remedied within thirty (30)
days after notice from Agfa Japan. When this License expires or is terminated, you shall either return to Agfa Japan or destroy all
copies of the Software and Typefaces and documentation as requested.

You agree that you will not modify, alter, disassemble, decrypt, reverse engineer or decompile the Software.
Agfa Japan warrants that for ninety (90) days after delivery, the Software will perform in accordance with Agfa Japan-published

specifications, and the diskette will be free from defects in material and workmanship. Agfa Japan does not warrant that the
Software is free from all bugs, errors and omissions.

THE PARTIES AGREE THAT ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FIT-
NESS FOR A PARTICULAR PURPOSE AND MERCHANTABILITY, ARE EXCLUDED.

Your exclusive remedy and the sole liability of Agfa Japan in connection with the Software and Typefaces is repair or replacement
of defective parts, upon their return to Agfa Japan.

IN NO EVENT WILL AGFA JAPAN BE LIABLE FOR LOST PROFITS, LOST DATA, OR ANY OTHER INCIDENTAL OR CON-

SEQUENTIAL DAMAGES, ORANY DAMAGES CAUSED BY ABUSE OR MISAPPLICATION OF THE SOFTWARE AND TYPE-
FACES.

New York, U.S.A. law governs this Agreement.

You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written consent of Agfa
Japan.

Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rightsin Technical Data and Computer
Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c¢)(1)(ii), as appropriate. Further use, duplication or
disclosure is subject to restrictions applicable to restricted rights software as set forth in FAR 52.227-19 (¢)(2).
YOUACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT,AND AGREE TOBE BOUNDBY ITS
TERMS AND CONDITIONS. NEITHER PARTY SHALL BE BOUND BY ANY STATEMENT OR REPRESENTATION NOT
CONTAINED IN THIS AGREEMENT. NO CHANGE IN THIS AGREEMENT IS EFFECTIVE UNLESS WRITTEN AND
SIGNED BY PROPERLY AUTHORIZED REPRESENTATIVES OF EACH PARTY. BY OPENING THIS DISKETTE PACKAGE,
YOU AGREE TO ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT.

Cautions for Toner Handling

Do not incinerate toner and toner containers. Dangerous sparks may cause burn.
Never open the toner container or waste toner box.

Make sure not to inhale the toner, and not to rub your eyes or touch your mouth with the hands stained with the toner. And make
sure not to stick to your skin.

For the disposal of old toner container and waste toner box, consult your dealer. Or dispose of the toner or toner containers in
accordance with Federal, state and Local rules and regulations.

Keep away the toner container and the waste toner box from children.
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Introduction

The Kyocera Mita page printer has many extremely desirable features. It was designed to
make a contribution to a cleaner environment as well as to represent the latest generation of
page printer technology.

This section contains the following subsections.

* Features
For More Information...
* Guide to the Operation Guide
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Features

Ultra long life modules
The drum, developer, and fuser have been designed for ultra long life.

Amorphous silicon drum

The drum has been developed using Kyocera’s unique ceramic technology
using amorphous silicon.

KIR (Kyocera Image Refinement)

This is Kyocera’s original smoothing function. It uses software to enhance
the printer’s resolution and produce high-quality printing. The default
setting is On.

Superb print quality

Using 1200 dpi resolution in Fast 1200 mode, the printout is close to
typeset quality. Also, with Kyocera Image Refinement (KIR) technology,
high quality printing can be achieved even at 300 dpi and 600 dpi.

Large paper capacity

Approximately 500 sheets can be loaded into the paper cassette, and about
100 sheets can be loaded into the MP tray.

Wide variety of print media

As well as standard paper, the printer will print on transparency, labels
and other types of special purpose media.

Sleep Mode
Conserves energy during the printer’s idle periods.

Ecoprint
Extends the toner yield by reducing the amount of toner used on the page.

USB (Universal Serial Bus) Interface

This printer supports USB Revision 1.1 standards. Connection to a
computer with a USB interface gives a higher communication speed than
parallel interface connection.

Standard Bi-directional Parallel Interface
Supports high-speed data exchange with the computer.
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Wide Variety of Available Fonts

The printer comes with 80 PCL/PS compatible fonts and a line printer
bitmap font installed.

PRESCRIBE Command Language

PRESCRIBE provides features including advanced graphics capabilities
that allow you to print any conceivable outline shape or solid form. Also
provided are a variety of special effects, such as patterned fills, gray-scale
shading, a user-accessible print image model, and multiple page
orientations and print directions within the same page.

Job Retention

Allows you to save print jobs onto the Microdrive installed in the printer. It
print them out later at the operator panel. The following four types of job
retention are available: quick copy, proof and hold, private printing, and
stored jobs.

Display of printer messages in any of five languages

English, French, German, Italian, or Spanish. As an option it is also
possible to download the messages in other languages. Please contact your
Kyocera Mita dealer.

Microdrive (hard disk unit) slot for various functions such as job
retention, VMB, and more

By saving print jobs onto the Microdrive, they can be printed out at the
operator panel when desired. The electronic sort function can be used for
much faster printing.

CompactFlash card slot for option fonts, macros, forms, etc.

Data in the CompactFlash card can be selectively read from the printer’s
operator panel.

PDF417 Two-dimensional Barcode

The printer includes a capability that allows the user to implement two-
dimensional stacked barcode symbology PDF417 (Portable Data File 417).

SNMP compliance

The printer complies with Simple Network Management Protocol (SNMP).
The SNMP is used for providing and transferring management information
(MIB) between the printer and the host computer.

Support for network printer monitor utility (KM-NET VIEWER)

Allows network wide management of printers. See the readme file in the
Kyocera Mita Digital Library CD-ROM (comes with the printer) for details.

Xi
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For More Information...

Item Description

Installation Guide Describes procedures from printer setup to printing

(paper manual) a test page.

Operation Guide Guides you through topics concerning the

(this guide) operations and maintenance of the printer.

Printer Driver Guide Describes how to install and set the printer driver.
This manual is contained in the CD-ROM supplied
with the printer.

PRESCRIBE Programming | Describes how to use the PRESCRIBE commands

Manual and their parameters in detail for experienced

users. This manual is contained in the CD-ROM
supplied with the printer.

PDF417 Two-Dimensional Includes a PDF417 overview and explains
Bar Code Implementation PRESCRIBE commands for use with
Manual two-dimensional barcodes. This manual is
contained in the CD-ROM supplied with the
printer.

Guide to the Operation Guide

This Operation Guide has the following chapters:

Chapter 1 Using the Operator Panel

This chapter explains the message display, indicators and keys on the
operator panel, and how to make various settings from the operator panel.

Chapter 2 Paper Selection
This chapter explains the types of paper that can be used with the printer.

Chapter 3 Maintenance

This chapter explains how to replace the toner container, waste toner box,
and how to care for your printer.

Chapter 4 Troubleshooting

This chapter explains how to handle printer problems that may occur, such
as paper jams.

Appendix A Fonts

This appendix explains about fonts and lists the printer’s internal fonts.

Xii
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Appendix B Options

This appendix explains how to expand the printer's memory and how to
install each option unit.

Appendix C Host Computer Interface

This appendix explains the pin assignment and specifications for the
printer’s parallel interface, USB interface, and optional serial interface.

Appendix D Specifications

This appendix lists the printer’s specifications.

Glossary

This glossary explains the terminology used in this guide.

The following symbols are used to attract your attention in this guide. The
symbols and their meanings are as follows:

Indicates tips or advice useful for operation.

Indicates situations that are potentially hazardous to the human body or
devices.

Indicates situations that are potentially extremely hazardous to the
human body or devices.

Indicates operations that can be performed or are effective only when the
required option unit is installed.

Xiii
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Chapter1  Using the Operator
Panel

This chapter explains the following topics:

* Understanding the Operator Panel
* Printing Test Pages

* Paper Handling

+ Pagination

+ e-MPS

+ Interface

* Operating the Storage Device

* Configuration

1-1
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Understanding the Operator Panel

Understanding the Operator Panel

Message Display

The operator panel has a LCD message display, three indicators, and eight

keys.

Messages that appear on the display and functions of indicators and keys
are explained in the sections that follows.

The message display gives information in the form of short messages. The
eight messages listed below are displayed during normal warm-up and

printing.

Other messages that may appear when the printer needs the operator’s
attention are explained in Chapter 4.

Message

Meaning

Self test

The printer is self-testing after power-up.

Please wait

The printer is warming up and is not ready. When
the printer is switched on for the first time after the
toner container is installed, (Adding toner)
also appears.

Ready The printer is ready to print.

Processing The printer is receiving data, generating graphics,
reading a CompactFlash card/Microdrive, or
printing.

Sleeping The printer is in sleep mode. The printer wakes

from sleep mode whenever the GO key on the
operator panel is pressed, the cover is opened or
closed, or data is received. The printer then warms
up and goes online. The time that the printer takes
to enter sleep mode depends on the sleep timer
setting.

Cancelling data

Jobs inside the printer are being canceled. To cancel
ajob, see the table on page 1-5.

Waiting

The printer is waiting for the end-of-job command
before printing the last page. Pressing the GO key
allows you to obtain the last page immediately.

FormFeed Time Out

The printer is printing the last page after a waiting
period.

1-2
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INTERFACE
==

Interface Indicator =

Understanding the Operator Panel

The interface indicator shows the interface that is currently used. It uses
the following abbreviations:

PAR
USB
SER
OPT

Standard bi-directional parallel interface
Standard USB interface
Option serial interface (RS-232C)
Option network interface card

No interface is active.

interface begins printing the job.

SIZE

Paper Size Indicator Bj

Each interface has a timeout time of 30 seconds during which the other
interface should wait to receive a print job. Even a print job has been
complete on the interface, you should wait for this period until the other

This indicator indicates the paper size of the current paper cassette. The
following abbreviations are used to indicate the paper sizes.

*  With only the MP tray feeding.

Message |Paper Size Message |Paper Size
Display Display
A4 ISOA4 (21x29.7cm) |EX Executive (7-1/4 x 10-1/2 inches)
A5 ISOA5(14.8x21cm) |#6 Commercial 6-3/4
(8-5/8 x 6-1/2 inches)”
A6 ISO A6 . #9 Commercial 9 i}
(10.5x 14.8 cm) (3-7/8 x 8-7/8 inches)
B5 JISB5(18.2x25.6cm) |02 Oficio IT (8-1/2 x 13 inches)*
B6 JIS B6 . ST Statement (5-1/2 x 8-1/2 inches)”
(12.8 x 18.2cm)
LT Letter FO Folio (210 x 330 mm)"
(8-1/2 x 11 inches)
LG Legal HA Japanese Postcard (10 x 14.8 em)”
(8-1/2 x 14 inches)
MO Monarch . |CH Return Postcard (20 x 14.8 cm)”
(3-7/8 x 7-1/2 inches)
BU Business .| Y2 Envelope (Youkei 2)
(4-1/8 x 9-1/2 inches)" (114 x 162 mm)"
DL ISODL(11x22cm)” |v4 Envelope (Youkei 4)
(105 x 235 mm)"
C5 ISOC5 cu Custom Size
(16.2x 22.9 cm)” (14.8 x 21 cm to 21.6 x 35.6 cm)
b5 ISOB5 (17.6 x 25 ¢cm)”

While the printer is processing data, the SIZE indicator indicates the
paper size selected by the application software.

Note

1-3
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Understanding the Operator Panel

TYPE
Paper Type Indicator D@
This shows the paper type defined for the current paper casette. Automatic
cassette switching is available according to the paper type.

The paper type can be specified at the operator panel. See Custom Paper
Type on page 1-32.

The following abbreviations are used to indicate the paper type.

normal operation and when the
printer needs attention.

Message Display |Paper Type Message Display | Paper Type
None Auto ROUGH Rough
PLAIN Plain LETTERHEA Letterhead
TRNSPRNCY Transparency* COLOR Color
PREPRINTE Preprinted PREPUNCH Prepunched
LABELS Labels™ ENVELOPE Envelope*
BOND Bond CARDSTOCK Cardstock*
RECYCLED Recycled CUSTOM1 (to 8) Custom 1 (to 8)
VELLUM Vellum*

*  With only the MP tray feeding.

READY, DATA, and ATTENTION Indicators
The following indicators light during \

) = reaoy

:9@ 3 DATA

! 3 ATTENTION

INTERFACE SIZE TYPE
=]

&= R DY
J

Indicator

Description

O 3 READY

Flashing: Indicates when an error occurs that you can clear
by yourself.

Lit: Indicates that the printer is on-line.

The printer prints received data.

Off: Indicates that the printer is off-line. Data can be received
but will not be printed. Also indicates when printing is
automatically stopped due to occurrence of an error.

E(}@ I DATA

Flashing: Indicates data transfer is taking place.
Lit: Indicates either that data is being processed, or that data
is being written to the memory card.

! 1 ATTENTION

Flashing: Indicates when the printer needs maintenance
attention or the printer is warming up (Please wait).

Lit: Indicates when a problem or an error occurs that you can
clear by yourself.

(For example, paper jam occurs.)

1-4
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Understanding the Operator Panel

Keys
The operator panel keys are used to
configure the printer. Note the @ @ @ @
certain keys have the secondary —
function. : :
CANCEL MENU % ENTER
g Settings made with these keys effect only the interface currently in use.
Note
Key Function

» Switches the printer on-line and off-line.
* Prints and feed out one page.
* Cancels specific errors.

CANCEL

* Cancels a printing job.

To cancel, proceed as follows:

1 Check if Processing is displayed in the message display.

2 Press the CANCEL key.

3 Print Cancel? appears in the message display and then interface to be canceled.
Parallel
USB
Serial (appears only when an option serial interface board kit is installed)

Option (appears only when an option network interface card is installed)
Press the CANCEL key again if you wish to stop the cancellation of printing.

4 Select the interface to cancel using the A or V key and then press the ENTER key. Printing
from the selected interface will stop. Cancelling data appears in the message display
and printing stops after the current page is printed.

* Resets numeric values, or cancels a setting procedure.
» Used to stop the sounding of the alarm buzzer an error occurs.

0

MENU

* When pressed during mode selection, terminates the setting and the printer returns to the
Ready condition.

» Used to select the emulation, font, character code set; to read an CompactFlash card, and
more.

Used to access a desired item or enter numeric values. In some of the control procedures, the >
and < keys are used to enter or exit a sub item.

Used to access a desired item or enter of numeric values. In some of the control procedures, the
> and < keys are used to enter or exit a sub item.

Used as the < key in the mode selection function.

* Used as the > key in the mode selection function.

* Displays online help messages on the message display when paper jam errors occur. When
pressed in the Ready condition, displays explanations of online help messages. When pressed
while the online help is displayed, cancels the online help.

0| 0+ (0|0

ENTER

Finalizes numeric values and other selections.

1-5
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Understanding the Operator Panel

Menu System Road Map

This section explains how to use the menu selection system. The MENU key
on the operator panel allows you to use the menu to set or change the
printer environment such as the number of copies to make, emulation, etc.,
to your specific needs. Settings can be made when Ready is indicated on
the printer message display.

The printer obeys the most recently received printer settings sent from

Ready
PAR A4 PLAIN

MENU

Print
Menu Map
Print

Status Page

e-MPS

Continued on next page

0 the application software, or from the printer driver, which take priority

>H>Quick Copy 'I-I

over operator panel settings.

The following is the hierarchy diagram of the menu selection system of the

printer.

The vertical transition is made with the A and V keys and horizontal
transition is made with the > and < keys. To change or finalize
configuration on an item, use the ENTER key.

I:I These items will not appear unless the printer
is installed with the applicable option unit.

|
>Private/Stored n

|
>Print VMB Data n

|
>List of VMB

|
>List of
Code JOB

|

>e-MPS > >>Quick Copy
Configuration

|
>>Temp.Code JOB
Size

|
>>Perm.Code JOB
Size

|
>>VMB Size

1-6
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Continued from previous page

Interface > >Parallel I/F
Parallel Auto
| USB | Normal
| Serial | High Speed
| Option | Nibble (high)

>Baud Rate

9600
|
>Data Bits
8
| |
>Stop Bits
1
|
>Parity
None
| |
>Protocol
DTR (pos.) &XON

>NetWare
Off >>NetWare Frame
| Oon Auto
>TCP/IP
Off ~>DHCP
| on OFF

>Ether Talk

Off >>IP Address

>>Subnet Mask

>>Gateway

>OPT. StatusPage
Off

11 =

Emulation
PCL 6

Emulation > >Print KPDL errs
KPDL Off

I [ on
Emulation > >Alt. Emulation
KPDL (AUTO) PCL 6

Emulation - |
Line Printer >Print KPDL errs
Off

| On

Emulation
IBM Proprinter

Emulation
DIABLO 630

Emulation
EPSON LQ-850

Continued on next page

Understanding the Operator Panel
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Understanding the Operator Panel

Continued from previous page I

Font > Font Select > >> I000
Internal
[ Option | |
| | >>Courier
>Code Set Dark
IBM PC-8 [ Reguiar
L
- | >>Letter Gothic
>List of
Internal Fonts Regular
| park
>List of -
Option Fonts >>Size
012.00
>>Pitch
10.00 cpi
Page Set > >Copies
001
>Orientation
Portrait ]
| Landscape
>Page Protect
Auto
| on
>LF Action
LF only ]
| CrR and LF ]
| Ignore LF
>CR Action
CR only ]
| CrR and LF ]
| Ignore CR
>Wide A4
Off B
| on
Continued on next page
1-8
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Continued from previous page I

Print Quality > ﬁ

>KIR Mode
on ]

| off

>Ecoprint Mode
Of

| Oon

>Resolution
Fast 1200 mode

| 300 dpi

| 600 dpi

>Print Density
03

Hard Disk

RAM Disk Mode
Of £

>Read Data |

>Write Data |

>Delete Data

>List of
Partitions

| On

Memory Card

>RAM Disk Size |

>Read Data |

>Write Data

>Delete Data

>List of
Partitions

Continued on next page

>Read Fonts |

>Read Data |

>Write Data

>Delete Data

>Format

>List of
Partitions

Understanding the Operator Panel
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Understanding the Operator Panel

Continued from Previous page I

Paper Handling > ﬁ

>MP Tray Mode
Cassette

>MP Tray Size
A4 or Letter

>MP Tray Type
Plain

>EF Size
DL or Business

>EF Type
Envelope

>BulkFeeder Size

>BulkFeeder Type
Plain

>Cassette Size >

>>Unit
mm

>Cassette Type
Plain

| inch

>>X Dimension

>Feed Select
Cassette

>>Y Dimension

>Duplex Mode
None

>Stack Select
Face-down tray

>Sorter Mode
Sorter

>Override A4/LT
Off

Oon

>Type Adjust
Custom 1

>

>>Paper weight
Normal

;ji: | I — [ = L | — = [ = = = = —

>Reset Type
Adjust

| Heavy (Thick)

(Thin)

| nLight
|

>>Duplex Path
Enable

Life Counters > H

>Total Print
0123456

>New Toner
Installed

Continued on next page

| Dpisable
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Continued from previous page I

Others

> >MSG Language
English

]

>Form Feed
Time Out 030sec.

>Sleep Timer >
030 min.

>>Sleep Mode
Oon

>Print HEX-DUMP

>Printer Reset

>Resource Prot.
Off

| Permanent

| Perm / Temp

>Buzzer
On

| off

>Auto Continue
Mode Oon

| Mode  oOff

>Service

| off

Understanding the Operator Panel

>>Auto Continue
Timer 030sec.

> >>Print
Status Page
|

>>Developer

>>Drum

* Since this menu is provided for service,
normally you need not use it.

1-1
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Printing Test Pages

Printing Test Pages

This section explains the procedure for printing the printer’s internal
information using the menu selection system. The menu map is usefull as a
reference to guide yourself through the menu selection system.

The status page is a list of parameters and settings for most basic printer
configurations. You may be required to produce a status page when
requesting service to the printer.

Menu Map
The printer prints a full list of menu selection system. Note that menus

indicated on the list may vary depending on which option units are
installed on the printer.

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Menu Map appears.

Print
Menu Map

3 Press the ENTER key. A question mark (?) appears.

Print
Menu Map ?

4 Press the ENTER key again. The printer prints a menu map.

1-12
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Printing Test Pages

Sample MENU MAP

(0 KYOCERA
~Jnita_ Ecosys”\  Fs.1900 Page Printer

MENU MAP

1-13
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Printing Test Pages

Status Page
If you want to check the printer's current status, including memory

available and option settings, you can find the information you need on the
status page.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Print Status Page appears.

Print
Status Page

3 Press the ENTER key. A question mark (?) appears.

Print
Status Page ?

4 Press the ENTER key again. The printer prints a status page.

For a full description of the status page, see the following pages.

1-14
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Printing Test Pages

The following is a sample status page. The numbers below refer to the
contents explained on the following pages.

¢} KYOCERTD
llll.la & o .
~— os1s FS-1900 Page Printer
’ [ Firmware Version: Released: }—— 1
( N\ ( A
Hardware Information Memory
3
> < L J
Page Information (" Installed Options )
: 5
. J J
( Network Status ) (Emulation )
_ D, 7
g J
( Error Log )_— 8
N
Toner Gauge
| . . | 9
0 100
N J
( )
Interfaces
10
- J
[ KIR Test pattern | ON )—— 1

Items and values on the status page may vary depending on the printer’s
firmware version.

fy
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Printing Test Pages

1 — Software Version

This information shows the firmware version and date of issue of the
printer.

2 — Hardware Information

This information shows various printer settings, such as the size and type
of the paper in the paper cassettes.

3 — Memory

This shows the amount of total memory installed in the printer, the
amount of currently available memory, and the current status of the RAM
disk. See Operating the Storage Device on page 1-81.

4 — Page Information

This shows the print resolution, number of copies, and the total page count.

5 — Installation Options

This shows the option(s) installed in the printer.

6 — Network Status

This shows the IP address, Subnet Mask address, and Default Gateway
address for the network interface card installed in the printer.

7 — Emulation

This shows all available emulations of the printer. The printer is shipped
from the factory with PCL 6 emulation selected as the default.

8 — Error Log

This shows the last three instances of the following four types of errors,
listing them in the order of their occurrence: KPDL. Error Press GO;
Memory overflow Press GO; Print overrun Press GO; File not
found Press GO. The most recent error is displayed on the top line of the
Error Log. For error remedies, see section Error Messages on page 4-10.
Error information is cleared when the printer’s power is turned off.

9 — Toner Gauge

This shows the approximate level of remaining toner. When the value is
100, the toner container is full.
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Printing Test Pages

10 — Interface Information

This information shows the default font and the default emulation for all
interfaces installed in the printer.

11 — KIR Test Pattern

KIR is the Kyocera Mita’s original smoothing function. This test pattern
shows the effect of the KIR (Kyocera Image Refinement) system.
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Printing Test Pages

Service Status Page

The service status page contains printer settings information that is more
detailed than the standard status page and is therefore for mostly service
purposes. However, since there is a great deal of information available on
the service status page that may be helpful to you, the procedure for
printing it out is given below.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or Vv key repeatedly until >Service > appears.

W

>Service >

Press the > key.

Press the A or Vv key repeatedly until >>Print Status Page
appears.

o O

>>Print
Status Page

7 Press the ENTER key. A question mark (?) appears.

>>Print
Status Page ?

8 Press the ENTER key again. The printer prints a service status page.

1-18

Download from Www.Somanuals.com. All Manuals Search And Download.



Printing Test Pages

Network Card Interface Status Page

WL\/| b

To use this function, the network interface card must be installed on the
printer.

You can print out a status page for the network interface. The network
interface card status page shows the firmware version, the network
addresses, and other information under various network protocols about
the network interface card. The default setting is On (print). If the setting
is changed to Of £ (not print) as follows, however, the network interface
status page will be printed when the printer status page is printed.

0 Printing out a network interface card status page may not be possible

with some network interface cards. For details, see the manual for the
network interface card.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Interface > appears.

Interface >
Parallel

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/l\

If you want to abandon the interface selection procedure, press the
CANCEL key. The interface remains unchanged.

4 Press the A or Vv key repeatedly until Option appears.

Interface
N,

?
/|\

Option

5 Press the ENTER key again. A > appears.

Interface >
Option

6 Press the > key and then press the A or Vv key repeatedly until the
message display indicates >Opt. StatusPage.

>Opt. StatusPage
On
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Printing Test Pages

7 The default setting is On. If it is set to Of £, change it as follows.
Press the ENTER key. A blinking question mark (?) appears.

1
2 0ff
/|\

>Opt. StatusPage

8 Select On using the A or V key.

>Opt. StatusPage

9 Press the ENTER key again.

On

>Opt. StatusPage

10 Press the MENU key. The message display returns to Ready.

O KHOCERE
i

m FS-1900 Page Printer

NETWORK STATUS PAGE
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Font Lists

Printing Test Pages

To help in selecting fonts, you can print the lists of the fonts including
option fonts.

1
2

W

Press the MENU key.

Press the A or Vv key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or Vv key repeatedly until > Font Selects> appears.

>Font Select >
Internal

To print a list of the internal fonts, check that Internal is
displayed. To print a list of option fonts, press the ENTER key. Press
the A or Vv key repeatedly until the message display indicates
Option and press the ENTER key.

Press the A or Vv key repeatedly until >List of Internal Fonts
or >List of Option Fonts appears.

>List of
Internal Fonts

Press the ENTER key. A question mark (?) appears.

>List of
Internal Fonts?

Press the ENTER key again. Processing appears, then Ready. The
printer prints a list of fonts with a short sample and font ID
(number) for each font.
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Font Lists

e TS
Font Name T tmap] | Password | | Selection (FSETI Font ID
Helvetica-Nr <Scalable> None FSET 1p##vis0b24580T; T041
Helvetica-NrBd <Scalabl FSET i 1042
1043
1044
S TR e e To4s
1047
Font Name ]| itmap] | Password | [ Selection  [FSET) FontD | s
Courier <scalable> None FSET 0p##h0s0b4099T; 1000 Toss
CGTimes <Scalables> None FSET 1pk#v0s0ba101T; 1001 : e
CGTimes-Bd <Scalable> None FSET 1pi#v0s3b4101T; 1002 1051
CGTimes-It N FEET 1017 1003 et
CGTimes-Bdlt <Scalable> None FSET 1p##v1s3be101T; 1004 1053
CGOmega <Scalable> None FSET 1p##v0s0bdlldT; 1005 s
CGOmega-Bd <Scalable> None FSET 1p##v0s3ba113T; 1006 1055
CGOmega-lt <Scalable> None PSET 1pH#vis0ba113T; 1007 ive
CGOmega-Bdit <scalables Yone FSET 1pkivis3na11dT; 1008 Lo57
Coronat <scalables None FSET 1p#¥vis0be116T; 1003 Sidi
Clarendon-Cd <Scalable> None FSET 1ph#vas3bel40T; 1010 T0ss
Univers-Md <Scalables None PSET 1p] 1011 z hse
Univers-Bd <Scalables None FSET 1p##v0s3b4148T; 1012 I Lot
Univers-Mdit <Scalables None PSBT 1p#Hvis0ba148T; 1013 i
Univers-Bdit <Scalable> None PSET 1ph#v1s3ba148T; 1014 1063
Univers-MdCd <Scalables None FSET 1pkkv4s0b4148T; 1015 1084
Univers-BdCd <scalables None FSET 1phivas3balast; 016 Loes
Univers-MdCdlt <Scalables None FSET 1p#4v5e0b4148T; 1017 cener 1066
Univers-BdCdlt <Scalable> None FSET 1p#v5s3ba148T; 1018 saser;  Tog7
AntiqueOlive <Scalable> None FSET 1pk#v0s0DA166T; 1013 e
Antiqueolive-Bd <scalables None FSET 1p#kv083ba168T; 1020 si0m 1069
AntiqueOlive-It <Scalable> Nene FSET 1p#kv1s0b4168T; 1021 s
GaramondAntiqua <Scalables None FSET 1p##v0s0ba197T; 1022 on
Garamond-HIb <Scalables None FSET 1ph#v083ba137T; 1023 s
Garamond-Krsv <Scalable> None FSET 1pH#v1s0b4197T; 1024 073
Garamond-HIbKrsv <Scalable> None FSET 1phivia3bal197T; 1028 074
Margod <scalable> None FSET 1p##v0s0b4297T; 1026 1075
Albertus-Md <Scalables None. FSET 1p#iv0s1ba36aT; 1027 zize
Albertus-ExtBd <Scalable> None PSET 1pi#v0s4ba362r; 1028 1017
Arial <Scalables None FSET 1p##v0s0b16602T; 1029 o
Arial-Bd <Scalable> None FSET 1p##v083b16602T; 1030 1079
Arial-lt <Scalable> None FSET 1ph#v1s0b16602T; 1031 i
Arial-Bdit <Scalable> None FSET 1pi#v1s3bl66027; 1032
TimesNewRoman <Scalable> None FSET 1phiv0s0b16901T; 1033
TimesNewRoman-Bd <Scalable> None PSET 1pk#v0s3b16901T; 1034
TimesNewRoman-It <Scalables None PSET 1pi#v1e0b16901T; 1035
| TimesNewRoman-Bdlt <Scalable> None FSET 1p##v1s3bl6901T; 1036
} Helvetica <Scalable> None FSET 1pkkv080b24580T; 1037
Helvetica-Bd <Scalable> None FSET 1pk#v0s3b24580T; 1038
| Helvetica-Ob <Scalables None PSET 1pHiv1s0b24580T; 1033
| Helvetica-BdOb <scalable> None FSET 1ph#v1s3b24580T; 1040
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Received Data Dumping

Printing Test Pages

It is possible to print data received by the printer as hexadecimal code for
the purposes of debugging programs and files.

1
2

W

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or V key repeatedly until > Print HEX-DUMP appears.

>Print HEX-DUMP

Press the ENTER key. A question mark (?) appears.

>Print HEX-DUMP?

Press the ENTER key again. Processing appears for a second, and
then Waiting appears.

Processing

v

Waiting

Send data to be dumped to the printer. The message Processing
will be displayed during receiving the data.

Once the dumped data you require has been output, it is possible to
cancel the printing of any further dumped data by taking the printer
offline by pressing the GO key and then pressing the CANCEL key.

Once all data has been received, the message Waiting will appear.
Press the GO key to finish printing.
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Paper Handling

Paper Handling

This section explains how to use the operator panel to change the paper
size and type for each paper source, the mode for the MP (multi-purpose)
tray, and other settings regarding paper handling.

Setting the Paper Size

Set the paper sizes according to the sizes of paper to be set in the paper
cassette and the MP tray.

If they do not match, printing will not be made on the correct size paper
when automatic paper size selection is made by the application software
(printer driver).

Setting the Paper Size in Paper Cassette

To set the standard sizes A5, A4, B5, Letter, and Legal (for U. S. A. only)
size for the paper cassette, use the following procedure to set the paper size
dial of the paper cassette.

If you use a non-standard size, see Custom Paper Size on next page.

Properly set the paper into the paper cassette. For details about the
adjustment of the paper guides and paper stopper inside the paper
cassette, set the Installation Guide supplies with the printer.

1 Turn the paper size dial so that the size of the paper you are going to
use appears in the paper size window.

Paper Size Dial Paper Size Window

2 Adjust the paper guides and paper stopper inside the paper cassette
to the size of the paper to be used and load the paper into the
cassette.

The paper size setting for the paper cassette is completed.
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Paper Handling

Custom Paper Size

In addition to the standard sizes A5, A4, B5, Letter, and Legal (for U. S. A.
only) size for the paper cassette, paper of other sizes can be fed as custom
sizes. When placing paper of sizes other than A5, A4, B5, Letter, or Legal
(for U. S. A. only) into the paper cassette, set the size of the paper to be
used into the printer by following the procedure given below. If an option
paper feeder (PF-60) is installed, custom sizes for its paper cassette can be
set using the same procedure.

This menu appears when the paper size dial of the paper cassette is set to
CUSTOM.

Properly set the paper into the paper cassette. For details about the
adjustment of the paper guides and paper stopper inside the paper
cassette, see the Installation Guide supplied with the printer.

Setting Paper Size Dial
Use the following procedure to set the paper size dial to CUSTOM.
1 Pull out the paper cassette from the printer and turn the paper size

dial to CUSTOM. See step 1 in Setting the Paper Size in Paper
Cassette.

2 Adjust the paper guides and paper stopper inside the paper cassette
to the size of the paper to be used and load the paper into the
cassette.

When using non-standard size paper, read the next section to set the
paper size from the operator panel.

Setting a custom size from the Operator Panel

Set the size of the paper loaded in the paper cassette into the printer from
the printer operator panel.

1 Press the MENU key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

3 Press the > key.
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Paper Handling

4 Press the A or V key repeatedly until >Cassette Size > appears.

If option paper feeders are added, Cassette 1 Size will appear for
the standard paper cassette and Cassette 2 Size, Cassette 3
Size, and Cassette 4 Size will appear for the option paper
feeders.

>Cassette Size >

Set the unit of measurement as described in the next section.

Selecting the Unit of Measurement

Then, use the following procedure to set the unit of measurement.
1 Press the > key.
2 Press the A or V key repeatedly until >>Unit appears. The unit of

measurement can be selected between millimeters and inches. The
current unit of measurement is displayed (the default setting is mm).

>>Unit
mm

3 Press the ENTER key. A blinking question mark (?) appears.

Select mm or inch using the A or V key.

oA

Press the ENTER key.

Set the dimensions of paper as described in the next section.

1-26

Download from Www.Somanuals.com. All Manuals Search And Download.



Paper Handling

Entering the Width and Length

Then, use the following procedure to set the paper size.

~

Gnter the paper size for X Dimension and Y Dimension as

shown in the figure.
\ _R—)

4 m
(0]
e
2

C
S £
@ Eo
: g3
§ “;j e
> oN
148 to 216 mm X Dimension N

(5.83 to 8.5 inches)

1 When the unit of measurement is set, press the V key.
>>X Dimension appears as shown below (the paper width setting).

>>X Dimension
216 mm

2 Press the ENTER key. A blinking cursor () appears.

>>X Dimension
2167 mm

L3-S
| B

3 Press the A or V key to increase or decrease the value of the figure
where the cursor is blinking and display the desired width. The
width can be set between 148 and 216 mm (5. 83 to 8. 5 inches). You
can use the > and < keys to move the cursor right and left.

Display the paper width and press the ENTER key.

When the width is set, press the Vv key. >>Y Dimension appears
(the paper length setting). Set the desired length in the same way as
the width. The length can be set between 210 and 356 mm (8.27 to
14.02 inches).

oA

6 Display the paper length, press the ENTER key.
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Paper Handling

7 Press the MENU key. The message display returns to Ready.

To print using the custom size set above, define the same custom size
on the printer driver. For details, see Setting Custom Paper Size in
Printer Driver Guide.

Setting the Paper Size in MP Tray

When using the MP tray in the cassette mode, you should set the same
paper size to the MP tray as that is used to format the job to print. The
factory default setting is A4 or Letter.

This menu does not appears when the option envelope feeder is installed on
the printer.

For more details about the paper sizes that can be fed from the MP tray, see
Chapter 2.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or Vv key repeatedly until >MP Tray Size appears.

W

>MP Tray Size
A4

5 Press the ENTER key. A blinking question mark (?) appears.

>MP Tray Size
Mo

? A4

1S
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6 Press the A or V key to display the desired MP tray size. The display
changes as shown below.

A4
Executive
Letter
Legal
Custom
Oficio II
Statement
Folio
Youkei 2
Youkei 4
Hagaki
OufukuHagaki
Monarch
Business
Comm. #9
Comm. #6 3/4
DL

C5

A6

B6

A5

B5

ISO B5

7 When the desired paper size is displayed, press the ENTER key.
8 Press the MENU key. The message display returns to Ready.

The paper size setting for the MP tray is completed.
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Setting the Paper Type

Set the paper types according to the paper to be set in the cassette and the
MP tray.

Setting the Paper Type in Paper Cassette

Make this setting to match the paper type fed from the paper cassette of
the printer. If the paper type is set correctly, you can perform printing
using the media type selection function from the application software
(printer driver). The factory default setting is Plain.

For more details about the paper types that can be fed from the paper
cassette, see Chapter 2.

1
2

W

Press the MENU key.

Press the A or Vv key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Cassette Type appears.

>Cassette Type
Plain

Press the ENTER key. A blinking question mark (?) appears.

?Cassette Type
N

? Plain

1S

Press the A or V key to display the desired cassette type. The display
changes as shown below.

Plain
Preprinted
Bond
Recycled
Rough
Letterhead
Color
Prepunched
Custom (1 to 8)

When the desired cassette type is displayed, press the ENTER key.
Press the MENU key. The message display returns to Ready.
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Setting the Paper Type in MP Tray

You can automatically select the paper cassette according to the selection
made by the application software (printer driver). The factory default
setting is Plain.

This menu does not appears when the option envelope feeder is installed on
the printer.

For more details about the paper types that can be fed from the MP tray,
see Chapter 2.

1 Press the MENU key.

2 Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or Vv key repeatedly until >MP Tray Type appears.

>MP Tray Type
Plain

5 Press the ENTER key. A blinking question mark (?) appears.

?MP Tray Type
pMNL2

? Plain

I|\
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6 Press the A or Vv key to display the desired MP tray type. The display
changes as shown below.

Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum
Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Custom (1 to 8)

When the desired MP tray type is displayed, press the ENTER key.

8 Press the MENU key and the message display returns to Ready.

Custom Paper Type

The following describes the procedure used to set a user-defined paper type
for the printer. Eight custom user settings may be registered. After having
been set, any of these may be called up when setting the paper type for a
paper source

The paper weight and duplex path can be set (see Setting the Paper
Weight on page 1-34, and Setting the Duplex Path on page 1-35) after
selecting the paper type to be customized as follows. For how to reset the
customized settings, see Resetting the Custom Paper Type on page 1-36.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or Vv key repeatedly until >Type Adjust > appears.

W

>Type Adjust >
Custom 1
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5 Press the ENTER key. A blinking question mark (?) appears.

>Type Adjust >
S

? Custom 1
I|\

6 Press the A or Vv key to display the desired paper type. The display
changes as shown below.

Custom (1 to 8)
Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum
Rough
Letterhead
Color
Prepunched
Envelope
Cardstock

7 When the paper type to be customized is displayed, press the ENTER
key.

8 Press the > key and proceed to Setting the Paper Weight on the
following page.

Proceed to Setting the Paper Weight and Setting the Duplex Path
starting from the following page.
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Setting the Paper Weight

You can set the paper thickness for your custom paper type to be
customized.

1 Display the custom paper type (see Custom Paper Type on page
1-32) and press the > key.

2 Press the A or V key repeatedly until >>Paper Weight appears.

>>Paper Weight
Normal

3 Press the ENTER key. A blinking question mark (?) appears.

?>Paper Weight

n o
? Normal
I|\

4 Press the A or V key to display the desired paper thickness. The
display changes as shown below. For details of the default setting for
each paper type, see Paper Type on page 2-11.

Normal

Heavy (Thick)

Light (Thin)

When the desired paper thickness displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

o O

If the paper type is set to Custom and the option duplexer is installed
on the printer, duplex printing can be enabled and disabled. See
Setting the Duplex Path on the following page.
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Paper Handling

Setting the Duplex Path

. To use this function, the duplexer must be installed on the printer.
If the paper type is set to Custom and the option duplexer is installed on
the printer, you can set whether or not to enable duplex printing as follows.

The default setting is Enable.

1 Display the custom paper type (see Custom Paper Type on page
1-32) and press the > key.

2 Press the A or V key repeatedly until >>Duplex path appears.

>>Duplex path
Enable

3 Press the ENTER key. A blinking question mark (?) appears.

?>Duplex path

n o
? Enable
I|\

4 Select Enable or Disable using the A or V key. For details of the
default setting for each paper type, see Paper Type on page 2-11.

5 Press the ENTER key.
6 Press the MENU key. The message display returns to Ready.

The custom paper type setting is completed.
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Resetting the Custom Paper Type

Resets the settings of Custom 1 to 8 that are set in Custom Paper Type
on page 1-32.

1 Press the MENU key.

2 Press the A or V key repeatedly until Paper handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Reset Type Adjust
appears.

>Reset Type
Adjust

5 Press the ENTER key. A question mark (?) appears.

>Reset Type
Adjust ?

6 Press the ENTER key. All the customized paper weight and duplex
path settings will be reset to the default. The message display
returns to Ready.
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MP Tray Mode

Paper Handling

The MP tray can be used in either of two modes — first or cassette. The
MP tray feed paper differently depending on the mode:

Cassette Mode

This is the default mode. The MP tray acts in the same manner as
other paper source. The printer can correctly feed paper from any paper
source as you command on the printer driver. The cassette mode
provides a faster printing speed than the first mode.

First Mode

The MP tray automatically feeds paper placed on the MP tray
overriding another paper source that is selected on the printer driver.
After all paper sheets in the MP tray have been used up (approximately
100 sheets [A4 size, 0.11 mm thickness]), paper will be fed from the
paper source originally selected. This mode is convenient to feed paper
of special size or type without reloading the current paper source.
However, the MP tray must be kept empty if you desire to feed paper
from the intended paper source.

This menu does not appears when the option envelope feeder is installed on
the printer.

The maximum capacity for the MP tray of 100 sheets is based on A4
paper. If you use Legal size paper on the MP tray, the number of paper
you use should be considerably smaller than 100 sheets to avoid
possible paper jam.

To switch the MP tray to First mode, proceed as follows:

1
2

Press the MENU key.

Press the A or Vv key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or Vv key repeatedly until >MP Tray Mode appears.

>MP Tray Mode
Cassette
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Paper Handling

5 Press the ENTER key. A blinking question mark (?) appears.

?MP Tray Mode

V4
? Cassette
I|\

6 Select First or Cassette using the A or V key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

Selecting the Paper Feed Source

You can select from which paper source printing will be performed. If no
option units are installed, the only selections are the paper cassette and
MP tray of the printer. If option paper feeders are installed, they can also
be selected using the manner described below.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or Vv key repeatedly until >Feed Select appears.

W

>Feed Select
Cassette

5 Press the ENTER key. A blinking question mark (?) appears.

?Feed Select

N
? Cassette
I|\

Select MP tray or Cassette using the A or V key.

Press the ENTER key.

oo ~NO®

Press the MENU key. The message display returns to Ready.
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Output Stack

Paper Handling

The following procedure allows you to select whether printouts will be
received by the face-down output tray or to the face-up output tray. If an
option sorter is installed, it can also be selected using the manner
described below.

1
2

W

o0 N

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or Vv key repeatedly until >Stack Select appears.

>Stack Select
Face-down tray

Press the ENTER key. A blinking question mark (?) appears.

?Stack Select

pMoo

? Face-down tray
1S

Press the A or Vv key to display the desired destination. The output
tray changes as shown below.

Face-down tray (Printer’s face-down output tray) [Default]
Face-up tray (Printer’s face-up output tray) [Option face-up
tray required]

When the desired paper source displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Overriding A4 and Letter Size Difference

This selects whether to enable or disable the difference between A4 size
and Letter size. Under the default setting of Of £, the paper size of the
paper source is matched to the paper size formatting the jobs. If these
differ, a corresponding error message is displayed. When this is set to On,
printing is performed even if the actual paper size differs from the paper
size formatting the jobs.

1
2

oo ~NO®

Press the MENU key.

Press the A or V key repeatedly until Paper Handling > appears.

Paper Handling >

Press the > key.

Press the A or V key repeatedly until >Override A4 /LT appears.

>Override A4/LT
Off

Press the ENTER key. A blinking question mark (?) appears.

?Override A4 /LT
N

2 Off

I|\

Select On or Of £ using the A or V key.
Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Pagination

Emulation

Changing the Emulation

Pagination

The items regarding pagination can be made from the operator panel. The
items that can be set are shown below.

Emulation

Font

Code Set

Number of Copies

Printing Orientation

KIR (Kyocera Image Refinement)
Ecoprint

Resolution

The following procedure allows you to select the printer’s emulation mode.

To change the emulation mode, proceed as follows:

1
2

Press the MENU key.

Press the A or V key repeatedly until Emulation appears. One of
the emulation modes shown below appears, indicating the current
emulation.

PCL 6 (default)
KPDL

KPDL (AUTO)
Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

KPDL is the Kyocera’s implementation of the PostScript page
description language.

Press the ENTER key. A blinking question mark (?) appears.

Emulation
P

?PCL 6

?l\

Press the A or V key repeatedly until the desired emulation mode
appears.
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5

6

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

Alternative Emulation for KPDL Emulation

The auto KPDL (XPDL (AUTO) ) emulation enables the printer to
automatically change the emulation mode according to the print job
received. The alternative emulation can be selected using the operator
panel. The default alternative emulation is PCL 6.

1
2

o O

Press the MENU key.

Press the A or V key repeatedly until Emulation appears.

Emulation
PCL 6

Press the ENTER key. A blinking question mark (?) appears.

Emulation
oL 6
1S

Press the A or Vv key repeatedly until the message display indicated
KPDL (AUTO) appears.

Emulation
?KPDL (AUTO)

Press the ENTER key.

Press the > key. When > Print KPDL Errs is displayed, press the
A or V key. The display cycles through the emulation in the following
order:

PCL 6 (default)
Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

Press the ENTER key. A blinking question mark (?) appears.

?Alt. Emulation
9

)

'i’PCL 6
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8
9

Pagination

Press the A or V key repeatedly until the desired alternative
emulation appears.

Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

The printer can print error descriptions when printing error occurs during
KPDL emulation. The default is Of £ — the printer does not print KPDL
errors.

1
2

o O

Press the MENU key.

Press the A or Vv key repeatedly until Emulation > appears.

Emulation
PCL 6

Press the ENTER key. A blinking question mark (?) appears.

Emulation
oL 6
1S

Select KPDL or KPDL (AUTO) using the A or V key.

Emulation
?KPDL

Press the ENTER key.

Press the > key. The message display changes to that shown below. If
>Alt. Emulation is displayed when the KPDL. (AUTO) emulation
is selected, press the A or Vv key to change it.

>Print KPDL Errs
Off

Press the ENTER key. A blinking question mark (?) appears.

?Print KPDL Errs
nL,

2

ﬁ\Off
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Font

Default font

8 Select On using the A or V key.

?Print KPDL Errs
n,

[5)

ﬁ\On

9 Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

You can select the default font for the current interface. In addition to the
internal fonts, all fonts that are downloaded to the printer memory, or fonts
stored on a CompactFlash card, Microdrive, or option ROM, can be selected
as the default font.

In this menu, you can also set the type and pitch for Courier and Letter
Gothic.

Press the MENU key.

—

2 Press the A or Vv key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or V key repeatedly until >Font Select > appears.

£~ )

>Font Select >
Internal

5 To select an internal font, check that Internal is displayed. If
Internal is not displayed, press the ENTER key. Press the A or v
key repeatedly until the message display indicates Internal and
press the ENTER key.

To select an option font, press the ENTER key. Press the A or Vv key
repeatedly until the message display indicates Option and press the
ENTER key. This operation is possible only when option fonts are
installed in the printer.
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6 Press the > key. The message display changes to that show below.

>> I000

The letter before the number indicates the type of font as shown

below:

Letter Description

I Internal font

S Soft (down load) font

M Fonts in an option CompactFlash card

H Fonts in a RAM disk or option Microdrive.
o} Fonts in an option ROM

7 Press the ENTER key. A blinking question mark (?) appears.

N2
>>?T000
l|\

8 Press the A or Vv key repeatedly until the desired font number
appears. For font numbers of the internal fonts, see List of Fonts on
page A-2.

9 When the desired font is displayed, press the ENTER key.

10 Press the MENU key. The message display returns to Ready.
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Default Font Size

The following procedure determines the size of the default font. If the
default font is a fixed font such as Courier or Letter Gothic, the character
pitch can be changed instead of the font size.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or V key repeatedly until >Font Select > appears.

£~ R

>Font Select >
Internal

Check that Internal is displayed and press the > key.

Press the A or Vv key repeatedly until >>Size appears.

o O

>>Size
012.00 point (s)

7 Press the ENTER key. A blinking cursor () appears.

>>Size
012.0Y point (s)
23N

8 Press the A or Vv key to increase or decrease the value of the figure
where the cursor is blinking. The font size can be set between 4 and
999.75 points, in 0.25-point increments. You can use the > or < key to
move the cursor right and left.

9 When the desired size is displayed, press the ENTER key.

10 Press the MENU key. The message display returns to Ready.
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Changing Type for Courier/Letter Gothic

Courier or Letter Gothic font type can be selected as Regular or Dark. For
example, to change the type of Courier, proceed as follows:

1
2

o O

8
9

Press the MENU key.

Press the A or Vv key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or V key repeatedly until >Font Select > appears.

>Font Select >
Internal

Check that Internal is displayed and press the > key.

Press the A or Vv key repeatedly until >>Courier appears.

>>Courier
Regular

Press the ENTER key. A blinking question mark (?) appears.

?>Courier

"D, R 1
2. egular

Select Regular or Dark using the A or V key.

Press the ENTER key.

10 Press the MENU key and the message display returns to Ready.
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Setting the Character Pitch for Courier/Letter Gothic

The character pitch for fixed fonts is adjustable when the default font is
Courier or Letter Gothic.

1
2

o O

9

Press the MENU key.

Press the A or Vv key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or V key repeatedly until >Font Select > appears.

>Font Select >
Internal

Check that Internal is displayed and press the > key.

Press the A or Vv key repeatedly until >>Pitch appears.

>>Pitch
10.00 cpi

Press the ENTER key. A blinking cursor () appears.

>Pitch
10.09¢7cpi

VAN
]

Press the A or V key to increase or decrease the value of the figure
where the cursor is blinking. The character pitch can be set between
0.44 and 99.99 characters per inch, in 0.01 character-per-inch
increments. You can use the > or < keys to move the cursor right and
left.

When the desired size is displayed, press the ENTER key.

10 Press the MENU key. The message display returns to Ready.
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Code Set

You can change the character code set. Available character code sets vary
depending on the current font. (The default is IBM PC-8.)

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Font > appears.

Font >

3 Press the > key. Press the A or V key until > Code Set appears.

>Code Set
IBM PC-8

4 Press the ENTER key. A blinking question mark (?) appears.

>Code Set
>TBM PC-8
bis -

Press the A or Vv key until the desired character code set appears.
Press the ENTER key.

Press the MENU key. The message display returns to Ready.

~N O O
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Number of Copies

You can set the number of copies to be printed of each page for the current
interface. The number of copies can be set between 1 and 999.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Page set > appears.

Page Set >

Press the > key.

Press the A or Vv key repeatedly until >Copies appears.

W

>Copies
001

5 Press the ENTER key. A blinking cursor () appears.

>Copies
00ls

VAN
]

6 Press the A or Vv key to increase or decrease the value of the figure
where the cursor is blinking. It can be set between 1 and 999. You

can use the > and < keys to move the right and left.

When the desired size is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

o0 N
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Printing Orientation
The default orientation of the page can be selected from the portrait
(upright) and landscape (sideways) page orientation.

Portrait orientation Landscape orientation

A A

Paper feed direction

Press the MENU key.

—

2 Press the A or Vv key repeatedly until Page Set > appears.

Page Set >

Press the > key.

Press the A or Vv key repeatedly until >Orientation appears.

£~ )

>Orientation
Portrait

5 Press the ENTER key. A blinking question mark (?) appears.

?Orientation

~9,P t it
2 ortrai

Select Portrait or Landscape using the A or V key.

Press the ENTER key.

oo ~NO®

Press the MENU key. The message display returns to Ready.
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KIR (Kyocera Image Refinement)

Status Page

KIR Checking
Lines

This printer incorporates the KIR (Kyocera Image Refinement) smoothing
function. This function provides high print quality by providing software
enhancement of print resolution.

With KIR Of £ With KIR On (default)

Set the print density to 3 when setting the KIR mode. For details on print
density, see page 71-95.

Look at the check line, the last line on a status page, to make the optimum
KIR mode setting.

Optimized stripes

The current KIR setting is optimal.

Dark vertical stripes

Set the KIR mode to Of £. Try printing the status

page again. If you still get dark vertical stripes,
adjust the print density control to a lighter setting.

White vertical stripes

Set the KIR mode to on. Try printing the status
page again. If you still get white vertical stripes,
adjust the print density control to a darker setting.
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Press the MENU key.

—

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

Press the > key.

Press the A or Vv key repeatedly until >5KIR Mode appears.

W

>KIR Mode
On

5 Press the ENTER key. A blinking question mark (?) appears.

>KIR Mode
s])/o
A n

Select On or Of £ using the A or V key.
Press the ENTER key.

Press the MENU key. The message display returns to Ready.

oo ~NO®
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Ecoprint

The Ecoprint enables you to reduce the amount of toner consumed on the
page so as to save your printing costs. You can set to Ecoprint mode on, as
follows. (The factory default setting is Of £.)

The Ecoprint setting has no effect on the print speed.

The Ecoprint mode setting is On when the printing image becomes lighter,
yet very readable.

A

rs

Ecoprint setting is Of £ Ecoprint setting is On
(default).

Press the MENU key.

—

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

Press the > key.

Press the A or V key repeatedly until >Ecoprint Mode appears.

£~ R

>Ecoprint Mode
Off

5 Press the ENTER key. A blinking question mark (?) appears.

?Ecoprint Mode
Mo

)

ﬁ\Off

Select On or Of £ using the A or V key.
Press the ENTER key.

Press the MENU key. The message display returns to Ready.

oo ~NO®
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Resolution
Proceed as follows to set the default print resolution from four ways — 300

dpi, 600 dpi, and Fast 1200 mode. The clarity of printed characters
and graphics becomes sharper in this order.

1 Press the MENU key.

2 Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Resolution appears.

>Resolution
Fast 1200 mode

5 Press the ENTER key. A blinking question mark (?) appears.

?Resolution

Ng

? Fast 1200 mode
Il\

Select Fast 1200 mode, 300 dpior 600 dpi using the A or V key.

Press the ENTER key.

oo ~NO®

Press the MENU key. The message display returns to Ready.
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e-MPS

-

To use the e-MPS system, an option Microdrive must be installed in the
printer.

e-MPS is an abbreviation for ‘enhanced-Multiple Printing System’ which
implements the following functions that are available from the printer
driver:

* Job Retention
* Job Storage

In either job mode, when printing a document, the print data is transferred
from the computer to the printer then stored on the printer’s Microdrive.

Since copies of the document are printed using the stored data, printing is
performed faster with less computer spooling time and less network traffic.

Job Retention

Job Retention has four modes as summarized below. These modes are
selected when you choose on the printer driver through the application

software:
Mode Quick Copy Proof and Hold Private Print Stored Job
Primary function To later print To proofthe first copy |Tohold thedocument | To electronically
additional copies before printing in printer to prevent |store documents
multiple copies unauthorized access |such as fax cover
pages
Storing started Printer driver Printer driver Printer driver Printer driver
Retrieved by Operator panel Operator panel Operator panel Operator panel
Default number of Same as storing One less Same as storing One
copies printed at
retrieval
Maximum number of |32, expandable to 50 |32, expandableto50 |Private jobs are Depends on the
jobs stored* deleted capacity of
automatically once it | Microdrive.
is retrieved.
PIN security No No Yes Yes (Option)
Data after printing Stored Stored Stored Stored
Data at power off Deleted Deleted Deleted Stored
Microdrive Yes Yes Yes Yes
required**

*  Jobs in excess will cause the earlier ones to be deleted.
** RAM disk does not work for e-MPS.
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e-MPS

Job Storage

Job storage stores print jobs either temporarily or permanently, or in
virtual mailboxes, as you click an appropriate radio button on the printer
driver when printing from a computer.

Virtual Mailbox

Virtual mailbox is part of Job Storage, which stores print jobs on the
Microdrive without printing. It enables you to retrieve jobs later from the
operator panel, or the KM-NET Job Manager utility (in the CD-ROM).

Each mailbox may be used by an individual who desires to share the
printer in this mode. By default, each mailbox is numbered from ‘Tray 001,
‘Tray 002,... etc. To ‘post’ a job in one of these mailboxes, you assign a
numbered mailbox on the printer driver when printing.

To retrieve the stored job for printing, see Retrieving Jobs from Virtual
Mailbox (VMB) on page 1-68.

The virtual mailbox can be used in PCL 6 emulation only.

This mode enables you to print the requested number of copies of a job,
simultaneously storing the job on the Microdrive. When additional copies
are required, you can reprint the required number of copies from the
printer operator panel. To print a job as a quick copy job, see Printer
Driver Guide.

The default number of print jobs that can be stored on the Microdrive is 32.
This value can be increased to up to 50 from the e-MPS Configuration
menu. For details, see e-MPS Configuration on page 1-70. When the
number of jobs reaches the limit, the oldest job will be overwritten by the
new one.

When the printer is turned off, all stored jobs will be deleted.

Printing Additional Copies using Quick Copy

To print additional copies of a job stored in the printer:
1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

3 Press the > key.
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O o0

1

Press the A or V key repeatedly until >Quick Copy appears
followed by the user name (Harold, in this example). The user name
is assigned at printing using the printer driver.

>Quick Copy
Harold

Press the ENTER key. A blinking question mark (?) appears before
the user name.

?Quick Copy
N2
ﬁgarold

Press the A or Vv key to display the desired user name, Arlen, in this
example.

>Quick Copy
?Arlen

Press the ENTER key. The job name entered in the printer driver
(Report, in this example) appear with a blinking question mark (?)
before the letters.

?Arlen

\'D Ve
,igeport

Press the A or V key to scroll to the desired job title.

Press the ENTER key. The number of copies to be printed can be set.
To increase the copy count, press the A key; to decrease the copy
count, press the Vv key.

>Report
Copies 00lq

1

Press the ENTER key to finalize the copy count. The printer prints
the specified number of copies for the job.
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e-MPS

Deleting a Quick Copy Job
All quick copy jobs are automatically deleted when the printer is turned off.

If you desire to explicitly delete a stored quick copy job, proceed as follows:

1 Follow steps 1 through 8 in the above section to let the title of the job
displayed.

2 When the title of the job is displayed, e.g. Report, below, press the
ENTER key. The cursor below the copy count starts to blink.

>Report
Copies 0olq

1

3 Press the Vv key repeatedly until Delete appears below the title.

>Report
Delete se

1

4 Press the ENTER key. The stored quick copy job is deleted.

When you print multiple copies, this mode first prints one copy so that you
can proof it before continuing to print the remaining copies. Since you can
proof the printouts before printing the remaining copies, wastage of paper
can be reduced.

The printer prints one copy and, at the same time, saves the print job on
the Microdrive. You can also change the number of copies when resuming
printing from the operator panel.

When the printer is turned off, all stored jobs will be deleted.

Printing Remaining Copies of a Proof and Hold Job

Printing a Proof and Hold job on the operator panel is similar to printing a
quick copy job. To print remaining copies of a job held in the printer:

1 Press the MENU key.

2 Press the A or V key repeatedly until e-MPS > appears.

e-MPS >

3 Press the > key.
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O o0

1

Press the A or V key repeatedly until >Quick Copy appears
followed by the user name (Harold, in this example). The user name
is assigned at printing using the printer driver.

>Quick Copy
Harold

Press the ENTER key. A blinking question mark (?) appears before
the user name.

?Quick Copy
N2
ﬁgarold

Press the A or Vv key to display the desired user name, Arlen, in this
example.

>Quick Copy
?Arlen

Press the ENTER key. The job name entered in the printer driver
(Report, in this example) appear with a blinking question mark (?)
before the letters.

?Arlen

\'D Ve
,igeport

Press the A or V key to scroll to the desired job title.

Press the ENTER key. The number of copies to be printed can be set.
To increase the copy count, press the A key; to decrease the copy
count, press the Vv key.

>Report
Copies 00lq

1

Press the ENTER key to finalize the copy count. The printer prints
the specified number of copies for the job.
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e-MPS

In private printing, you can specify that a job is not printed until you
release the job from the operator panel. At sending the job from the
application software, you should specify a 4-digit access code in the printer
driver. The job is released for printing by entering the access code on the
operator panel. Thus, this function ensures confidentiality of the print job.

When the printer is turned off, all the print jobs will be deleted.

Releasing a Private Job

To print a private job through the operator panel:

1
2

Press the MENU key.

Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or V key repeatedly until >Private/Stored appears.
The name entered in the printer driver (Harold, in this example)
also appears.

sPrivate/Stored
Harold

Press the ENTER key. A blinking question mark (?) before a user
name appears.

?Private/Stored
ao

2

’igarold

Press the A or Vv key to display the desired user name (Arlen, in this
example).

>sPrivate/Stored
?Arlen

Press the ENTER key. The user name and the job name (Agenda, in
this example) entered in the printer driver appear with a blinking
question mark (?).

>Arlen
\; ’ d
,iégen a
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O o0

10

1

Press the A or V key to display the desired job title.

Press the ENTER key. The ID input line appears. Enter the four-digit
access code entered in the printer driver and press the ENTER key.
To enter the ID, press the < or > key to move the cursor to the
number to be changed and then enter the correct number by pressing
the A or V key.

>Agenda
ID 00007

-

You can set the number of copies to be printed. To increase the copy
count, press the A key; to decrease the copy count, press the Vv key.

>Agenda
Copies o0ols

-

Press the ENTER key to finalize the copy count. The printer prints
the specified number of copies for the job.

Deleting a Private Job

To delete a stored private job, proceed as follows:

1
2

Follow steps 1 through 8 in the above section.

When the title of the job to be printed is displayed (Agenda, in this
example), press the ENTER key. Enter the four-digit access code
entered in the printer driver and press the ENTER key.

>Agenda
Copies ools

-

Press the Vv key repeatedly until Delete appears for the number of
copies.

>Agenda
Delete e

g I

Press the ENTER key. The private job is deleted from the Microdrive.
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e-MPS

The procedure below allows you to store print jobs to the Microdrive that
are frequently needed such as fax cover pages, check lists, and order forms,
for printing at any later time using the operator panel.

The print jobs will not be deleted when the printer is turned off.

Releasing a Stored Job

To print a stored job through the operator panel:

1
2

W

Press the MENU key.

Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or V key repeatedly until >Private/Stored appears.
The name entered in the printer driver (Harold, in this example)
also appears.

sPrivate/Stored
Harold

Press the ENTER key. A blinking question mark (?) before a user
name appears.

?Private/Stored
ao

2

’igarold

Press the A or Vv key to display the desired user name (Arlen, in this
example).

>sPrivate/Stored
?Arlen

Press the ENTER key. The user name and the job name (Agenda, in
this example) entered in the printer driver appear with a blinking
question mark (?).

>Arlen
\; ’ d
,iégen a
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O o0

10

1

Press the A or V key to display the desired job title.

Press the ENTER key. If you entered an access code for the printer
driver, the ID input line appears. Enter the four-digit access code
entered in the printer driver and press the ENTER key. To enter the
ID, press the < or > key to move the cursor to the number to be
changed and then enter the correct number by pressing the A or v
key.

>Agenda
ID 00007

-

You can specify the number of copies to print. To increase the copy
count, press the A key; to decrease the V key.

>Agenda
Copies ools

-

Press the ENTER key to finalize the copy count. The printer prints
the specified number of copies for the job.

Deleting a Stored Job

To delete a stored job, proceed as follows:

1
2

Follow steps 1 through 8 in the above section.

When the title of the job to be printed is displayed (Agenda, in this
example), press the ENTER key. If you entered an access code for the
printer driver, enter the four-digit access code and press the ENTER
key.

>Agenda
Copies ools

-

Press the Vv key repeatedly until Delete appears for the number of
copies.

>Agenda
Delete e

-

Press the ENTER key. The stored job is deleted from the Microdrive.
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Printing a Code Job

Install the KM-NET Job Manager software from the Kyocera Mita Digital
Library CD-ROM supplied with the printer. To do this, from the CD-ROM
Main Menu, select Printer Utilities > Install KM-NET Job Manager.

1 Browse through Windows Start > Programs > KYOCERA MITA >
KM-Net > Job Manager.

2 Enter the password for the software. Job Manager will start.

3 Click the Add printer icon (below). Select the Local or Network port.
If you use the local parallel port to connect to the printer, make sure that
the printer driver is set to print to a local port. To check this out, click the

Note Details tab of the printer Properties, and note the Print to the following
port setting.

% KM-NET Printer Disk Manager

Ell igw  Printer  Disk  Operation  Option  Help

Add printer— gl |- @‘@‘L v

icon

cFan®  Ready 0 T

4 Follow the wizard until the Select printer dialog box is reached.
When the printer is found in the Printer List, click (highlight) it, then
Finish.
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5 Double click Model Name on the list. The jobs currently stored in the
printer are shown. To print the job, right click Job name and then
click Print on the drop down list that appears.

It is possible to select more than one job at a time by right clicking a
job one by one while pressing the Shift key on the computer

keyboard.
tin KM-NET Job Manager _ O]
File View Printer Operation Help
£ =L |
el
ame [ 1P address [ 1P sddres: tobrreme - Bomer | Humberopagest izeH
FE18m0 LFTH JDBSTUHAGE MACK, THE ENIFE 2 1.13MB
2| I El= | i
Enw® Reay [ Iuow 7

The job remains intact even after printing. To permanently delete the job
in the hard disk, right click the job name on Job Manager, then click Delete

on the drop down lost that appears.
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Printing a List of Code Jobs

If you select Permanent Job Storage on the printer driver, you can have a
List of Code Job printed using the operator panel.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or V key repeatedly until >5List of Code JOB appears.

W

>List of
Code JOB

5 Press the ENTER key. A question mark (?) appears.

>List of
Code JOB ?

6 Press the ENTER key again. The printer prints a Code Job list.
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Retrieving Jobs from Virtual Mailbox (VMB)

b e To use this mode, an option Microdrive must be installed in the printer.
e

To retrieve the jobs posted in the virtual mailbox, proceed as follows.
1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or Vv key repeatedly until >Print VMB Data appears.
The virtual mailbox number will also appear.

W

>Print VMB Data
Tray001:

5 Press the ENTER key. A blinking question mark (?) appears.

>Print \IIMB Data
Y 04
?
Trayoo%i‘

6 Press the ENTER key. The document in the mailbox is printed and
automatically deleted from the mailbox.
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Printing a List of VMB

A Virtual Mailbox list includes the jobs currently stored in the mailboxes.
1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or Vv key repeatedly until >List of VMB appears.

W

>LList of VMB

5 Press the ENTER key. A question mark (?) appears.

>LList of VMB ?

6 Press the ENTER key again. The printer prints a list of jobs currently
posted in the virtual mailboxes.
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e-MPS Configuration

- \/I - You can change the following parameters for e-MPS operation:
_O ¢ Maximum number of Quick Copy/Proof and Hold jobs

* Maximum space assigned to temporary code jobs

* Maximum space assigned to permanent code jobs

* Maximum space assigned to virtual mailboxes

The total amount of storage areas specified must not exceed the total
size of the Microdrive. Otherwise, you may only be able to accommodate
" Note print jobs of a smaller amount of print jobs than specified.

Changing the Maximum Number of Quick Copy/Proof and Hold
Jobs

This changes maximum number of Quick Copy/Proof and Hold jobs from 0
to 50. The default is 32.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or Vv key repeatedly until >e-MPS Configuration >
appears.

W

>e-MPS >
Configuration

Press the > key.

Press the A or Vv key repeatedly until >>Quick Copy appears.

o O

>>Quick Copy
32

7 Press the ENTER key. A blinking cursor () appears.

>>Quick Copy
327

8 B
]
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Press the A or Vv key to increase or decrease the value at the blinking
cursor. The value can be set between 0 and 50. Use the > and < keys
to move the cursor right and left.

When the desired maximum number of jobs is set, press the ENTER
key.

10 Press the MENU key. The message display returns to Ready.

Maximum Space Assigned to Temporary Code Jobs

This changes the Microdrive space that holds temporary code jobs. You can
change the maximum space from 0 to 9999 (megabytes). The actual

maximum size depends on the size of free hard disk space, however. The
default size is 50 MB.

1
2

o O

Press the MENU key.

Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or Vv key repeatedly until >e-MPS Configuration >
appears.

>e-MPS >
Configuration

Press the > key.

Press the A or V key repeatedly until >>Temp. Code JOB Size
appears.

>>Temp. Code JOB
Size 050MB

To change the maximum disk space, press the ENTER key. A
blinking cursor ( ) appears.

>>Temp. Code JOB
Size 0sbMB

YIEN
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8
9

Press the A or V key to increase or decrease, respectively, the value
at the blinking cursor. Use the > and < keys to move the cursor right
and left.

When the desired size is displayed, press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Maximum Space Assigned to Permanent Code Jobs

This changes the Microdrive space that holds permanent code jobs. You can
change the maximum space from 0 to 9999 (megabytes). The actual
maximum size depends on the size of free Microdrive space, however. The
default size is 50 MB.

1
2

W

o O

Press the MENU key.

Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or Vv key repeatedly until >e-MPS Configuration >
appears.

>e-MPS >
Configuration

Press the > key.

Press the A or V key repeatedly until >>Perm. Code JOB Size
appears.

>>Perm. Code JOB
Size 050MB

Press the ENTER key. A blinking cursor () appears.

>>Perm. Code JOB
Size 0sbMB

YIEN

Press the A or Vv key to increase or decrease, respectively, the value
at the blinking cursor. Use the > and < keys to move the cursor right
and left.
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e-MPS

When the desired size is displayed, press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Maximum Space Assigned to Virtual Mailboxes

This changes the Microdrive space for virtual mailboxes. You can change
the maximum space from 0 to 9999 (megabytes). The actual maximum size
depends on the size of free Microdrive space, however. The default size is
50 MB.

1
2

W

o O

8
9

Press the MENU key.

Press the A or Vv key repeatedly until e-MPS > appears.

e-MPS >

Press the > key.

Press the A or Vv key repeatedly until >e-MPS Configuration >
appears.

>e-MPS >
Configuration

Press the > key.

Press the A or Vv key repeatedly until >>VMB Size appears.

>>VMB Size
050MB

Press the ENTER key. A blinking cursor () appears.

>>VMB Size
050MB

V3

-

Press the A or Vv key to increase or decrease, respectively, the value
at the blinking cursor. Use the > and < keys to move the cursor right
and left.

When the desired size is displayed, press the ENTER key.

10 Press the MENU key. The message display returns to Ready.
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Interface

The printer is equipped with both a parallel and USB interface. Option
serial interface board kit and network interface card can also be installed.
Various printing environment parameters such as the default emulation
can be changed indepently on different interfaces by using the printer’s
menu selection system. Before select the interface to apply the changes in
the procedure described below.

This interface selection described below does not select which interface
data will be received from. The printer automatically selects an interface
“Note data is received.

Parallel Interface Mode

The parallel interface mode of this printer supports a bi-directional/high-
speed mode. Normally, this interface is used under the default setting
AUTO. For details, see Appendix C. After setting the interface, be sure to
reset the printer or turn the power off at least once. The new setting will be
enabled thereafter.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Interface > appears. One of
the interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (when a serial interface board kit is installed)
Option (when a network interface card is installed)

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/|\

If parallel is not displayed, press the A or Vv key repeatedly until it
is Parallel.

If you want to abandon the interface selection procedure, press the
CANCEL key. The interface remains unchanged.

Press the ENTER key again.

Press the > key. The message display changes to the communication
mode menu.

oA
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USB Interface Mode

Interface

Press the ENTER key. A blinking question mark (?) appears.

?Parallel I/F

Nio
? AUTO
1S

Press the A or Vv key to display the desired mode. The display
changes as shown below. Press the ENTER key.

AUTO (default)
Normal

High Speed
Nibble (high)

Press the MENU key. The message display returns to Ready.

About USB interface, for details, see Appendix C.

1
2

o O

Press the MENU key.

Press the A or Vv key until Interface > appears. One of the
interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (when a serial interface board kit is installed)
Option (when a network interface card is installed)

Press the ENTER key. A blinking question mark (?) appears.

Interface
nNL,
? Parallel
/|\

Press the A or Vv key until USB appears.

Interface
N,

? USB

/l\

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

1-75

Download from Www.Somanuals.com. All Manuals Search And Download.



Interface

Serial Interface Parameters

b This section applies to the printers having the option serial interface
_[:jj board kit (IB-10E) installed.

The baud rate, data bits, stop bits, parity, and protocol for the serial
interface can be set as follows:

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Interface > appears. One of
the interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (when a serial interface board kit is installed)
Option (when a network interface card is installed)

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/|\

If you want to abandon the interface selection procedure, press the
CANCEL key. The interface remains unchanged.

4 Press the A or Vv key repeatedly until Serial appears.

%nterface

N, .
? Serial
/l\

5 Press the ENTER key again.
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6 Press the > key. Each time the A or V key is pressed, the setting item
and current setting change as shown below.

Definable baud rates: 1200, 2400, 4800,
>Baud Rate 9600 (default), 19200, 38400, 57600,

9600 115200

v 4

>Data Bits
8

Definable data bits: 7, 8 (default)

v 4

>Stop Bits

Definable stop bits: 1 (default), 2

1
) Definable parity: None (default), 0dd, Even,
>Parity Ignore
None
Definable protocol: DTR (pos . ) &XON
>Protocol (default), DTP (positive), DTR
DTR (pos . ) &XON (negative), XON/XOFF, ETX/ACK

7 Display the setting item to be changed and press the ENTER key. A
question mark (?) appears.

The following example explains how to change the baud rate. The
settings for other items can be changed in a similar manner.

>Baud Rate
? 9600

8 Press the A or Vv key to display the desired setting. The setting
changes as shown below.

The baud rate can be selected from 1200, 2400, 4800, 9600 (default),
19200, 38400, 57600, and 115200.

Some computers may not be compatible with a baud rate of 115200 bps.
If you set the baud rate to 115200 and communication problems occur,
“Note lower the baud rate.

9 Display the desired baud rate and press the ENTER key.

10 Press the MENU key. The message display returns to Ready:.
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Network Interface Parameters

WL\/| b

This section applies to the printers having the option network card
installed.

To make your printer supports TCP/IP, Netware, and EtherTalk networks,
you will need to install the option network interface card in the printer and
make the proper settings as explained in this section.

Using the operator panel, you can:

* Activate or deactivate TCP/IP, NetWare, and EtherTalk
* Activate or deactivate DHCP

* Enter IP address, subnet mask address, and default gateway address

To confirm or change network card parameters, proceed as follows:
1 Press the MENU key.

2 Press the A or Vv key repeatedly until Interface > appears. One of
the interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (when a serial interface board kit is installed)
Option (when a network interface card is installed)

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/|\

4 Press the A or Vv key repeatedly until Option appears.

Interface
\; ’

4\Optlon

5 Press the ENTER key again.
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Press the > key. Each time the A or V key is pressed, the display

changes as shown below.

>sNetWare >
Oon

v 4

>TCP/IP >
On

v 4

>EtherTalk
Off

v 4

>Opt.
On

StatusPage

Range

Set this item to On when you connect to a
network using NetWare. In submenu (),
frame mode can be selected from Auto,
Ethernet, 802.2,and 802. 3.

Set this item to On when you connect to a
network using TCP/IP. Submenu (>) has
items including DHCP, IP address, subnet
mask address, and gateway address.

EtherTalk must be activated (0n) for
networking with Macintosh computers.

When the item is set to On, the printer prints
out a network status page when it prints the
printer status. See page 1-19

The following example explains how to activate TCP/IP protocol to
connect the printer in the network. You can select Netware or
EtherTalk in a similar manner.

>TCP/IP >
On

If TcP/ 1P is currently Off is displayed, select On using the A or Vv
key. Press the ENTER key again.

>TCP/IP
? On

>TCP/IP >

-»> On
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8 Press the > key. Each time the A or V key is pressed, the item
changes as shown below.

>>DHCP
Off

v 4

>>IP Address
000.000.000.000

v 4

>>Subnet Mask
000.000.000.000

v 4

>>Gateway
000.000.000.000

9 Display the item to be set and press the ENTER key.
For DHCE, a question mark (?) appears. For IP Address, Subnet
Mask, and Gateway, the cursor () blinks.

10 For DHCP, select On or Of f using the A or V key. For IP Address,
Subnet Mask, and Gateway addresses, press the A or V key to
change the number (000 to 255) where the cursor is blinking. You
can use the > and < key to move the cursor right and left.

To obtain these addresses, consult your network administrator.

11 Press the ENTER key.

12 Press the MENU key. The message display returns to Ready.
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Operating the Storage Device

The printer supports three types of storage devices: CompactFlash card,
Microdrive, and RAM disk.

The printer is equipped with a slot for a CompactFlash card and a
Microdrive. By inserting a CompactFlash card or Microdrive into the
printer, the following operations become available. For details about the
handling of the CompactFlash card and Microdrive, see Appendix B.

The following procedure assumes use of a CompactFlash card. The similar
procedure can be applied when using the Microdrive.

You can format the Microdrive using the operator panel when the first
time you installed a new Microdrive. About formatting a new Microdrive.

Activating the RAM Disk

The RAM disk is a memory space shared within the printer memory that
can temporarily store print jobs for electronic sorting. The stored print job
can then be used to print multiple copies of the job reducing the total
amount of period required to print the whole job. It acts similar to the
option Microdrive except that the data is effective only during the printer
is powered up.

To set up the RAM disk, the option Microdrive must not be installed.

To use the RAM disk, activate and enter the desired size of the RAM disk
in the manner described below. The maximum RAM disk size can be
calculated as follows:

Maximum RAM size = Total printer memory - 9 MB

For example, if the total memory installed in your printer is 144 MB, you
can set 135 MB of RAM disk. If you attempt to set the RAM disk size
beyond this restriction, the printer automatically round it down so that the
size is always 9 MB less than the total printer memory. Once the RAM disk
size is set, the printer must be reset.

By default, the RAM disk is not activated (0f £). To confirm the RAM disk
size or activate the RAM disk, proceed as follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until RAM Disk Mode > appears.

RAM Disk Mode
Off
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~N O

The default setting is Of f£. Press the ENTER key. A blinking question
mark (?) appears. Select On using the A or V key, and then press the
ENTER key.

?AM Disk Mode

e
? On
?l\

Press the > key to display >RAM Disk Size.

>RAM Disk Size
0007 Mbyte

Press the ENTER key again, and change the RAM disk size using the
A or V key. It is not possible to make a setting that exceeds total
printer memory. The default value for the RAM disk is the total
printer memory minus 9 MB. This parameter may be set anywhere
from 0001 to 1024 depending on the available printer memory.

When the desired RAM disk size is displayed, press the ENTER key.

Press the MENU key and restart the printer. The setting will be
activated after restart.
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Operating the Storage Device

To read data on a CompactFlash card, Microdrive, or the RAM disk use the
following procedure:

1
2

~N O

Press the MENU key.

Press the A or Vv key repeatedly until Memory Card >, Hard Disk
> or RAM Disk Mode > appears.

Memory Card >

Press the > key.

Press the A or Vv key repeatedly until >Read Data appears. The
data name also appears.

>Read Data
data name

Press the ENTER key. A blinking question mark (?) appears before
the data name.

>Read Data
?data name

Press the A or Vv key to display the desired data name.

Press the ENTER key. Processing appears and the reading of data
from the storage device starts.
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Writing Data

You can write data to a CompactFlash card, the Microdrive, or the RAM
disk using the operator panel. When writing data to the storage device, a
name is automatically assigned to the data. The CompactFlash card or the
Microdrive or the RAM disk must be formatted. Otherwise, the sWrite
Data message explained below will not appear on the display. To format a
CompactFlash card or the Microdrive or the RAM disk, see Formatting a
Storage Device on page 1-88.

when the first time you installed a new Microdrive or the RAM disk. About

0 You can format the Microdrive or the RAM disk using the operator panel
“Note  formatting a new Microdrive.

After writing is complete, you can print a list of data stored in the storage
device for confirmation. See Printing a List of Data Names on page
1-89.

To write data to a CompactFlash card, the Microdrive or the RAM disk,
proceed as follows:

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Memory Card >, Hard Disk
> or RAM Disk Mode > appears.

Memory Card >

Press the > key.

Press the A or Vv key repeatedly until >Write Data appears.

L~ )

>Write Data

5 Press the ENTER key. A question mark (?) appears.

>Write Data °?

6 Press the ENTER key. Processing appears, then Waiting.
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7 In this state, send the file from the computer to the printer.

The file is written onto the storage device given a destination name
(also referred to as a partition name) which the printer automatically
assigns one after another as follows:

DataS001 (first data),
DataS002 (second data),
DataS003 (third data)...

In the example above, if the file TEST.TXT is the first data to be
written onto the storage device, the destination name will be
DataS001.

As the printer receives data, the message display changes to
Processing, then when the end of the data is received, the message
display changes to Waiting.

8 Check that the message display has changed to Waiting, then press
the GO key. This writes the file to the memory card and instructs the
printer to automatically print out a CompactFlash card write
information page as shown below.

0} KYOCERA
Jnita__ E'C'@ FS-1900 Page Printer
| WRITE INFORMATION

\/—\

Partition Type. Type of data written (currently only type 2 is supported).
Partition Name. Name of data written.

Write Partition Length. Length (size) of the data written.

Others. Additional information, such as error information.

When the write information page is printed, the message display
returns to Ready.

If the writing was not completed successfully, an error code appears
on the message display. For details, see Error Messages on page
4-10. If this happens, press the GO key. The message display returns
to Ready.
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Deleting Data

Repeat above steps until you have transferred all data (files) that
you want to write to the CompactFlash card. Each time you finish
writing data, a CompactFlash card write information page is printed
from the printer showing the information explained in step 4 above,
but pertaining only to the data just written. To see all data contained
in the CompactFlash card at once, print a list of data names as
explained on page 1-89, Printing a List of Data Names.

You can use the printer’s operator panel to delete data from a
CompactFlash card, the Microdrive or the RAM disk.

1
2

~N O

Press the MENU key.

Press the A or V key repeatedly until Memory Card >, Hard Disk
> or RAM Disk Mode > appears.

Memory Card >

Press the > key.

Press the A or Vv key repeatedly until > Delete Data appears. The
data name also appears.

>Delete Data
data name

Press the ENTER key. A blinking question mark (?) appears before
the data name.

?Delete Data
no

>}

'igata name

Press the A or Vv key to display the desired data name.

Press the ENTER key. Processing appears and the data is deleted
from the CompactFlash card.
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Reading Fonts from a CompactFlash Card

If a font (CompactFlash) card is already inserted into the slot when the
printer is turned on, the fonts are automatically read into the printer.

To re-read fonts into the printer from a CompactFlash card, proceed as
follows.

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card > appears.

Memory Card >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Read fonts appears.

>Read fonts

5 Press the ENTER key. A question mark (?) appears.

>Read fonts ?

Press the ENTER key. Processing appears and the reading of fonts
from the CompactFlash card starts.

7 When the reading of fonts ends, the message display returns to
>Read fonts.

8 Press the MENU key. The message display returns to Ready.
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Formatting a Storage Device

A new CompactFlash card or Microdrive must be formatted before it can be
used in the printer. You can format the storage device using the printer
operator panel.

* Formatting will destroy any existing data on a storage device.

* You can format the Microdrive using the operator panel when the first
time you installed a new Microdrive. About formatting a new
Microdrive.

To format a CompactFlash card or the Microdrive, use the following
procedure:

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Memory Card > or Hard
Disk >appears.

Memory Card >

Press the > key.

Press the A or Vv key repeatedly until >Format appears.

W

>Format

5 Press the ENTER key. A question mark (?) appears.

>Format ?

6 Press the ENTER key. Processing appears and formatting of the
CompactFlash card starts.
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When the formatting is successfully completed, the printer automatically
prints out a format information page as shown below.

W} KYOCERA
\m”a/ m FS-1900 Page Printer
| FORMAT INFORMATION |

\/\

Capacity. The total size of the CompactFlash card or the Microdrive memory.

Used Space. The size the printer uses for its system.

Free Space. The size remaining in the CompactFlash card or the Microdrive for storing
data.

When the format information is printed, the message display returns to
Ready.

Printing a List of Data Names

The printer prints a list of all data names (referred to as partitions) stored
in the storage device for reference. (Printing a list is also available for a
font card.)

To print a list of data names for the CompactFlash card, the Microdrive, or
the RAM disk proceed as follows.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Memory Card >, Hard Disk
>, or RAM Disk Mode > appears.

Memory Card >

Press the > key.

Press the A or V key repeatedly until >List of Partitions
appears.

£~ )

>List of
Partitions
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5

6

Press the ENTER key. A question mark (?) appears.

>List of
Partitions ?

Press the ENTER key. Processing appears and the printing of the
list starts.

O} KYOCERA

~Jnita_ MIS\ FS-1900 Page Printer
| PARTITION LIST |

Device Information

Information

The list provides the following information that are automatically
generated by the printer about data currently stored in the storage
device:

Device Name/Number. Description for the storage device. For example,
‘MEMORY CARDY/A is indicated for a memory card.

Capacity. Total capacity of the storage device in bytes.

Used Space. The total space used for data stored in the storage device in bytes.
Free Space. The space remaining in the storage device for storing more data,
including the memory space required by the printer for its file system.
Partition Name. The name assigned automatically by the printer for written
data.

Partition Size. Size of the written data in bytes.

Partition Type. The type identifying the written data, i.e., whether it is host
data (Data) or font data (Font).

When the list of file names (partition list) for the storage device is
printed, the display returns to Ready.
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Configuration

This section explains the details of printer settings. The following items
are covered.

Page Protect Mode

Page Protect Mode

Linefeed (LF) Action
Carriage-Return (CR) Action
Wide A4 Pitch

Print Density

Total Printed Pages

Toner Counter Resetting
Message Language
Automatic Form Feed Timeout
Sleep Timer Setting

Printer Resetting

Resource Protection

Alarm (Buzzer) Setting

Auto Continue Setting

The Page Protect Menu does not normally appear, however, Page Protect
will be forcibly set to On if a print overrun error occurs due to insufficient
printer memory. When this has happened, be sure to reset Page Protect
to Auto (default) in order to maintain the optimum use of printer memory.

1
2

W

Press the MENU key.

Press the A or Vv key repeatedly until Page set > appears.

Page set >

Press the > key.

Press the A or V key repeatedly until >Page Protect appears.

>Page Protect
On

Press the ENTER key. A blinking question mark (?) appears.

?Page Protect

Mo

ip)
'i\On
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6 Press the A or Vv key repeatedly until Auto appears.

>Page Protect
? Auto

Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

Linefeed (LF) Action

This procedure instructs the printer what to do when it receives a linefeed
code (character code 0AH).

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Page set > appears.

Page set >

Press the > key.

Press the A or Vv key repeatedly until >LLF Action appears.

W

>LF Action
LF only

5 Press the ENTER key. A blinking question mark (?) appears.

?LF Action

\ol 1
ﬁ\LF only

6 Press the A or V key repeatedly until desired linefeed action
appears.

LF only A linefeed is performed. (default)
CR and LF A linefeed and carriage return are performed.
Ignore LF  The linefeed is ignored.

When the desired action is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

o0 N
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Carriage-Return (CR) Action

This procedure instructs the printer what to do when it receives a carriage-
return code (character code 0DH)

1
2

W

o0 N

Press the MENU key.

Press the A or Vv key repeatedly until Page set > appears.

Page set >

Press the > key.

Press the A or Vv key repeatedly until >CR Action appears.

>CR Action
CR only

Press the ENTER key. A blinking question mark (?) appears.

>CR Action
\'D/ R 1
q\C only

Press the A or Vv key repeatedly until desired carriage-return action
appears.

CR only A carriage-return is performed. (Default)
CR and LF A carriage-return and linefeed are performed.
Ignore CR  The carriage-return code is ignored.

When the desired action is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Wide A4 Pitch

Turn this to On to increase the maximum number of characters that can be
printed in a line for A4 page (78 characters at 10 pitch) and Letter size
page (80 characters at 10 pitch). This setting is effective in only PCL 6
emulation.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Page set > appears.

Page set >

Press the > key.

Press the A or Vv key repeatedly until >Wide A4 appears.

W

>Wide A4
Off

5 Press the ENTER key. A blinking question mark (?) appears.

SWide A4
M7 OF £
li\

Select On or Of £ using the A or V key.

Press the ENTER key.

oo ~NO®

Press the MENU key. The message display returns to Ready.
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Print Density

Configuration

The print density can be adjusted in five steps: from 01 (light) to 05 (dark).
The factory setting is 03.

1
2

W

o0 N

Press the MENU key.

Press the A or V key repeatedly until Print Quality > appears.

Print Quality >

Press the > key.

Press the A or V key repeatedly until >Print Density appears.

>Print Density
03

Press the ENTER key. A blinking question mark (?) appears.

>Print Density
~'I>,03
R

Select the print density from five steps from 01 (light) to 05 (dark)
using the A or V key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Total Printed Pages

This procedure displays the total number of printed pages.

1
2

W

5

Toner Counter Resetting

Press the MENU key.

Press the A or V key repeatedly until Life Counters > appears.

Life Counters >

Press the > key.

Press the A or Vv key repeatedly until >5Total Print appears, the
total number of printed pages displayed.

>Total Print
0012345

Press the MENU key. The message display returns to Ready.

When the toner container is replaced, reset the toner counter as follows so
that an accurate toner gauge measurement is indicated on the status page.
Note that if this operation is performed when the toner container is not
replaced, the toner gauge measurement will not be indicated correctly.

Also refer to the Installation Guide supplied with the toner kit when
replacing the toner container.

1
2

W

Press the MENU key.

Press the A or V key repeatedly until Life Counters > appears.

Life Counters >

Press the > key.

Press the A or V key repeatedly until >5New Toner Installed.
appears

>New Toner
Installed
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5 Press the ENTER key. A question mark (?) appears.

>New Toner
Installed ?

6 Press the ENTER key. The toner counter is reset. The message
display returns to Ready.

Message Language
You can select the language of the messages on the message display by

following the procedure given below. You can optionally download messages
in order language. Contact your Kyocera Mita dealer for information.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or V key repeatedly until >MSG Language appears. The
default message language is English.

W

>MSG Language

English

5 To change the language, press the ENTER key. A blinking question
mark (?) appears.

?MSG Language

> English
2 Englis
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6 Press the v/ key. The display cycles through the available selections
in the following order (The A key cycles in the reverse order):

>MSG Language
? English

\ 4

>Langue

? Francails

\ 4

>Anzeigesprache
? Deutsch

\ 4

>Lingua

? Italiano

\ 4

>Idioma

? Espafiol

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Automatic Form Feed Timeout

When the printer receives no data for a certain time, it time out and
releases the current interface: it prints whatever data it has in its buffer
and feeds out the page. You can adjust the time-out time as follows:

1
2

o0 N

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or V key repeatedly until >Form Feed Time appears.
The default setting is 30 seconds.

>Form Feed
Time Out 030sec.

Press the ENTER key. A blinking cursor () appears.

>Form Feed Time.
Time out 03bsec.

VRN
]

Press the A or V key to increase or decrease the value of the figure
where the cursor is blinking and set the desired time. The time can
be set between 0 and 495 seconds, in 5-second increments. You can
use the > and < keys to move the cursor right and left.

Display the desired time and press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Sleep Timer Setting

The printer has a sleep timer to conserve power when the printer is not
printing, processing, or receiving data. You can adjust the timer value, the
length of time the printer waits before entering sleeping mode in the
absence of data.

1
2

W

o0 N

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or V key repeatedly until >Sleep Timer > appears.
The default setting is 015 min.

>Sleep Timer >
015 min.

Press the ENTER key. A blinking cursor () appears.

>Sleep Timer
015/ min.

VTN

Press the A or V key to increase or decrease the value of the figure
where the cursor is blinking and set the desired time. The timer can
be set between 5 and 240 min, in 5-minute increments. You can use
the > and < keys to move the cursor right and left.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Turning Off the Sleep Timer

You can turn off the sleep timer function by following the procedure given
below.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or V key repeatedly until >Sleep Timer > appears.

W

>Sleep Timer >
015 min.

5 Press the > key and display >>Sleep Mode.

>>Sleep Mode
On

6 Press the ENTER key. A blinking question mark (?) appears.

>>Sleep Mode
s

? On
/|\

7 Select Of £ using the A or V key.

>>Sleep Mode
? Off

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

O o0
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Printer Resetting
The procedure described below resets the printer’s temporary conditions,
such as the current unit of measurement, page orientation, font, character
code set, margins, etc., set by commands to their default values.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Printer Reset appears.

>Printer Reset

5 Press the ENTER key. A question mark (?) appears.

>Printer Reset ?

6 Press the ENTER key again. Self test appears while the printer is
resetting itself, then Please wait followed by Ready.

Self test

v

Please wait

v

Ready
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Resource Protection

Configuration

When you switch from the PCL 6 emulation to another, all downloaded
fonts and macros are lost. Resource protection preserves these PCL
resources in memory so that they are intact when you change the
emulation back to PCL 6.

Resource protection requires extra memory to store the downloaded
fonts and macros. The total size of the printer memory recommended for

using the resource protection option is affected by several factors. See
Appendix B.

1
2

o0 N

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or Vv key repeatedly until >Resource Prot. appears.

>Resource Prot.
Off

Press the ENTER key. A blinking question mark (?) appears.

?Resource Prot.
N g

2

ﬁ\Off

Press the A or Vv key to display the desired mode. The display
changes as shown below.

Of £ (default)
Permanent
Perm / Temp

When the desired mode is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Alarm (Buzzer) Setting

In addition to the message displayed when the paper supply is exhausted,
or when paper jamming occurs, an audio warning is made to sound. This is
useful, for example, when the printer is in a location some distance from
the user.

The audio alarm is set to On when leaving the factory. If the alarm is set to
Off, it is made not to sound.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or Vv key repeatedly until Buzzer appears.

W

>Buzzer
On

5 Press the ENTER key. A blinking question mark (?) appears.

? 0On
/|\

Select On or Of £ using the A or V key.
Press the ENTER key.

Press the MENU key. The message display returns to Ready.

oo ~NO®
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Auto Continue Setting

If an error that still allows you to continue printing occurs (Memory
overflow Press GO, Print overrun Press GO, KPDL error Press
GO, and File not found Press GO), the next received data is
automatically printed after a set period of time elapses. For example, if the
printer is shared over a network as a network printer and one person
causes one of the above errors, after the set period of time elapses, the data
sent from the next person is printed.

1 Press the MENU key.

2 Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or Vv key repeatedly until Auto Continue > appears.

W

>Auto Continue >
Mode On

5 Press the ENTER key. A blinking question mark (?) appears.

>Auto Fontinue
\lg

Mode ? On
/|\

Select On or Of £ using the A or V key.
Press the ENTER key.

Press the MENU key. The message display returns to Ready.

oo ~NO®
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Setting the Auto Continue Recovery Time

Follow the procedure given below to change the recovery time for Auto
Continue.

1
2

W

o O

O o0

Press the MENU key.

Press the A or V key repeatedly until Others > appears.

Others >

Press the > key.

Press the A or V key repeatedly until Auto Continue Mode >
appears.

>Auto Continue >
Mode On

Press the > key and display >>Auto Continue Timer.

Press the ENTER key. A blinking cursor () appears.

>>Auto Continue
Timer 00bsec.

VIR
L]

Press the A or V key to increase or decrease the value of the figure
where the cursor is blinking and set the desired time. The time must
be set between 000 and 495 seconds, in 5-second increments. If set to
000, printing will be continued immediately without allowing any
time interval. You can use the > and < keys to move the cursor right
and left.

Display the desired time and press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Chapter2  Paper Selection

This chapter explains the following topics:

* General Guidelines
* Special Paper
+ Paper Type
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General Guidelines

General Guidelines

4

Note

Paper Availability

Paper Specifications

The printer is designed to print on high-quality copier bond paper (the kind
used in ordinary dry copier machines), but it can also accept a variety of
other types of paper within the limits specified below.

The manufacturer assumes no liability for problems that occur when
paper not satisfying these requirements is used.

Selection of the right paper is important. Using the wrong paper can result
in paper jams, misfeeding, curling, poor print quality, and paper waste, and
in extreme cases can damage the printer. The guidelines given below will
increase the productivity of your office by ensuring efficient, trouble-free
printing and reducing wear and tear on the printer.

Most types of paper are compatible with a variety of machines. Paper
intended for xerographic copiers can also be used with the printer.

There are three general grades of paper: economy, standard, and premium.
The most significant difference between grades is the ease with which they
pass through the printer. This is affected by the smoothness, size, and
moisture content of the paper, and the way in which the paper is cut. The
higher the grade of paper you use, the less risk there will be of paper jams
and other problems, and the higher the level of quality your printed output
will reflect.

Differences between paper from different suppliers can also affect the
printer’s performance. A high-quality printer cannot produce high-quality
results when the wrong paper is used. Low-priced paper is not economical
in the long run if it causes printing problems.

Paper in each grade is available in a range of basis weights (defined later).
The traditional standard weights are 16, 20, and 28 pounds (60 to 105 g/m?).

The following table summarizes the basic paper specifications. Details are
given on the following pages.

Item Specification
Weight Cassette: 60 to 105 g/m? (16 to 28 Ib/ream)
MP tray: 60 to 200 g/m? (16 to 53 lb/ream)
Thickness 0.086 t0 0.110 mm (3.4 to 4.3 mils)
Dimensional accuracy +0.7 mm (+0.0276 inches)
Squareness of corners 90° +0.2°
Moisture content 4t06 %
Direction of grain Long grain
Pulp content 80 % or more
2-2
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Selecting the Right Paper

Laser printing is a process involving laser light, electrostatic discharge,
toner, and heat. In addition, as the paper passes through the printer it
undergoes considerable sliding, bending, and twisting motions. A high-
quality printing paper matching the printer’s requirements withstands all
these stresses, enabling the printer to turn out clean, crisp printed copies
consistently.

Remember that all paper is not the same. Some of the factors to consider
when selecting paper for the printer are as follows:

Condition of the Paper

Avoid using paper that is bent at the edges, curled, dirty, torn, embossed, or
contaminated with lint, clay, or paper shreds.

Use of paper in these conditions can lead to illegible printing, misfeeding,
and paper jams, and can shorten the life of the printer. In particular, avoid
using paper with a surface coating or other surface treatment. The paper
should have as smooth and even a surface as possible.

Composition

Do not use paper that has been coated or surface-treated and contains
plastic or carbon. The heat of fusing can cause such paper to give off
harmful fumes.

Bond paper should contain at least 80 % pulp. Not more than 20 % of the
total paper content should consist of cotton or other fibers.
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Paper Size

Cassettes and an MP tray are available for the paper sizes listed in the
table below. The dimensional tolerances are +0.7 mm (+0.0276 inches) for
the length and width. The angle at the corners must be 90° +0.2°.

Multi-purpose tray Size Cassette or multi- Size
purpose tray
Monarch 3-7/8 x 7-1/2 inches Legal 8-1/2 x 14 inches
Business 4-1/8 x 9-1/2 inches Letter 8-1/2 x 11 inches
ISO A6 105 x 148 mm ISO A4 210 x 297 mm
ISO DL 11x22cm ISO A5 148 x 210 mm
ISO C5 16.2 x 22.9 cm JISB5 182 x 257 mm
ISOB5 17.6 x 25 cm Custom Cassette:
Executive 7-1/4 x 11/2 inches 148 to 216 mm x 210 to 297 mm

Commercial 9

3-7/8 x 8-7/8 inches

Commercial 6-3/4

3-5/8 x 6-1/2 inches

JIS B6

128 x 182 mm

ForU.S. A.: 5-13/16 to 8-1/2
inches x 8-1/4 to 14 inches

MP tray:
70t0 216 mm x 148 to 297 mm

Oficio IT 8-1/2 x 13 inches (2-13/16 to 8-1/2 inches x
Statement 5-1/2 x 8-1/2 inches 5-13/16 to 11-11/16 inches)
Folio 210 x 330 mm

Hagaki 100 x 148 mm

Ofuku-Hagaki 148 x 200 mm

Youkei 2 114 x 162 mm

Youkei 4 105 x 235 mm

Smoothness

The paper should have a smooth, uncoated surface. Paper with a rough or
sandy surface can cause voids in the printed output. Paper that is too
smooth, however, can cause multiple feeding and fogging problems.
(Fogging is a gray background effect.)

Basis Weight

Basis weight is the weight of a standard quantity of paper. In the
traditional system, the standard quantity is a ream consisting of 500
sheets measuring 17 x 22 inches each. In the metric system the standard
quantity is 1 square meter.

Paper that is too light or too heavy can cause misfeeding, jams, and
premature wear of the printer. Uneven paper weight can cause multiple
feeds, print defects, poor toner fusing, blurring, and other print quality
problems. The proper weight is 60 to 105 g/m? for the paper cassette, and
60 to 200 g/m? for the MP tray.
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Paper Weight Equivalence Table

Paper weight is listed with expression in U.S. bond weight (Ib) and
European metric (g/m?). The shaded point indicates the standard weight.

U. S.Bond

Weight (Ib) 16 17 | 20 | 21 | 22 | 24 | 27 | 28 | 32 34 | 36 | 39 | 42 | 43 | 47 53
Europe Metric
Weight (g/m?) 60 | 64 | 75 | 80 | 81 | 90 | 100 | 105 | 120 | 128 | 135 | 148 | 157 | 163 | 176 | 199

Thickness (Caliper)

Thick paper is referred to as high-caliper paper and thin paper as low-
caliper paper. The paper used with the printer should be neither extremely
thick nor extremely thin. If you are having problems with paper jams,
multiple feeds, and faint printing, the paper you are using may be too thin.
If you are having problems with paper jams and blurred printing, the
paper may be too thick. The proper thickness is 0.086 to 0.110 mm (3.4 to
4.3 mils).

Moisture Content

Moisture content is defined as the percent ratio of moisture to the dry mass
of the paper. Moisture can affect the paper’s appearance, feedability, curl,
electrostatic properties, and toner fusing characteristics.

The moisture content of the paper varies with the relative humidity in the
room. When the relative humidity is high and the paper absorbs moisture,
the paper edges expand, becoming wavy in appearance. When the relative
humidity is low and the paper loses moisture, the edges shrink and
tighten, and print contrast may suffer.

Wavy or tight edges can cause misfeeding and alignment anomalies. The
moisture content of the paper should be 4 to 6%.

To ensure the proper moisture content, it is important to store the paper in
a controlled environment. Some tips on moisture control are:

» Store paper in a cool, dry location.

* Keep the paper in its wrapping as long as possible. Rewrap paper that
is not in use.

* Store paper in its original carton. Place a pallet, etc., under the carton
to separate it from the floor.

* After removing paper from storage, let it stand in the same room as the
printer for 48 hours before use.

* Avoid leaving paper where it is exposed to heat, sunlight, or damp.
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Paper Grain

When paper is manufactured, it is cut into sheets with the grain running
parallel to the length (long grain) or parallel to the width (short grain).
Short grain paper can cause feeding problems in the printer. All paper used
in the printer should be long grain.

Other Paper Properties

Porosity: Refers to the density of the paper structure; that is, how openly
or compactly the fibers are bonded.

Stiffness: Limp paper can buckle inside the printer, while paper that is too
stiff may bind. Either way the result is a paper jam.

Curl: Most paper has a natural tendency to curl in one direction. The
paper should be loaded so that the natural curl is downward, to counteract
the upward curl imparted by the printer. Printed sheets will then come out
flat. Most paper also has a top and bottom surface. Loading instructions
are usually given on the paper package.

If the paper is considerably curled in one direction, e.g. when the paper
was used to print on one side, try to roll the paper in the opposite
direction to counteract the curl. Printed sheets will then come out flat.

Electrostatic properties: During the printing process, the paper is
electrostatically charged to attract the toner. The paper must be able to
release this charge so that printed sheets do not cling together in the
output tray.

Whiteness: The contrast of the printed page depends on the whiteness of
the paper. Whiter paper provides a sharper, brighter appearance.

Quality control: Uneven sheet size, corners that are not square, ragged
edges, welded (uncut) sheets, and crushed edges and corners can cause the
printer to malfunction in various ways. A quality paper supplier should
take considerable care to ensure that these problems do not occur.

Packaging: Paper should be packed in a sturdy carton to protect it from
damage during transport. Quality paper obtained from a reputable
supplier is usually properly packaged.
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Special Paper

Special Paper

This section explains printing on special paper. The page printer can use
the following types of special paper. In this case, set the media type
according to the table below.

Paper type Media type
Colored paper Color
Preprinted paper Preprinted
Overhead projector transparencies Transparency
Postcards Cardstock
Envelopes Envelope
Labels Labels

When using the above types of paper, be sure to use products that are
specified for use with photocopiers and/or page printers. Feed paper other
than colored paper or pre-printed paper from the MP (multi-purpose) tray.

Use paper that is sold specifically for use with copiers (heat-fusing type).
Label paper and envelopes should not be placed in the cassette; they must
be fed manually and delivered in the face up stack.

Since the composition and quality of special paper vary considerably,
special paper is more likely than white bond paper to give trouble during
printing. No liability will be assumed if moisture, etc., given off in printing
on special paper causes harm to the machine or operator.

Before purchasing any type of special paper, test a sample on the printer
and check that print quality is satisfactory.

Specifications for each type of special paper are given below.

Transparency (Overhead Projection Film)

Transparency must be able to withstand the heat of fusing during the
printing process. It should satisfy the conditions given in the table below.

Item Specification

Tolerance of heat Must tolerate at least 190 °C (374 °F)
Thickness 0.100t0 0.110 mm (3.9 to 4.3 mils)
Material Polyester

Dimensional accuracy +0.7 mm (+0.0276 inch)

Squareness of corners 90° +0.2°

To avoid trouble, transparency must be delivered face-up.

If transparency jams frequently, pull the top of the sheet very gently as it
leaves the printer.
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Adhesive-Backed Labels

The basic rule for printing on adhesive labels is that the adhesive must
never come into contact with any part of the printer. Adhesive paper
sticking to the drum or rollers will damage the printer.

Be sure to feed label paper from the MP tray. Feeding label paper from a
paper cassette may cause printer failure.

Note
Label paper has a structure comprised of three layers, as shown in the

figure below. The top sheet is printed on. The adhesive layer consists of
pressure-sensitive adhesives. The carrier sheet (also called the linear or
backing sheet) holds the labels until use. Due to the complexity of its
composition, adhesive-backed label paper is particularly likely to give
trouble in printing.

Top sheet (white bond paper)

Adhesive
Carrier sheet

Adhesive label paper must be entirely covered by its top sheet, with no
spaces between the individual labels. Labels with spaces in between are
apt to peel off, causing serious paper jam problems.

Some label paper is manufactured with an extra margin of top sheet
around the edge. Do not remove the extra top sheet from the carrier sheet
until after printing is finished.

Acceptable Unacceptable

~&— Top sheet—p

Carrier sheet—»
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The table below lists the specifications for adhesive label paper.

Item Specification

Weight of top sheet 44 to 74 g/m? (12 to 20 Ib/ream)
Composite weight 104 to 151 g/m? (28 to 40 lb/ream)
Thickness of top sheet 0.086 t0 0.107 mm (3.9 to 4.2 mils)
Composite thickness 0.115t0 0.145 mm (4.5 to 5.7 mils)
Moisture content 4 to 6 % (composite)

Envelopes

The printer can print on envelopes using paper with a basis weight of 60 to
79 g/m? (16 to 21 lb/ream). Envelopes must be manually fed.

An envelope is a more complex object than a single sheet of paper. For this
reason, it may not be possible to obtain consistent print quality over the
entire envelope surface.

Many envelopes have a diagonal grain orientation (See Paper Grain on
page 2-6). This orientation is more likely to wrinkle and crease on its way
through the printer. Before purchasing envelopes for use with the printer,
test a sample to verify the envelope’s suitability.

Do not use envelopes that have an encapsulated liquid adhesive.

Avoid long printing runs consisting of envelopes only. Extensive envelope
printing can cause premature printer wear.

To avoid jamming due to curled envelopes, do not leave more than
approximately 10 printed envelopes stacked in the paper trays during
multiple envelope printing.

Colored Paper

Colored paper should satisfy the same conditions as white bond paper,
listed in Paper Specifications on page 2-2. In addition, the pigments
used in the paper must be able to withstand the heat of fusing during the
printing process (up to 200 °C or 392 °F).

Preprinted Paper

Preprinted paper should have a bond paper base. The preprinted ink must
be able to withstand the heat of fusing during the printing process, and
must not be affected by silicone oil.

Do not use paper with any kind of surface treatment, such as the type of
paper commonly used for calendars.
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Recycled Paper

Select recycled paper that meets the same specifications as the white bond
paper (see Paper Specifications on page 2-2) except whiteness.

Before purchasing recycled paper, test a sample on the printer and check
that the print quality is satisfactory.
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Paper Type

Paper Type

The printer is capable of printing under the optimum setting for the type of
paper being used.

Setting the paper type for the paper source from the printer’s operator
panel will cause the printer to automatically select the paper source and
print in the mode best suited to that type of paper.

A different paper type setting can be made for each paper source including
the MP tray. Not only can preset paper types be selected, but it is also
possible for you to define and select customized paper types. See Custom
Paper Type on page 1-32.

The following types of paper can be set.

Paper source | MP Paper Paper Duplex path
tray Cassette | Weight (MP tray available
only in Cassette

Paper Type mode)

Plain Yes Yes Normal Yes
Transparency Yes No Heavy (Thick) No
Preprinted Yes Yes Normal Yes
Labels Yes No Normal No
Bond Yes Yes Normal Yes
Recycled Yes Yes Normal Yes
Vellum Yes No Light (Thin) No
Rough Yes Yes Normal Yes
Letterhead Yes Yes Normal Yes
Color Yes Yes Normal Yes
Prepunched Yes Yes Normal Yes
Envelope Yes No Normal No
Cardstock Yes No Heavy (Thick) No
Custom 1 (to 8)* Yes Yes Normal Yes

Yes: Can be stored No: Cannot be stored
This is a paper type defined and registered by the user. Up to eight types of user settings may
be defined. For details on Custom Paper Type on page 1-32.

£
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Chapter3 Maintenance

This chapter explains how to replace the toner container and how to clean parts such as the
registration roller and charger wire.

This chapter explains the following topics:

* Toner Container Replacement
* Waste Toner Box Replacement
* Cleaning
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Toner Container Replacement

Toner Container Replacement

The toner container in the printer should be replaced as soon as the
message display shows Toner low TK-50 or soon after. If you continue to
use the printer, eventually the toner supply will be exhausted at which
point the printer will stop printing and the Replace toner Clean
printer message will be shown instructing you to install a new toner kit.

Toner Container Replacement Interval

Assuming an average toner coverage of 5% and Ecoprint mode turned off,
the toner container will need replacing approximately once every 10,000
pages.*

* For a new printer with a toner kit installed for the first time, the

number of copies that can be printed will be approximately 5,000.

Toner Kits to be Used

Name: TK-50 (10,000 pages)

Contents: Toner container
Waste toner box
Wiper cloth

Grid cleaner

2 plastic bags (for disposal of the old toner container and
waste toner box)

Installation Guide

* Be sure to distance items such as floppy disks during toner container
replacement.

* Be sure to clean the inside of the printer when replacing the toner
container. For details, see Cleaning on page 3-9.

* Use of original Kyocera Mita toner kits is highly recommended to
prevent printer trouble and ensure the long life of the printer.

3-2
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Toner Container Replacement

Replenishing Toner

1 Open the printer top cover all the way.

2 Pull the lock lever (green colored) to the right and gently lift the old
toner container.

Lock Lever

:] Keep the toner container as level as possible while removing.

3 Put the old toner container in the plastic bag supplied with the toner
kit and dispose of it.

Old Toner Container

The old toner container may be incinerated without the risk of generating
harmful gas.

3-3

Download from Www.Somanuals.com. All Manuals Search And Download.



Toner Container Replacement

Take the new toner container from the bag.

oA

With the label side down, thoroughly shake the toner container (in
the direction of the arrows) ten times or more. This ensures that the
toner is evenly distributed inside.

New Toner Container

10 times or
more

6 Carefully remove the protective seal (orange colored).

Protective Seal

7

3-4
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Toner Container Replacement

8 Push firmly on the top of the toner container at the positions marked
PUSH HERE.

When the toner container fits into place, it will lock with a clicking
sound.

container. If the toner container is replaced when Replace toner

0 It is necessary to clean the inside of the printer after replacing the toner

Clean printer is displayed, Clean printer Press GO will appear
after replacement. After cleaning the inside of the printer (see Cleaning
on page 3-9), the message will disappear when the GO key is pressed,
and the printer will be ready for printing.

3-5
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Waste Toner Box Replacement

Waste Toner Box Replacement

Replacing the Waste Toner Box

When replacing the toner container, the used waste toner box in the
printer should also be replaced with the new one from the new toner kit.

Note
1 Open the left cover on the left side of the printer.

W
I
[

T
it

i

g

4
2

2 While holding the waste toner box, press the lock lever and then
gently remove the waste toner box.

Old Waste
Toner Box

Left Cover

Lock Lever

Remove the waste toner box as gently as possible so as not to scatter
the toner inside. Do not let the opening of the waste toner box face
“Note  downward.

3-6
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Waste Toner Box Replacement

3 Cap the waste toner box after removing from the printer.

ﬁ con

A

(€

Old Waste
Toner Box

4 To avoid toner spilling, place the capped waste toner box in the
plastic bag supplied before proper disposal.

Plastic Bag /@

New Waste
Toner Box

3-7
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Waste Toner Box Replacement

6 Insert the new waste toner box as shown in the figure below. The box
will be locked when it fits into place.

)
i

A

=
=
=
=
=
=
=
=

New Waste Toner
Box

7

The printer parts must be cleaned when replacing the toner
container. See Cleaning on page 3-9.

8 When the toner container is replaced, reset the toner counter (see
Toner Counter Resetting on page 1-96).

3-8
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Cleaning

Cleaning

To avoid print quality problems, the following printer parts must be
cleaned with every toner container replacement. In addition, the charger
wire and paper transfer unit should be cleaned from time to time, or
whenever print quality problems occur.

0 If the toner container was replaced when Replace toner Clean

printer was displayed, Clean printer Press GO will appear after
replacement. After cleaning the inside of the printer following the
procedure shown below, press the GO key; the message will disappear
and the printer will be ready for printing.

Cleaning the Charger Wire

The charger wire is a part in the drum unit that needs to be periodically
cleaned. You can clean the charger wire by pulling the cleaning knob as
instructed below.

1 Open the left cover on the left side of the printer.

\y

=

T =S
==
Ul S
ZeZ\E s
Z22 S5
.

/ ~

/

Left Cover ——  Charger Unit

2 Pull the cleaning knob (green colored) slowly in and out a few times.
This cleans charger wire inside the printer.

\/

!4 SIS
ze2 |k =
Ze\b
OIS
2SS
)

v

@

Cleaning Knob
(Green) \D\
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Cleaning

Cleaning the Charger Grid

The charger grid is a part located at the bottom of the charger unit, which

also needs to be cleaned. You should use a grid cleaner attaching it to the
printer and pull out the charger unit as instructed below.

1

Take the grid cleaner from protective bag in the new toner kit, and
remove the cap.

Cap
Protective Bag

Grid Cleaner

The grid cleaner pad is supplied with water soaked. Perform the
following procedure before the pad dries.

2

Attach the grid cleaner to the printer with the pad at the top, as
shown in the figure.

/

oI
A
]

\ Grid Cleaner
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Cleaning

3 Slowly pull out and then push back in the charger unit at least 5
times. It is easier to pull out the charger unit for the first time if it is
raised slightly, as shown in the figure.

This cleans grid part underneath the charger unit.

Charger Unit

N\

£

4 Remove the grid cleaner from the printer and dispose of it. The grid
cleaner is not re-usable.

I

D
A
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Cleaning

5 After cleaning the charger wire and grid, push the charger unit all
the way in and close the left cover.

Paper Transfer Unit

To avoid print quality problems due to paper dust and debris, clean the
paper transfer unit in the following manner.

1 While pulling the paper transfer unit release lever (green colored),
pull out the paper transfer unit.

Paper Transfer Unit Release Lever
(green colored)

3-12
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Cleaning

2 Wipe away the paper dust on the registration roller and the paper
ramp using the wiper cloth included in the toner kit.

Transfer Roller [Black]
See Note below.

<

Wiper Cloth o o

/\ N

s ,&”‘“ Paper Ramp

O N
,‘{f‘/y‘v Registration Roller [Metal]

// N

4

Paper Transfer Unit

Be careful not to touch the transfer roller (the black roller) during
cleaning as this may adversely affect print quality.
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Chapter4  Troubleshooting

This chapter explains how to handle printer problems that may occur. If a problem cannot be
corrected, contact your Kyocera Mita dealer.

This chapter explains the following topics:

* General Guide

* Print Quality Problems

* Indicators and Messages
* Correcting a Paper Jam

4-1

Download from Www.Somanuals.com. All Manuals Search And Download.



General Guide

General Guide

There are quite a few printer problems that you can deal with by yourself. This section explains how to
correct these problems. Therefore, if some kind of problem should occur, check the following before
concluding the printer is broken.

Symptom

The printer will not
print from the
computer.

Check Items Corrective Action
Check the READY (O Off Look through the items below and check
indicator. anything that seems appropriate.
Flashing An error has occurred. For details on error
warnings and remedies, see Indicators on
page 4-6.
Lit See the appropriate item below.
Check the ATTENTION Flashing See Indicators on page 4-6
indicator. Lit

A maintenance message appears in the

message display.

See Maintenance Messages on page 4-7

Print quality is not good.

See Print Quality Problems on page 4-3.

Paper is jammed.

See Correcting a Paper Jam on page 4-12.

Nothing lights on the
operator panel even
when power is turned
on and the fan makes
no noise.

Check that the power cord is properly
plugged into the power outlet.

Turn off the printer’s power, plug in the power
cord securely, and try turning on the printer’s
power again.

Check that the power switch is really in the ON (| ) position.

The printer prints a
status page, but data
from the computer is
not being printed
normally.

Check the interface cable.

Connect both ends of the interface cable
securely. Try replacing the printer cable. For
details on the parallel interface for this printer,
see Appendix C.

Check program files and application

software.

Try printing another file or using another
print command. If the problem occurs only
with a specific file or application, check the
printer settings for that application.

If you still cannot correct a printer problem even after checking the above, please contact your Kyocera

Mita dealer.

4-2
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Print Quality Problems

Print Quality Problems

As the following table shows, there are many possible causes of print quality problems, such as blank
output as. The troubleshooting procedure for each type of problem is explained below. If you still can not
solve the problem, contact your Kyocera Mita dealer.

Printed Results Corrective Action

Completely blank printout Check the developer unit.

Open the printer top cover and check that the developer
unit is inserted correctly and check that the developer’s
connector is connected properly.

Check the toner container.

Open the printer top cover and check that the toner
container is correctly installed in the printer. See Toner
Container Replacement on page 3-2.

All-black printout Check the charger unit.
Open the printer left cover and check that the charger
unit is correctly installed.

Dropouts, horizontal streaks, stray dots Clean the charger wire.
Open the printer left cover. Pull the cleaning knob (green
colored) slowly in and out a few times. See Cleaning on

ABC | [ABC| |ABC ||psso
123 | [123 | | 123

(Continued on next page)
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Print Quality Problems

Printed Results

Corrective Action

Black or white vertical streaks

ABC | | ABC
123 123

Check the operator panel.

Ifthe Toner low TK-50 message is displayed and the
ATTENTION indicator is flashing, install a new toner kit.
See Toner Container Replacement on page 3-2.

Clean the charger wire.

Open the printer left cover. Pull the cleaning knob (green
colored) slowly in and out a few times. See Cleaning on
page 3-9.

Faint or blurred printing

ABC | | ABC
123 123

ABC
123

Check the Ecoprint setting.
When this setting is On, switch it to Of £ on the Operator
Panel. (See Ecoprint on page 1-54)

Check the operator panel.

* Ifthe Toner low TK-50 message is displayed and
the ATTENTION indicator is flashing, install a new
toner kit. See Toner Container Replacement on
page 3-2.

* Setthe print density from the operator panel to a
higher level than the current setting. See Print
Density on page 1-95.

* Make sure the paper type setting is correct. See
Paper Type on page 2-11

Clean the charger wire.

Open the printer left cover. Pull the cleaning knob (green
colored) slowly in and out a few times. See Cleaning on
page 3-9

Grey background.

Check the operator panel.

Ifthe Toner low TK-50 message is displayed and the
ATTENTION indicator is flashing, install a new toner kit.
See Toner Container Replacement on page 3-2.

Check the print density.

Display the print density menu from the operator panel
and select a lighter density setting. See Print Density on
page 1-95.

Clean the charger wire.

Open the printer’s left cover. Pull the cleaning knob
(green colored) slowly in and out a few times. See Toner
Container Replacement on page 3-2.

Check the charger unit installation.

Open the printer left cover and check that the charger
unit is correctly installed and seated as far as it will go.
See Cleaning on page 3-9.

(Continued on next page)
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Print Quality Problems

Printed Results Corrective Action

Dirt on the top edge or back of the paper Check the paper chute and the ramp.
_ _ Pull out the paper transfer unit and check for toner on the

free cloth. See Cleaning on page 3-9.

Check the transfer roller.
If the transfer roller is dirty with toner, try printing

paper ramp. Clean the paper ramp using a soft, dry, lint-
several pages.

Characters out of position. Check the file or program.

Check whether the problem is being caused by a
PRESCRIBE command error. If the problem occurs only
with a specific file or program, the most likely cause is an
error in a parameter to a command or command syntax.

ABC

19
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Indicators and Messages

Indicators and Messages

The tables on the following pages indicate how to respond to problems
indicated by the operator panel indicators and messages.

Indicators
Indicator Name Condition Description
Flashing An error occurs that you can clear by yourself.
Ready Lit The printer is on-line. The printer is ready to print.
QO = reaoy | dicator The printer is off-line. The printer stores but does not print received
Off data. Also indicates when printing is automatically stopped due to
occurrence of an error.
Dat Flashing Data transfer is taking place.
ata
DB = oam indicator Lit Either data is being processed, or data is being written onto the
option CompactFlash card or Microdrive.
Flashin The printer needs maintenance attention or the printer is warming
g up (Please wait).
I = arrenmion ﬁéfggg? Lit A problem or an error occurs that you can clear by yourself. (For
example, a paper jam occurs.)
Off Operations are normal.

4-6
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Indicators and Messages

Maintenance Messages

The following table lists maintenance messages that you can deal with by yourself. If Call service
person appears, turn off the printer, disconnect the power cord, and contact your Kyocera Mita dealer.

Message

Corrective Action

Add paper (paper source)

The paper has run out. Supply paper according to the paper source displayed (paper
cassette, MP tray, or optional paper feeder).

Messages indicating the printer status (Ready, Please wait, Processing®,
Waiting, and FormFeed Time Out®) are displayed alternately.

* These messages will not appear if the number of copies is set to 2 or more.

Call service

person FO

The ATTENTION indicator turns on and the READY indicator goes off. Indicates a
problem with the controller and the operator panel. Call a service person. The printer
does not operate when this message is displayed.

Call service

HH#H#

The ATTENTION indicator turns on. Indicates a controller error. Call a service person.
The printer does not operate when this message is displayed.

Call service
##H##:0123456

The ATTENTION indicator turns on. Indicates a mechanical error. Call a service
person. 0123456 indicates the number of printed pages.

Cassette #
not loaded

The paper cassette may not be propery inserted into the printer. Reinsert the paper
cassette. The paper source number (#) is only displayed when there is an option paper
feeder installed.

Check waste
toner box

A
71N

The waste toner box is not installed. After installing the waste toner box, you should
be able to print. Replace the old waste toner box with the new one which is included
inthe toner kit. The message will also be shown if the waste toner box has become full.
The waste toner box should be replaced when the message display eventually shows
Toner low TK-50.See Toner Container Replacement on page 3-2.

Clean printer
Press GO

Please clean the inside of the printer. See Cleaning on page 3-9.

This message will be displayed when replacing the toner container after the message
Replace toner TK-50 is displayed. After cleaning the inside of the printer, press
the GO key and the printer will be ready for printing.

If Auto Continue is set to On, printing will be automatically resumed after a preset

{2 | period of time.

Close duplexer Open the option duplexer rear cover, then close tightly.

rear cover

Close Open the left cover, then close tightly.

left cover

Close sorter Open the sorter rear cover, then close tightly.

rear cover

Close Open the stacker cover, then close tightly.

stacker cover

Close Open the top cover, then close tightly.

top cover

Close paper Open the paper transfer unit, then close tightly.

transfer unit

Face-down tray The face-down output tray has become full (approx. 250 pages). You must remove all

paper full printed pages from the face-down output tray. When the printer senses that the face-

down output tray is empty again, it will continues printing into the face-down output

2 |tray.

< :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)
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Indicators and Messages

Message

Corrective Action

Load Cassette #
(paper size) / (paper type)*

*(paper size) and (paper
type) are displayed flashing
alternately.

<

There is data for printing that matches with a paper cassette setting (paper size,
paper type), but there is no paper in the paper cassette.

Set paper into the paper source as displayed on the operator panel, and press the
GO key to restart printing. However, the paper source number (#) is only displayed
when there is an option paper feeder installed.

Or, ifyou want to print from a different paper source press the A and \/ key to display
Use alternative? and you can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling >
appears. By pressing the > key, the paper type settings menu appears. After setting
the correct paper type, press the ENTER key and printing starts.

Load MP tray
(paper size)/(paper type)

*(paper size) and (paper
type) are displayed flashing
alternately.

o

There is no paper cassette set (paper size, paper type) that matches with the data for
printing, so printing is done from the MP tray. Set paper into the MP tray that
matches the paper size and type shown on the display and press the GO key to restart
printing.

Or, if you want to print from a different paper source press the A and \/ key to display
Use alternative? and you can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling >
appears. By pressing the > key, the paper type settings menu appears. After setting
the correct paper type, press the ENTER key and printing starts.

-
~

Missing
duplex drawer

The duplex drawer is either not installed or incorrectly inserted. Insert the duplex
drawer securely.

Option interface
Error

A failure has occurred with the option network interface card.
Check the option interface installed in the printer.

Paper jam

HEHHH RS

A

/1N

Open the top cover or the paper transfer unit and correct the paper jam (or paper mis-
feeding in the paper cassette). The location of the paper jam is also indicated in place
of the #’s. Online help messages which are useful for correcting the paper jam will be
displayed by pressing the B key. (See Correcting a Paper Jam on page 4-12)

Remove paper

There is still paper in the option sorter’s tray indicated by # when the power was

sorter tray ## turned on or the sorter’s mode was switched. Remove all the paper inside the sorter.
LR
Replace toner Replace the toner container using a new toner kit. The printer does not operate when
Clean printer this message is displayed. See Toner Container Replacement on page 3-2.
LR
Sorter tray ## The sorter tray indicated by # is now full. Remove some of the paper from the sorter

paper full

A

/1N

tray concerned.

Toner low
TK-50

Replace the toner container using a new toner kit. See Toner Container
Replacement on page 3-2.

< :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)
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Indicators and Messages

Message

Corrective Action

Unsupported
external device

An unsupported option hardware has been installed. Be sure to install proper option
hardware compatible with the FS-1900.

Warning
image adapt

Printing job cannot be done in current resolution because there is not enough internal
memory. Try adding more memory or changing resolution. See Appendix B.

Warning
low memory

The printer’s internal memory is running low due to the number of fonts and macros
downloaded. Print a status page to see how much user memory is left, and try deleting
unnecessary fonts and macros. See Appendix B.
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Indicators and Messages

Error Messages

The following table lists error messages that can be dealt with by the user.

Message

Corrective Action

File not found
Press GO

A
/N

VMB: A VMB tray that was specified for output does not contain any jobs, or the VMB
tray is not being used. Confirm the VMB tray.

If Auto Continue is set to On, printing will be automatically resumed after a preset
period of time. See Auto Continue Setting on page 1-105.

Format error
Memory card

This message appears when the printer is in the ready state and the CompactFlash
(memory) card is not formatted, and therefore cannot be read or written. Follow the
procedure in Formatting a Storage Device on page 1-88 to format the card.

Format error
Hard disk

Initialization (formatting) of the Microdrive is required. Initialize the Microdrive.
(See Operating the Storage Device on page 1-81.)

Hard disk err ##
Press GO

A
/N

Look at the error code given in place of ## and refer to the corresponding description
given below.

01: Microdrive format error. If this error recurs even if the power has been turned off
and then on, reformat the Microdrive.

The disk system is not installed. Recheck the requirements for using the system
and the devices.

There is no available Microdrive space. Delete unnecessary files, etc., in order to
free up space.

The specified file does not exist in the Microdrive.

There is no memory available to the Microdrive system. Increase the available
memory.

Formatting is not possible because host data is being spooled on the Microdrive.
Wait until the Microdrive is ready, and then format.

VMB; Alias error (the alias setting was lost, or the VMB tray corresponding to
the alias does not exist). Set the alias again.

Code job; The number of permanent code job reached the limit value, and no
more can be saved. Either delete some unnecessary jobs, etc., or increace the
limit.

99: A print job for the specified ID does not exist in the Microdrive.

02:

04:

05:
06:

10:

85:

97:

I/F occupied

This message is displayed when you attempt to use the printer’s operator panel to
change the environmental settings on the interface from which data are presently
being received.

ID error

The ID entered for a private job, or a stored job is not correct. Check the ID that is set
using the printer driver.

Insert the same
memory card

You have inserted the wrong CompactFlash (memory) card when the Insert again
message was displayed. Remove the wrong CompactFlash card from the printer’s
CompactFlash card slot and insert the correct CompactFlash card. The printer again
reads it from the beginning of the data.

KPDL error
Press GO

##

<

Current print processing cannot continue. To print out an error report, display >
Print KPDL errs from the mode select menu, and select On. Press the GO key to
resume printing. You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a preset
period of time. See Auto Continue Setting on page 1-105.

%< :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)
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Indicators and Messages

Message

Corrective Action

Memory card err
Insert again

The CompactFlash card is accidentally removed from the printer’s memory card slot
during reading. If you continue reading the memory card, insert the same memory
card into the slot again. The printer again reads it from the beginning of the data.
Note: We recommend that you follow the reading procedure from the
beginning to ensure correct reading of the memory card.

Memory overflow
Press GO

/1N

The total amount of data received by the printer exceeds the printer’s internal
memory. Try adding more memory (expansion DIMM). Press the GO key to resume
printing. You can abandon printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a preset
period of time. See Auto Continue Setting on page 1-105.

MemoryCard err##
Press GO

VAR

This message appears when an error occurs during access to the CompactFlash card
using the PRESCRIBE RWER command or from the printer’s operator panel. Look at
the error code given in place of ## and refer to the corresponding description given
below.

01: The CompactFlash card does not meet specifications. This CompactFlash card
cannot be used by this printer. Insert a CompactFlash card which can be used by
this printer.

(See CompactFlash (Memory) Card on page B-30.)

02: The CompactFlash card is not installed. Recheck the requirements for using the
CompactFlash card.

04: The capacity of the CompactFlash card is insufficient. Clean up files.

05: Specified file not on CompactFlash card.

06: No memory for use by CompactFlash card. Expand printer memory.

Paper path error

VAR

There is no paper cassette in the feeder, or the cassette is not inserted properly. After
reinserting the paper cassette, you should be able to print. When two or more option
feeders are installed and the lowest one is selected, the same message will appear if
any of the upper paper feeder and the printer cassette is improperly installed.

Print overrun
Press GO

VAR

The data transferred to the printer was too complex to print on a page. Press the
GO key to resume printing. (The page may break in some pages.)

You can abandon printing by the CANCEL key.

Note: After this message is displayed, page protect mode will be on. To
maintain optimum use of memory during printing, display >Page protect
from the operator panel, and re-select Auto.

See Page Protect Mode on page 1-91.

If Auto Continue is set to On, printing will be automatically resumed after a preset
period of time. See Auto Continue Setting on page 1-105.

RAM disk error ##
Press GO

/1N

Look at the error code given in place of ## and refer to the corresponding description
given below.

01: Abnormal format. Try turning the power off and on again.

02: RAM disk mode is Of £. Turn RAM disk mode On.

04: No disk space. Clean up files.

05: Specified file not on disk.

06: No memory for use by disk system. Expand printer memory.

Virtual mail box
full

The storage area for the VMB is full. Print out accumulated VMB data.

%< :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.
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Correcting a Paper Jam

Correcting a Paper Jam

The Paper jam message is displayed on the message display when paper
becomes stuck in the paper transport system, the paper feed timing is
incorrect, or paper fails to feed at all. The jam can be corrected by removing
the paper.

The printer goes off-line when the Paper jam message is displayed.

When a paper jam occurs, a paper jam message and the paper jam location
are indicated on the message display. Details of the messages and paper
jam locations are as follows:

Paper jam Pape? jam Pt Reference
message location page
Paper jam A Paper is jammed at the paper 2414
Cassette 1 cassette or inside the printer.
Paper jam Paper is jammed at the option

B , 4-14
Cassette 2 (to4) paper feeder’s cassette.

Paper is jammed inside the rear

gapi rojam C cover of the option duplexer or at 4-16
upLexer the duplexer drawer.

Paper jam D Paper is jammed at the option 418

Sorter sorter.

Paper jam ..

MP Tray E Paper is jammed at the MP tray. 4-20

v
T

B |

a -y — g ;\CEDR > \‘
COFT TP ITEnT 17
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Correcting a Paper Jam

When the jammed paper has been removed, open and close the printer’s
top cover or the paper transfer unit. Then the printer automatically warms
up, goes on-line, and continues printing. Depending on the point at which
the jam occurred, the printer may or may not print the jammed page.

If paper jams occur frequently, try using a different type of paper, replace
with paper from another ream, turn the stack of paper over, or turn the
paper the other way around. Read the information in Chapter 2. Also, look
for tiny pieces of paper that may have been torn off and overlooked when
the jammed paper was removed.

If you cannot solve the problem by changing the paper, there may be a
problem with the printer. Call a service person.

When pulling the paper, pull it gently so as not to tear it. Torn pieces of
paper are difficult to remove and may be easily overlooked, deterring the
jam recovery.

Online help messages

With the online help message function, this printer can display the
procedure to correct a paper jam on the message display. When a paper jam
message is displayed, press the B key. The display will show

Please wait after the jammed paper has been removed.

Pressing the \/ key at the online help message display shows the next step;
pressing the A key shows the previous step.

To exit the online help message display, press the B key. The previously
shown paper jam message appears.

Online help messages that can be displayed when a paper jam occurs and
their respective corrective actions are given below:
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Correcting a Paper Jam

Jam at the Paper Cassette or Inside the Printer

Paper is jammed at the paper cassette or inside the printer. Remove the

Paper jam jammed paper using the procedure given below.

Cassette 1

While the display alternates between the paper jam message and HELP
t START, press the B key. An online help message appears.

-- HELP START --
Press | key

>

-

Examples of online help 1 Pull out the paper cassette and remove the jammed paper.
messages

Open
wcassette 1 and

©Q

Apull out paper
wtransfer unit

Q

Athen remove 2 Push the paper cassette back in. While pulling the paper transfer
wvthe paper jam. unit release lever (green colored), pull out the paper transfer unit.

Paper Transfer Unit Release Lever
(green colored)
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Correcting a Paper Jam

3 If paper is jammed before the registration roller, remove it as shown
in A. If paper is jammed under the registration roller, remove it as
shown in B.

Registration
Roller

Registration
Roller

@ 4 Open the rear cover and remove the jammed paper.
>

AAlso, remove
wthe paper jam

©

V2 Rear Cover

A from

wIear cover.

@ 5 Push the paper cassette and paper transfer unit back in and close
the rear cover.
~

AClose paper
wtransfer unit.

0

v

A - HELP END --
Press Key

>
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Correcting a Paper Jam

Paper Jam at the Option Duplexer

Paper jam

Duplexer

$

-- HELP START --
Press | key

>

-

Examples of online help
messages

Open duplexer
wTrear cover and

O

v

Aremove
wthe paper jam.

@)

v

Apbull out
wduplex drawer,

Paper is jammed inside the rear cover of the option duplexer or at the
duplexer drawer. Remove the jammed paper using the procedure given
below.

While the display alternates between the paper jam message and HELP
START, press the B key. An online help message appears.

1 Open the rear cover of the duplexer and remove the jammed paper.

Rear Cover

2 Pull out the duplex drawer.

Duplex Drawer
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Correcting a Paper Jam

@ 3 Remove the jammed paper.

v

4Aand remove
wthe paper jam.

@ 4 Close the rear cover of the duplexer and the duplex drawer.

v

AClose

wIear cover

O

A and

wduplex drawer.

O

A - HELP END --
Press Key

o )
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Correcting a Paper Jam

Paper Jam at the Option Sorter

Paper is jammed at the option sorter. Remove the jammed paper using the

Paper jam procedure given below.

Sorter

While the display alternates between the paper jam message and HELP
t START, press the B key. An online help message appears.

-- HELP START --
Press | key

>

-

Examples of online help 1 Open the rear cover of the option sorter.
messages

Open sorter
wIrear cover

Rear Cover

@ 2 Remove the jammed paper. If both ends of the paper are inside the
sorter, turn the paper feed gears in the direction of the arrows. The

hd paper can then be removed easily.

Aand remove

the paper jam Paper Feed Gears
v J
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O

v

3 Close the rear cover of the option sorter.

AClose

wIear cover.

@)

A%

A - HELP END --
Press Key

>

-

Correcting a Paper Jam

4-19

Download from Www.Somanuals.com. All Manuals Search And Download.



Correcting a Paper Jam

Jam at the MP Tray

Paper is jammed at the MP tray. Remove the jammed paper using the

Paper jam procedure given below.

MP tray

While the display alternates between the paper jam message and HELP
t START, press the B key. An online help message appears.

-- HELP START --
Press | key

>

-

Examples of online help 1 Remove the paper jammed at the MP tray.
messages

Check the 2 Open and close the top cover (the paper jam error will be reset).
vMP tray and

O

Aremove
wthe paper jam.

O

AQOpen and close
wtop cover to

O

Arelease paper
wjam error.

O

A - HELP END --
Press Key

>
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Appendix A Fonts

This appendix explains the types of fonts you can use with the printer. A font is a set of
characters of a particular design. The design is referred to as a typeface. Several
characteristics identify a font. These include the code set (For details on the code sets, read
the Programming Manual on the supplied CD-ROM), spacing, pitch, height, style, stroke
weight, and typeface family.
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List of Fonts

This section contains a full list of the printer’s internal fonts. The printer
has 80 PCL/PS compatible fonts and a bitmap font for a line printer. You
can print the same font list from the printer by using the printer’s operator
panel key. To print a list of fonts, refer to Font Lists on page 1-21.

Font may be downloaded to the printer’s memory from a option Compact-
Flash card or Microdrive.

PCL (Scalable and Bitmap) Fonts

Font
number Fontsamples

0 This is a sample of Courier font.
1 This is a sample of CGTimes font.

2 This is a sample of CGTimes-Bd font.

3 This is a sample of CGTimes-It font.

4 This is a sample of CGTimes-Bdlt font.

5 This is a sample of CGOmega font.

6 This is a sample of CGOmega-Bd font.

7 This is a sample of CGOmega-It font.

8 This is a sample of CGOmega-BdlIt font.

9 his is a samplo of Coronot font.

10 This is a sample of Clarendon-Cd font.

1 This is a sample of Univers-Md font.

12 This is a sample of Univers-Bd font.

13 This is a sample of Univers-MdIt font.

14 This is a sample of Univers-BdIt font.

15 This is a sample of Univers-MdCd font.

16 This is a sample of Univers-BdCd font.

17 This is a sample of Univers-MdCdlt font.

18 This is a sample of Univers-BdCdlt font.

19 This is a sample of AntiqueOlive font.
20  This is a sample of AntiqueOlive-Bd font.
21 This is a sample of AntiqueOlive-It font.
22 This is a sample of GaramondAntiqua font.

23 This is a sample of Garamond-HIb font.

24 This is a sample of Garamond-Krsv font.

25  This is a sample of Garamond-HIbKrsv font.
26 This is a sample of Marigold font.

27 This is a sample of Albertus-Md font.
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Font

number Font samples

28
29
30
31
32
33
34
35
36
37
38
39
40
a1
42
43
a4
45
46
a7
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67

This is a sample of Albertus-ExBd font.

This is a sample of Arial font.

This is a sample of Arial-Bd font.

This is a sample of Arial-It font.

This is a sample of Arial-BdIt font.

This is a sample of TimesNewRoman font.

This is a sample of TimesNewRoman-Bd font.

This is a sample of TimesNewRoman-It font.

This is a sample of TimesNewRoman-Bdlt font.

This is a sample of Helvetica font.

This is a sample of Helvetica-Bd font.

This is a sample of Helvetica-Ob font.

This is a sample of Helvetica-BdOb font.

This is a sample of Helvetica-Nr font.

This is a sample of Helvetica-NrBd font.

This is a sample of Helvetica-NrOb font.

This is a sample of Helvetica-NrBdOb font.

This is a sample of Palatino font.

This is a sample of Palatino-Bd font.

This is a sample of Palatino-It font.

This is a sample of Palatino-Bdlt font.

This is a sample of ITCAvantGardeGothic-Bk font,
This is a sample of ITCAvantGardeGothic-Dm font.
This is a sample of ITCAvantGardeGothic-BkOb font.
This is a sample of ITCAvanitGardeGothic-DmODb font.
This is a sample of ITCBookman-Lt font.

This is a sample of ITCBookman-Dm font.

This is a sample of ITCBookman-LtIt font.

This is a sample of ITCBookman-DmlIt font.
This is a sample of NewCenturySchoolbook-Rom font.
This is a sample of NewCenturySchoolbook-Bd font.
This is a sample of NewCenturySchoolbook-It font.
This is a sample of NewCenturySchoolbook-BdlIt font.
This is a sample of Times-Rom font.

This is a sample of Times-Bd font.

This is a sample of Times-It font.

This is a sample of Times-Bdlt font.

This is a sample of I'TCZapfChancery-MdIt font.

Tnio 16 o caunie odp Tyupoi povt. (Symbol)

Tnio 16 o counie 06 ZYUPBoAITE dovt. (SymbolPS)

A-3

Download from Www.Somanuals.com. All Manuals Search And Download.



Font
number Font samples

68 FooHe He o OO0 Ox* ¢HMVpLHXEYoe XM (Wingdings)
69 Kok A RA @ ASOT@k L1 Yookelokd itV A 1 (ITCZapfDingbats)
70 This is a sample of Courier-Bd font.

71 This is a sample of Courier-It font.

72 This is a sample of Courier-BdIt font.

73 This is a sample of LetterGothic font.

74 This is a sample of LetterGothic-Bd font.

75 This is a sample of LetterGothic-It font.

76 This is a sample of CourierPS font.

77 This is a sample of CourierPS-Bd font.

78 This is a sample of CourierPS-Ob font.

79 This is a sample of CourierPS-BdOb font.

80 This is a sample of LinePrinterBM8.5-Roman font.
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KPDL Fonts (1)

This is a sample of Albertus-ExtraBold font.

This is a sample of Albertus-Medium font.

This is a sample of AntiqueOlive font.

This is a sample of AntiqueOlive-Bold font.
This is a sample of AntiqueOlive-Italic font.

This is a sample of Arial font.

This is a sample of Arial-Bold font.

This is a sample of Arial-Boldltalic font.

This is a sample of Arial-Italic font.

This is a sample of AvantGarde-Book font.

This is a sample of AvantGarde-BookOblique font.
This is a sample of AvantGarde-Demi font.

This is a sample of AvantGarde-DemiOblique font.
This is a sample of Bookman-Demi font.

This is a sample of Bookman-Demiltalic font.
This is a sample of Bookman-Light font.

This is a sample of Bookman-Lightltalic_font.

This is a sample of CGOmega font.

This is a sample of CGOmega-Bold font.

This is a sample of CGOmega-BoldlItalic font.

This is a sample of CGOmega-Italic font.

This is a sample of CGTimes font.

This is a sample of CGTimes-Bold font.

This is a sample of CGTimes-Boldltalic font.

This is a sample of CGTimes-Italic font.

This is a sample of Clarendon-Condensed-Bold font.

j/zid isa mm/)é o/ Coronet %)nt.

This is a sample of Courier font.

This is a sample of Courier-Bold font.

This is a sample of Courier-BoldOblique font.
This 1s a sample of Courier-Oblique font.

This is a sample of CourierPCL font.

This is a sample of CourierPCL-Bd font.

This is a sample of CourierPCL-BoldItalic font.

This is a sample of CourierPCL-Italic font.
This is a sample of Garamond-Antiqua font.

This is a sample of Garamond-Halbfett font.

This is a sample of Garamond-Kursiv font.

This is a sample of Garamond-KursivHalbfett font.
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KPDL Fonts (2)

This is a sample of Helvetica font.

This is a sample of Helvetica-Bold font.

This is a sample of Helvetica-BoldOblique font.

This is a sample of Helvetica-Narrow font.

This is a sample of Helvetica-Narrow-Bold font.

This is a sample of Helvetica-Narrow-BoldOblique font.

This is a sample of Helvetica-Narrow-Oblique font.

This is a sample of Helvetica-Oblique font.

This is a sample of LetterGothic font.

This is a sample of LetterGothic-Bold font.
This is a sample of LetterGothic-Italic font.

This is a sample of Marigold font.

This is a sample of NewCenturySchlbk-Bold font.
This is a sample of NewCenturySchlbk-BoldItalic font.
This is a sample of NewCenturySchlbk-Italic font.
This is a sample of NewCenturySchlbk-Roman font.
This is a sample of Palatino-Bold font.

This is a sample of Palatino-Boldltalic font.

This is a sample of Palatino-Italic font.

This is a sample of Palatino-Roman font.

Tnio 1o o caunie odp Zyupoi dovt. (Symbol)

Tnio o o capnie oo ZyuBoAlIXA dovt. (Symbol MT)
This is a sample of Times-Bold font.

This is a sample of Times-BoldlItalic font.

This is a sample of Times-Italic font.

This is a sample of Times-Roman font.

This is a sample of TimesNewRoman font.

This is a sample of TimesNewRoman-Bold font.

This is a sample of TimesNewRoman-Boldltalic font.

This is a sample of TimesNewRoman-Italic font.

This is a sample of Univers-Bold font.

This is a sample of Univers-Boldltalic font.

This is a sample of Univers-Condensed-Bold font.

This is a sample of Univers-Condensed-Boldltalic font.

This is a sample of Univers-Condensed-Medium font.

This is a sample of Univers-Condensed-Mediumltalic font.

This is a sample of Univers-Medium font.

This is a sample of Univers-Mediumltalic font.

gamxe He IS eSsOON Ox* ¢XMYoLXEMYoeaD izl Vo @ (Wingdings-Regular)
This is a sample of ZapfChancery-MediumItalic font.

Kotk A RA & ASROT@%k sk ksl OV A BV (ZapfDingbats)
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Appendix B OPtions

This appendix explains how to expand the printer’s memory and how to install each option
unit. Also refer to the manuals of the respective option units.

This appendix explains the following option units:

+ Expanding the Printer Memory
*  PF-60 Paper Feeder

+ DU-60 Duplexer

+  SO0-60 Sorter

+ EF-60 Envelope Feeder

* PT-4/PT-60 Face-up Output Tray
* Network Interface Card

* Microdrive (Hard Disk)

*+  CompactFlash (Memory) Card

B-1
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Available Options

Available Options

S0-60
Sorter

PT-4/PT-60
Face-up
Output Tray

Interface Card
3.3V DC)or
Serial Interface

EF-60 Board Kit
Envelope (IB-10E)
Feeder
DU-60
Duplexer
PF-60

Paper Feeder

Printer combined with options

S0-60 Sorter

1 |Equipped with five trays each with 200 sheets capacity.
Performs sorting, collating, and mailbox functions.
Attaches to the top of the printer.

PT-4/PT-60 Face-up Output Tray

This is a face-up tray. It attaches to the rear of the printer.

Network Interface Card (IB-21)

Enables printing from multiple computers via a network
ifyou install the special-purpose utility KPrint. (KPrint is
included in the Kyocera Mita Network Library CD-ROM
3 |supplied with IB-21.) For details, see Configuration
Guide in the CD-ROM supplied with IB-21.

Serial Interface Board Kit (IB-10E)

Connect to the computer’s serial printer port with a serial
cable.

EF-60 Envelope Feeder

4 |Holds more envelopes at a time than the MP tray. It canbe
attached to the front of the printer after the MP tray has
been removed.

DU-60 Duplexer

5 |Performs duplex printing for short edge and long edge
binding. Attaches to the bottom of the printer.

PF-60 Paper Feeder

¢ |Holds approximately 500 sheets of A5 to A4/Letter and
Legal size paper. Up to three paper feeders can be
attached to the bottom of the printer.

Other Options

* Bulk Feeder (PF-8E)

Holds approximately 2,000 sheets of A5 to A4/Letter and Legal
size paper. It can be attached to the front of the printer after the
MP tray has been removed.

Bulk Stacker (HS-8E)

This bulk stacker can hold up to 2,000 copies for a continuous,
voluminous output. It attaches to the rear of the printer.
Paper Cassette (PC-60LG)

Holds A5 to A4/Letter and Legal size paper.

Microdrive (Hard Disk Unit)

Enables the electronic sorting and job retention functions. To be
inserted into the slot designed for it on the main circuit board of
the printer. See your dealer for purchasing information
regarding the Microdrives that are best suited for use with this
printer.

CompactFlash Card

This is a microchip card that may contain option fonts, macros,
and forms. Insert the card into the card slot located near the
handle on the right of the printer. See your dealer for
purchasing information regarding the CompactFlash Cards
that are best suited for use with this printer.

Memory DIMM

See your dealer for purchasing information of the DIMM that
are best suited for use with this printer. See Expanding the
Printer Memory for the installation procedure.
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Expanding the Printer Memory

Expanding the Printer Memory

This section explains how to expand the printer’s memory. Expanded
printer memory enables you to print more complex pages, download more
fonts, and define more macros.

This section first explains how to remove the main circuit board and then
how to install a DIMM (Dual In-line Memory Module) on the main circuit
board.

This printer comes supplied with 16 MB of memory installed. Two sockets
are provided for expanding the printer memory to allow more complex
printing jobs and increase the printing speed. By installing DIMM into
your printer, the memory in the printer can be increased to a maximum of
144 MB.

The expansion memory should be installed only by a Kyocera Mita
authorized dealer or Kyocera Mita certified technician. Kyocera Mita shall
not be liable for damage due to improper installation of the expansion
memory.

B-3

Download from Www.Somanuals.com. All Manuals Search And Download.



Expanding the Printer Memory

Removing the Main Circuit Board
The main circuit board of the printer is equipped with two sockets for

memory expansion. Expansion memory is available in the form of DIMM.

The following instructions are intended for the technician only.

Notes on Handling the Main Circuit Board and DIMM
Protect the electronics by taking these precautions:

* Before touching the main circuit board and DIMM, touch a water pipe
or other large metal object to discharge yourself of static electricity.
While doing the work, it is recommended that you wear an antistatic
wrist strap.

* Touch the main circuit board and DIMM only at the edges.

Removing the Main Circuit Board from the Printer

Be sure to remove the CompactFlash Card (memory card) first if inserted
in the printer’s card slot.

Remove the main circuit board completely from the printer as follows:

1 Turn the printer off and unplug its power cord. Disconnect the
printer from the host computer.
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Expanding the Printer Memory

2 Remove the two screws from the printer’s rear panel.

\ Screws

3 Pull the main circuit board all the way out of the printer.

DIMM Socket

0 Before pulling the main circuit board out, clear away the area, behind the

printer. Foreign objects, accidentally sticking to the back of the main
circuit board, can cause serious damage to the printer.

Install the DIMM as described on the following page.

B-5

Download from Www.Somanuals.com. All Manuals Search And Download.



Expanding the Printer Memory

DIMM to be used

16 MB, 32 MB, 64 MB, and 128 MB DIMM can be used for memory
expansion. See your Kyocera Mita dealer for purchasing information of the
DIMM that are best suited for use with this printer.

Installing DIMM
Insert the DIMM into the socket as shown below.

1 Remove the DIMM from its package.
Open the clips on both ends of the DIMM socket.

Insert the DIMM into the socket, so that the notches on the DIMM
align with the corresponding protusions in the socket.

4 Close the clips of the DIMM socket to secure the DIMM.

When you finish installing the DIMM, reinsert the main circuit
board into the printer by reversing the removal procedure.

Clip
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Expanding the Printer Memory

Removing DIMM

To remove a DIMM, carefully pull the end clips outwards, then pull the
DIMM out of the socket.

Return the main circuit board to the printer by reversing the procedure
explained in Removing the Main Circuit Board from the Printer.

Testing the Expansion Memory

After you finish installing DIMM in the printer, test the printer to see if the
installation was successful.

To test the expansion memory, proceed as follows:

Make sure printer is turned off. Plug the power cord into the printer
and turn the printer on.

Press the MENU key on the operator panel.

Press the A and v/ key repeatedly until Print Status Page
appears.

Press the ENTER key twice.
If the installation was successful, the amount of memory shown on

the status page will correspond with the amount of expanded
memory. (The factory installed memory size is 16 MB.)

AL WON -
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Expanding the Printer Memory

Adjusting the Memory on the Printer Driver

After you install the additional memory to the printer, follow the

instructions below to set the printer driver so that the printer can use the

memories efficiently.

1 Click the Windows Start button, point to Settings then click Printers.

2 Right click the Kyocera Mita FS-1900 KX icon, and click Properties.
The Properties dialog box will open. Click the Device Settings tab.

3 Enter the total memory size installed to the printer (up to 144 MB)
in the Memory box.

Kyocera Mita F5-1900 KX Properties EHE
General I Dretailz I Color Management I Media | Layout | Imaging I ‘wiatermark I
Prologue/E pilogue I Output Device Settings | About

Device Dptions:

[ Paper Feeder [Cassette 1) -
[Paper Feeder [Cassette 2)
[ Paper Feeder [Cassette 3)
[ Paper Feeder [Cassette 4)
[Envelope Feeder

OB ulk Feader

O Duplex Unit

[ Sorter Stacker

CJBulk Stacker

[JHard Disk...

User... | Memory:
Adminigtrator... | Friskd| Disk: I?MB i’

QK I Cancel Lpply Help

4 Click the OK button to close the window.
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Installing Option Units

Installing Option Units

PF-60 Paper Feeder

Up to three option paper feeders can be installed below the printer. A paper
feeder can hold approximately 500 sheets of paper at a time. By using
option paper feeders in conjunction with the printer paper cassette, which
can also hold approximately 500 sheets of paper, up to approximately 2,000
sheets of paper can be fed continuously. The paper cassette of the paper
feeder can feed Legal size paper.

When installing more than one paper feeder, first stack the paper feeders
together.

Turn off the printer and disconnect the power cord and printer cable.

—

2 Gently place the printer on top of the paper feeder(s).

3 Pull the paper cassette all the way out of the paper feeder.
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Installing Option Units

4 Push down the bottom plate until it locks.

5

6 Adjust the paper guides and paper stopper to the size of paper to be
used.
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Installing Option Units

7 Load paper.

g * Do not load more paper than will fit under the load limits on the paper

guides.

* The paper cassette will hold approximately 500 sheets of paper with
a 80 g/m? (21 Ib) basis weight, or with a thickness of 0.11 mm.

T - ) T
~] LY
N 4
Load Limit Load Limit
N 4
NELU B !
b . - I”~

Ir

8 Set the stack of paper so that it is under the clips as shown in the
figure.

Clip Clip

9 Insert the paper cassette back in.
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Installing Option Units

DU-60 Duplexer

Install the option duplexer immediately below the printer. By combining
the two binding modes (short edge bind and long edge bind) with the two
printing orientations (portrait and landscape), duplex printing is possible
in four different methods. Duplex printing can be specified from the
application (printer driver).

1 Remove the nine tapes and the pad from the duplexer.

2 While pushing the rear cover release lever inward, remove the
duplexer rear cover.

3 Turn off the printer and disconnect the power cord and printer cable.

B-12
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Installing Option Units

4 Gently place the printer on top of the duplexer.

5 Connect the printer cable (parallel interface cable,USB interface
cable, serial interface cable or network interface cable) according to
your operation environment.

B-13
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Installing Option Units

7 Pass the connected cable and power cord through the opening in the
duplexer.

8 Install the duplexer rear cover.
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Installing Option Units

S0-60 Sorter

Install the option sorter on top of the printer. It is equipped with five sorter
trays, with a capacity of 200 sheets each. There are three modes in which
printouts can be received: the sorter mode, the collator mode, and the mail
box mode (for details about the modes, refer to the Printer Drivers
Guide).

The following installation procedure explains how to install the sorter
when the option paper feeder (PF-60) and duplexer (DU-60) have already
been installed.

1 Unpack the sorter and place it on its side.

2 Remove the tapes from the sorter.

4 Turn off the printer and disconnect the power cord and printer cable.
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Installing Option Units

5 If the duplexer is installed, remove the duplexer rear cover, power
cord, and printer cable.

6 Remove the sorter connection cover from the printer. Store the
removed cover in a safe place.

@; Sorter Connection
Cover

7 Install the sorter by inserting the four hooks on its attachment legs
into the notches in the printer.

Notch
Hook

Notch
Hook
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Installing Option Units

8 Push the sorter down. The levers of the attachment legs are in the
lock position.

When removing the sorter, unlock the attachment legs by releasing
the levers as shown in the figure one by one, and then lift the sorter.

9

Sorter Cable

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing Option Units

/When disconnecting the sorter cable, hold the grip on the connector as
shown in the figure and then pull it out.

o

10 The sorter is equipped with two power cord sockets. The upper one is
to be connected to a power outlet and the lower one is to be connected
to the printer.

To power supply

To printer

11 Secure the connected sorter cable and power cord to an attachment
leg on the sorter.

B-18

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing Option Units

1 2 If the duplexer is installed, secure the power cord to the duplexer.
Take care not to loosen the power cord.

13 If the duplexer is installed, remove the two cut-out portions from the
upper part of the duplexer rear cover removed in step 5.

Duplexer
Rear Cover

W
W
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Installing Option Units

15 Install the five sorter trays to the sorter.

Sorter Tray

&

Warning
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Installing Option Units

EF-60 Envelope Feeder

Install the option envelope feeder at the front of the printer. By installing
the envelope feeder, you can print on a wide variety of different envelope
sizes. And the EF-60 feeds envelopes automatically, making it easy to print
on large quantities of envelopes at one time.

Installing the envelope feeder on the printer

g Turn OFF the power to the printer before installing the envelope feeder.

1 Pull the printer’s paper transfer unit release lever (green colored),
then draw the paper transfer unit fully out of the printer.

Paper Transfer Unit Release Lever
(green colored)

2 Gently tilt the MP tray toward the printer until that it rests on its
side as shown in the figure, and remove the MP tray from the printer
by lifting it straight upward.

MP tray
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Installing Option Units

3 Fit both ends of the envelope feeder into their mountings on the
paper transfer unit as shown in the figure and lay the envelope
feeder down toward you.

Envelope Feeder

4 Return the paper transfer unit into the printer with the envelope
feeder mounted.

Load envelopes into the envelope feeder

1 Push the bottom tray downward, as shown in the figure, until you
hear a clicking sound to secure it.

Bottom Tray
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Installing Option Units

2 Pull out the sub-tray that matches the size of the envelopes.

Sub-tray

3 Load envelopes into the envelope feeder so that they feed in face up,
right edge first. Then adjust the envelope feeder’s paper guides to the
width of the envelope.

Paper Guides

0 * Do not set different types of envelopes into the feeder at the same
time.

Note * Do not load envelopes into the envelope feeder higher than the
limitation marks ( L% ) on either side of the feeder.

* Do not force paper into the envelope feeder. Damage to the
mechanism may result.
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Installing Option Units

4 Press the paper setting button. The envelope feeder’s bottom tray is
lifted and envelopes that are fed are secured to the envelope feeder.

Paper Setting Button

* Paper feed errors may occur when using large envelopes. If this
g happens, remove the envelopes and move the switch to the up ([z=")
“Note position as shown in the figure. This improves seating of the
envelopes in the envelope feeder.

* Do not touch envelopes while they are being fed, or attempt to pull an
envelope back once it starts being fed. Damage to the mechanism
may resulit.

¢ To avoid trouble, we recommend that envelopes be deliverd face-up
using the option face-up output tray. Refer to next page.
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Installing Option Units

PT-4/PT-60 Face-up Output Tray

Use the face-up output tray when you wish paper to be stacked with the
printed side facing up (reverse order), or when you are printing on
envelopes, postcards, transparencies, or thick paper. When installing it
directly to the printer, use PT-4. If an option duplexer has been installed,
use PT-60.

1 Install the paper stopper according to the size of paper to be used.
(same for both PT-4 and PT-60)

'ﬂ_j——\
— Legal Size
— A4 Size
— Letter Size
Paper Stopper

2

If a duplexer has been installed to the printer
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Installing Option Units

Network Interface Card
Insert the option network interface card into the option interface slot at the
rear of the printer. The network interface card enables the printer to be
used in a network.

1 Turn off the printer and disconnect the power cord and printer cable.

2 Remove the two screws from the option interface slot cover.

Option Interface
Slot Cover

3 Insert the network interface card and secure it with the screws
removed in step 2.

Network Interface
Card

Screws
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Installing Option Units

4 Connect the network cable.

Network Cable

5 Set the network address from the printer operator panel (for details
about the modes, see Network Interface Parameters on page
1-78).
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Installing Option Units

Microdrive (Hard Disk)

Insert the Microdrive into its slot on the main circuit board of the printer. If
a Microdrive is installed in the printer, received data can be rasterized and
stored on this Microdrive. This enables high-speed printing of multiple
copies using an electric sort function. Also, you can use the e-MPS
functions. For details, see e-MPS on page 1-56.

For details of available Microdrives, see your dealer.
1 Turn off the printer and disconnect the power cord and printer cable.

2 Remove the two screws from the rear panel.

Rear Panel

Screws

3 Pull the main circuit board all the way out of the printer.

Main Circuit
Board

B-28

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing Option Units

4 Install the Microdrive into its slot on the main circuit board.

Microdrive Slot

1111111411112

Microdrive

5 Return the main circuit board to the printer by reversing the
procedure followed when removing it.

B-29

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing Option Units

CompactFlash (Memory) Card

Insert the CompactFlash card into the card slot located near the handle on
the right of the printer. A CompactFlash card is a microchip card that may
contain option fonts, macros, forms, etc. The printer reads the contents of
the card into its internal memory when printer is turned on. The presence
of this data in the printer memory can be confirmed on the status printout.

For details of available CompactFlash cards, see your dealer.

1 Turn off the printer.

Do not insert or remove a CompactFlash card while power is on. If the
CompactFlash card is removed while the printer is on, damage could

result in the printer’s electronics or the CompactFlash card.

2 Insert the CompactFlash card in the slot. Insert it face up, connector
end first. Push it in all the way.

CompactFlash
Card
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AppendixC Host COmputer
Interface

This appendix explains the signals used in the printer’s parallel and RS-232C interfaces. It
also lists pin assignments, signal functions, timings, connector specifications, and voltage
levels. The RS-232C protocols are also covered. Finally, it explains how to use the printer in
a multi-computer environment.

This appendix explains the following topics:

* Parallel Interface

* USB Interface

* Serial Interface (Option)

*+ RS-232C/RS-422A Protocol
+ RS-232C Cable Connection
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Parallel Interface

Parallel Interface

Parallel Interface Communication Modes

Interface Signals

The printer features fast data transmission with the parallel interface. The
parallel interface mode can be activated from the operator panel.
See Parallel Interface Mode on page 1-74.

Use a parallel printer cable that complies with the IEEE1284 standard.

Auto [default]
The printer automatically changes its communication mode to the one the
host computer is currently using.

Nibble (high)
High speed data communication is used in compliance with the IEEE1284
standard. Ordinarily, you should leave this setting unchanged.

Normal
The printer uses the standard communication method prescribed for
Centronics interfaces.

High-speed

This mode enables faster data transmission between the printer and the
host computer. (Select this mode if printing problems occur when the
printer is connected to a workstation.)

The pins of the parallel interface connector carry the signals listed in the
table in Parallel Connector Pin Assignment on page C-3. Asterisks in
the table indicate signals that are active low. The table also indicates
whether each signal is incoming or outgoing with respect to the printer.
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Parallel Interface

Parallel Connector Pin Assignment

Pin In/out Description
1 In Strobe* [nStrobe]
2 In/Out |Data 0 [Data 1]
3 In/Out |Data 1 [Data 2]
4 In/Out |Data 2 [Data 3]
5 In/Out |Data 3 [Data 4]
6 In/Out |Data4 [Data 5]
7 In/Out |Data5 [Data 6]
8 In/Out |Data 6 [Data 7]
9 In/Out |Data 7 [Data 8]
10 Out Acknowledge* [nAck]
11 Out Busy [Busy]
12 Out Paper Empty [PError], returns paper empty status if FRPO
02=2
13 Out Select (Online) [nSelect], returns off-line status if FRPO 02=2
14 In Auto-feed [nAutoFd]
15 - Not connected
16 - ovDC
17 - Chassis GND
18 - +5VDC
19 - Ground
20 - Ground
21 - Ground
22 - Ground
23 - Ground
24 - Ground
25 - Ground
26 - Ground
27 - Ground
28 - Ground
29 - Ground
30 - Ground
31 In Ignored [nlnit]
32 Out Error*, returns error status if FRPO 02=2 [nFault]
33 - Not connected
34 - Not connected
35 Out Power Ready
36 In Ignored [nSelectIn]

[]: Signal names in the Auto mode and Nibble (high) mode (IEEE1284). In the Auto mode and
Nibble (high) mode, these signals are bi-directional.

C-3

Download from Www.Somanuals.com. All Manuals Search And Download.



Parallel Interface

Detailed descriptions of the signals follow.

Strobe* [nStrobe] (Pin 1)
A negative-going Strobe* pulse causes the printer to read and latch the
data on the Data 0 [1] to Data 7 [8] signal lines.

Data 0 [1] to Data 7 [8] (Pins 2 to 9)
These eight signals form the data byte sent from the host computer to the
printer. Data 7 [8] is the most significant bit.

Acknowledge* [nAck] (Pin 10)
This negative-going pulse acknowledges the previous character received by
the printer.

Busy [Busy] (Pin 11)
This signal is high when the printer is busy and low when it is able to
accept more data.

Paper Empty [PError] (Pin 12)
This signal goes high when the printer has received a print job and run out
of paper.

Select [Online] (Pin 13)
This signal is high when the printer is online and low when the printer is
offline. It goes low when the GO key is pressed to set the printer offline.

+5 VDC (Pin 18)
This line is connected to the printer’s +5 V DC line (+5 V £0.5 V, maximum
400 mA, fused).

Error* [nFault] (Pin 32)
When the high-speed parallel line control is on (FRPO 02=2), this line
returns error status.

Power Ready (Pin 35)
This signal is high when the printer is turned on.

The Paper Empty, Online, and Error signals are not used unless enabled
by the FRPO command (O2 parameter).
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USB Interface

Specifications

Interface Signals

USB Interface

This printer supports the USB (Universal Serial Bus) Revision 1.1
standards. USB interface specifications and interface signals are as
follows.

Basic specification

Complies with the USB Revision 1.1 standards.

Connectors

Printer: B-type receptacle (female) with upstream port
Cable: B-type plug (male)

Cable

Use shielded cable that complies with the USB Revision 1.1 standards and
not longer than 5 meters (16 feet).

Transfer Mode

Full speed (max. 12 Mbps)

Power Control

Self-power device

Pin Signal Description
1 Vbus Power supply (+5V)
2 D- Data transmission
3 D+ Data transmission
4 GND Signal ground
Shell Shield
C-5
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Serial Interface (Option)

Serial Interface (Option)

Installing the optional serial interface board kit (IB-10E) in the printer
enables connection to a computer with an RS-232C or RS-422A standard

RS-232C Interface

serial interface.

Interface Signals

The pins of the printer’s RS-232C interface connector carry the signals

listed in table below. The table also indicates whether each signal is
incoming or outgoing with respect to the printer.

Pin In/out Signal Description

1 - FG Frame ground

2 Out TXD Transmit Data

3 In RXD Receive Data

4 Out RTS Request To Send

5 In CTS Clear To Send

6 In DSR Data Set Ready

7 - SG Signal Ground
20 Out DTR Data Terminal Ready

Brief descriptions of the signals follow.

FG - Frame Ground - (Pin 1)
This pin is connected directly to the printer frame.

TXD - Transmit Data - (Pin 2)
This output carries asynchronous data sent by the printer to the computer.
It is used mainly in handshaking protocols.

RXD - Receive Data - (Pin 3)
This input carries serial asynchronous data sent by the computer to the
printer.

RTS - Request To Send - (Pin 4)
This output is always held high (above 3 volts).

CTS - Clear To Send - (Pin 5)
DSR - Data Set Ready - (Pin 6)
Unused.
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RS-422A Interface

Note

Serial Interface (Option)

SG - Signal Ground - (Pin 7)
All signals can transmit between the printer and the host computer to send
each signal with a signal ground.

DTR - Data Terminal Ready - (Pin 20)
This output is used as a buffer nearly-full handshake line. It is held high
(above 3 volts) when the buffer can accept more data.

RS-232C Interface Voltage Levels

The voltage levels of the interface signals conform to EIA RS-232C
specifications. SPACE is from 3 volts to 15 volts. MARK is from -3 volts to
-15 volts. Voltages between -3 volts and 3 volts are undefined.

The serial interface is set to the RS-232C mode as the factory default.
However, by changing the jumper connector on the IB-10E interface board,
the interface can be changed to the RS-422A mode.

In the RS-232C mode, the printer can be connected to a personal
computer (or similar device) equipped with an RS-232C serial interface.
(The serial interface is set to the RS-232C mode as the factory default.)

In the RS-422A mode, the printer can be connected to a personal
computer (or similar device) equipped with an RS-422A serial interface.

Changing of the jumper connector should be carried out only by a
Kyocera Mita authorized dealer or Kyocera Mita certified technician.
Kyocera Mita shall not be liable for damage due to improper changing of
the jumper connector.

Interface Signals

The pins in the printer’s RS-422A interface connector carry the signals
listed in table below.

Pin In/out Signal Description

- FG Frame ground

3 In RDA Receive data Inverted
- SG Signal ground

9 Out SDA Send data Inverted

10 Out SDB Send data

11 - - +5V DC

18 In RDB Receive data
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Serial Interface (Option)

Overview of Signals (RS-422A)

FG - Frame Ground - (Pin 1)
This pin is connected directly to the printer frame.

SG - Signal Ground - (Pin 7)
All signals can transmit between the printer and the host computer to send
each signal with a signal ground.

RDB - Receive Data - (Pin 18)

RDA - Receive Data Inverted - (Pin 3)

These pins carry asynchronous data sent from the computer to the printer.
(differential input)

SDB - Send Data - (Pin 10)

SDA - Send Data Inverted - (Pin 9)

These pins carry asynchronous data sent from the printer to the computer.
(differential output)

RS-422A Interface Voltage Levels

The interface signal voltage levels conform with the EIA RS-422A
standard. The differential voltage varies from 200 mV to 6 V.

SERIAL Connector

The connector marked “IOIOI” (RS-232C/RS-422A) on the rear panel is a
DB-25S connector. Use a DB-25P connector (or equivalent) for the
connector on the cable.
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RS-232C/RS-422A Protocol

RS-232C/RS-422A Protocol

A protocol is a set of rules the computer follows in sending data to the
printer. The RS-232C/RS-422A parameters are stored in battery backed-up
memory. They are indicated on the status printout. They can be changed by
the FRPO (firmware reprogram) command described in the
Programming Manual provided on the CD-ROM supplied with the
printer. The parameters and their identification codes are given below.

H1: Baud rate
Parameter value Baud rate

12 1200

24 2400

48 4800

96 9600

19 19200
38 38400
57 57600
11 115200

The factory setting is 9600 baud.

H2: Data bits
7 or 8, factory-set to 8.

H3: Stop bits
1 or 2, factory-set to 1.

H4: Parity
Parameter value Meaning
0 None
1 Odd
2 Even
3 Ignore

The factory setting is “None” (0 on the status printout).
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RS-232C/RS-422A Protocol

4

Note

H5: Protocol logic

Parameter value Meaning
0 Combination of 1 and 3 below
1 DTR/DSR, positive logic
2 DTR/DSR, negative logic
3 XON/XOFF
4 ETX/ACK
5

XON/XOFF recognized only as protocol

The factory setting is 0.

H6: Buffer nearly-full threshold
This is a percentage from 0 to 99. The factory setting is 90.

H7: Buffer nearly-empty threshold
This is a percentage from 0 to 99. The factory setting is 70.

The factory settings of the buffer nearly-full and nearly-empty thresholds
(H6 and H7) are subject to change without notification.

The gap between the nearly-full and nearly-empty thresholds allows the
computer to send a fairly large amount of data in a continuous stream.

HS8: Received-data buffer size
This is the size of the input buffer, specified in units of 10 Kbytes. The
factory-set value is 6, meaning 60 Kbytes.

Since DTR/DSR protocol is not used with the RS-422A standard, select a
parameter value other than 0, 1, or 2 for the H5 setting when using the
RS-422A interface.

PRESCRIBE FRPO DO Command

The PRESCRIBE FRPO D0 command provides control over XON/XOFF
operation when an error occurs on the serial interface. The following table
summarizes the error status corresponding to different D0 values.

Serial interface error
Error not handled Error handled
Timing of XON transfer to XON sent every 3-5 seconds | D0=0 (default) Do=1
hOSt Whlle Ready or Waltlng XON not sent D0= 10 D0=11
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RS-232C Cable Connection

RS-232C Cable Connection

Obtain a Suitable RS-232C Cable

Make sure that the RS-232C cable is wired correctly. The cable must be a
null modem cable; that is, one in which pin 2 on either end of the cable is
connected to pin 3 on the other end. You cannot use a straight cable such as
IBM communication adapter cable type 1502067 unless you purchase a
null modem adapter.

Connecting the Printer to the Computer

Check that the power of both the printer and the computer is switched off.

o0 A WO DN -

Discharge yourself of static electricity by touching a metal object
such as a doorknob.

Remove the plastic cap from the printer’s RS-232C interface
connector.

Plug the printer end of the RS-232C interface cable into the printer’s
RS-232C connector and screw it in place.

Plug the other end of the cable into the computer’s RS-232C interface
connector.

Switch on the printer’s power.

The printer’s RS-232C parameters are factory-set to the following
values:

Baud rate=9600 bps, data bits (character length)=8 bits, stop bits=1,
parity=none

The two RS-232C protocols are XON/XOFF and DTR. The printer
performs both of them simultaneously, using positive logic for DTR.

If you are uncertain as to the printer’s current parameter settings,
you can reset them to the values listed above. See Serial Interface
Parameters on page 1-76.

Set the computer to the same parameters as the printer. On many
computers this can be done by setting DIP switches before the power
is turned on. Another method is as follows:

C-11
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RS-232C Cable Connection

With Windows 95/98/Me, make settings as follows:

1 Click on Start button in the Windows 95/98/Me Task Bar and align
the cursor with Settings, then click on Control Panel from among
the items displayed.

2 The control panel folder opens. Double click on System.

3 System Properties opens. Click on the Device Manager tab, then
click on the COM port to be used.

System Properties [ 7] <]

General Device Manager | Hardware Profiles | Perfarmance |

& Yiew devices by lupe  Wiew devices by connection

Computer -
&5 COROM

=D Disk diives

(B Display adapters
Floppy disk cantrollers
Hard disk. conballers
Keyboard

Mornitars

i3 Mouse

B3 Network adapters

B Pats [COM & LPT)

| Comm g
- Printer Port (LPT1)

& G5OS| conbollers

Sound, video and game controllers -

: Spstem devices [
Popeties | Refresh | Remove | P |
Cancel

Click on Properties button.

(& ¢ -5

The Properties sheet is displayed for the selected COM port. Click on
the Port Settings tab and set the port properties.

Communications Port [COM1) Properties HE

General Port Settings | Driver | Resources |

Bits per second: -
Daabits o 7]
Parity: Iﬁ

Stop bits: Iﬁ

Elow contral: Im

Advanced. I Bestore Defaults |

Carncel

6 After setting the properties, click OK button.
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RS-232C Cable Connection

In DOS, enter the following commands:

C:\>MODE COM1:96,N,8,1,P
C:\>MODE LPT1:=COM1

To test the interface, enter the following:

CTRL P
C:\>DIR
CTRL P

The software settings made using the above procedures are temporary. On
most computers, permanent settings must be made with DIP switches.
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Specifications

Specifications
Item Description
Printing method Electrophotography, laser scan
Printing speed 18 pages/minute (A4 size) when printing multiple copies of the same page
Resolution Fast 1200 mode with KIR [Kyocera Image Refinement]
600 dpi with KIR (Kyocera Image Refinement)
300 dpi with KIR (Kyocera Image Refinement)
First print Approx. 19 seconds or less (A4 size), depending on input data

Warm-up time

Approx. 9 seconds or less (from sleep mode)
Approx. 16 seconds or less (from power on)
at 23 °C, 120 or 230 V

Controller PowerPC 405 (200 MHz)
Main memory 16 MB, expandable up to 144 MB
Interfaces Parallel: IEEE1284, 1
USB: Revision 1.1, 1
Option: Serial interface/Network interface card, 1
Memory card slot 1 (CompactFlash card)
Hard disk slot 1 (Microdrive)
Self test Performed at power-up

Maximum duty cycle

65,000 pages/month

Drum Amorphous silicon drum
Developer Mono-component dry developer
Main charger Positive scorotron charger
Transferring Negative charger roller
Separation Curvature separation

Drum cleaning

Blade cleaner

Drum discharging

Illumination by eraser LED array

Fuser

Heat roller and pressure roller

Toner saving

Ecoprint mode

Paper

Plain paper (See Chapter 2)

Paper feed trays

Cassette: A5 to A4/Letter universal cassette 148 to 216 mm x 210 to 297 mm.

Holds 500 sheets of thickness 0.11 mm

For U. S. A.: A5 to A4/Letter and Legal universal cassette 5-13/16 to

8-1/2" x 8-1/4 to 14"

MP tray: 70 to 216 mm (2-3/4 to 8-1/2") x 148 to 297 mm (5-13/16 to 11-11/16")

(see page 2-4). Holds 100 sheets of thickness 0.11 mm

Capacity of output trays

Face-down tray — 250 sheets of thickness 0.11 mm
Face-up output tray (Option) —PT-4: 250 sheets of thickness 0.11 mm
PT-60: 100 sheets of thickness 0.11 mm

Ambient conditions Temperature: 10 to 32.5 °C (50 to 90.5 °F)
Humidity: 20to 80 % RH
Optimum conditions: 23 °C (73.4 °F), 60 % RH
Altitude: Max. 2,000 m (6,500 feet)
Illumination: Max. 1,500 lux
D-2
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Specifications

Item

Description

Power requirements

120V, 60 Hz, max. 7.2 A (U. S. A./Canada)

220-240V, 50 Hz/60 Hz, max. 3.6 A (European countries)
Max. allowable voltage fluctuation: +10 %

Max. allowable frequency fluctuation: +2 %.

Power consumption

Max.: 961 W
During sleep mode: 12 W

Operating noise (in
accordance with ISO 7779
[Bystander Position, sound
pressure level at the front])

During printing: LpA=53dB (A)
During standby: LpA=35dB (A)
During sleep mode: Immeasurably low

Dimensions

345 (13-9/16) wide x 300 (11-13/16) high x 390 mm (18-1/4") deep [(): U.S.A.]

Weight

13 kg (28-5/8 Ib), main unit only
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Glossary

Cassette mode

This is an operation mode for the MP tray. When
this mode is used, approximately 100 sheets of
plain paper can be fed continuously, the same as
for the cassette.

dpi (dots per inch)

This indicates the number of dots printed per
inch, and is the unit of printer resolution.

Ecoprint

This is a printing mode that controls toner
consumption. Pages printed in the Ecoprint mode
are lighter than pages printed in the normal
mode. The default setting is Off.

Emulation

This refers to emulation of manufacturers’
printers. The printer emulates operation of the
following printers: PCL, Line printer, IBM
Proprinter, DIABLO 630, EPSON LQ-850,
KPDL.

Expansion memory

This option is used to increase printer memory.
The printer has an expansion socket, into which
you can install a 16 MB, 32 MB, 64 MB, or

128 MB DIMM (Dual Inline Memory Module).
See your Kyocera Mita dealer to purchase the
DIMM that is best suited for use with this
printer.

Face-up output tray

Tray installed at the rear of the printer. Select
paper output to the face-up output tray when
printing on postcards, envelopes, or labels.

First mode

This is an operation mode for the MP tray. When
the MP tray setting is set to first mode (priority
printing from the MP tray) with paper inserted
in the MP tray, the first paper will always feed
from there even if another paper source is
selected. The printer is set to the cassette mode
(another MP tray operation mode) as the factory
default, but you can change this setting from the
operator panel.

IEEE1284

This is a standard used when connecting a
printer to a computer, and was established by the
Institute of Electrical and Electronic Engineers
in 1994.

KIR (Kyocera Image Refinement)

This is Kyocera’s original smoothing function. It
uses software to enhance the printer’s resolution
and produce high-quality printing. The default
setting is On.

KM-NET VIEWER

This is a network management tool that can be
used with the Kyocera Mita F'S series. You can
view information for printers connected to the
network using SNMP commands. KM-NET
VIEWER is contained on the Kyocera Mita Digital
Library CD-ROM supplied with the printer.

Kyocera Mita Digital Library

This is contained on the CD-ROM supplied with
the printer. The contents of the CD-ROM include
guides, printer drivers, and various utilities.

MB (mega byte)

This unit is used to express data quantities and
memory capacities. 1 MB is equivalent to
1024 kB, or 1,048,576 bytes.

Glossary-2
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MP tray

This is an abbreviation for Multi-Purpose tray.
The MP tray is used instead of the cassette when
printing on envelopes, postcards, transparency
sheets, and labels.

Offline

The printer can receive data, but cannot print.
Turn the printer online if you want to print.

Online

The printer can output received data.

Operator panel

This is located on the top of the printer. The
panel consists of the message display three
indicators and eight keys. The message display
shows the printer’s status. Press the keys when
you want to switch the printer between online
and offline status, or to cancel printing.

Outline font

With outline fonts, characters outlines are
represented by numerical expressions, and fonts
can be enlarged, reduced, or painted in different
ways by changing the numeric values of those
expressions. Printing remains clear even if you
enlarge fonts, since the letters are defined by an
outline. You can specify font size in steps of 0.25
points up to 999.75 points.

Parallel interface

With this interface, data transfer between the
printer and the computer takes place on 8-bit
chunks. The printer can perform IEEE1284
compatible bi-directional communications.

Glossary

Printer driver

The printer driver makes it possible for you to
print data created using application software.
The printer driver for either the printer is on the
Kyocera Mita Digital Library CD-ROM supplied
with the printer. Install the printer driver on the
computer connected to the printer.

RAM disk

This is a virtual disk drive that uses part of the
printer’s memory. With RAM disk you can set
any memory size arbitrarily, and use electronic
sorting (to reduce print time).

Simple Network Management
Protocol (SNMP)

This is a protocol for the management of
networks that use TCP/IP (Transmission Control
Protocol/Internet Protocol).

Sleep mode

This mode is activated after a specified amount
of time elapses. The printer goes into economy
mode and a minimum amount of power is
consumed. You can change the amount of time
before the printer goes into sleep mode from the
printer’s operator panel. The default setting is 15
minutes.

Status page

This lists printer conditions, such as the printer’s
memory, the total number of copies printed, and
paper source settings.

USB (Universal Serial Bus)

An interface standard for tow to middle speed
serial interfaces. This printer supports USB
revision 1.1. The maximum transfer rate is 12
Mbps and the maximum cable length is 5 meters
(16 feet).

Glossary-3
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Adhesive label 2-8

Alarm (Buzzer) setting 1-104
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Auto continue I1-105

C

Cassette size 1-24
Charger unit 3-11
Cleaning 3-9
charger wire 3-9
grid cleaner 3-10
paper transfer unit 3-12
Cleaning knob 3-9
Code job 1-67, 1-72
CompactFlash card ix, 1-81, B-2, B-30
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Envelope feeder (EF-60) B-21
Envelopes 2-9

Error messages 4-10
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Face-up output tray (PT-4/
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Font A-1
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Grid cleaner 3-2, 3-10
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IB-10E B-2, C-6
Indicators 1-4, 4-6
Interface wviiz, 1-3, C-1
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K

Keys 1-5

KIR 1-17, 1-52
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Left cover 3-6, 3-9
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Menu map 1-12
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Message language 1-97
Microdrive 1-81, B-2, B-28
MP tray 1-24
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Network ix, 1-3, 1-78
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status page 1-19

o

Online help messages 1-5, 4-13
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P
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colored paper 2-9
condition 2-3
envelope 2-9
grain 2-6
preprinted paper 2-9
recycled paper 2-10
size 2-4
special paper 2-7
specifications 2-2
thickness 2-5
type 2-7
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Paper cassette 1-3, B-9
clip B-11
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Paper guide 1-25
Paper jam 4-12
Paper size dial 1-24, 1-25, B-10
Paper size window 1-24
Paper stopper 1-25, B-10, B-25
Paper transfer unit release lever 3-12
Parallel interface 1-3, 1-74, C-2, Glossary-3
bi-directional/high-speed viii
communication modes C-2
pin assignment C-3
PDF417 ix, x
Plastic bag 3-2
PRESCRIBE command ix, x, C-10
PRESCRIBE Programming Manual x
Print density 1-95
Print quality 4-3
Printer driver 1-6, B-8, Glossary-3
Printer drivers guide x
Protocol 1-76, C-9

R

RAM disk 1-81, Glossary-3
Recycled paper 2-10
Registration roller 3-13, 4-15
Resolution 1-55

Resource protection 1-103
RS-232C 1-76, C-6, C-9, C-11
RS-422A C-7, C-9

S

Serial interface 1-76, C-6
protocol 1-76, C-9
RS-232C mode C-6
RS-422A mode C-7

Serial interface board kit (IB-10E) B-2, C-6

Service status page 1-18

Simple Network Management Protocol

(SNMP) ix, Glossary-3

Sleep mode viii, 1-2, 1-100, Glossary-3

Sleep timer 1-2, 1-100
Sorter (SO-60) 4-18, B-15
Specifications D-1

Status page 1-14

T

TK-50 3-2
Toner container 3-2
dispose 3-3
grid cleaner 3-10
lock lever 3-3
protective seal 3-4
replacement 3-2
Toner gauge 1-16, 1-96
Toner kit 3-2
Top cover 3-3
Troubleshooting
error messages 4-10
indicators 4-6
interface 4-2

maintenance messages 4-7

quality problems 4-3

Two-dimensional bar code (PDF417) ix, x

Typeface A-I1

U

USB interface viii, 1-3, 1-75, C-5, Glossary-3

4

Virtual Mailbox (VMB) 1-68

w

Waste toner box 3-2, 3-6
Windows C-12
Wiper cloth 3-2, 3-13

QUALITY
CERTIFICATE

This machine has passed
all quality controls and
final inspection.
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Notice

The information in this guide is subject to change without notification. Additional pages may be inserted in future editions. The user
is asked to excuse any technical inaccuracies or typographical errors in the present edition.

No responsibility is assumed if accidents occur while the user is following the instructions in this guide. No responsibility is assumed
for defects in the printer's firmware (contents of its read-only memory).

This guide, any copyrightable subject matter sold or provided with or in connection with the sale of the page printer, are protected by
copyright. All rights are reserved. Copying or other reproduction of all or part of this guide, any copyrightable subject matter without
the prior written consent of Kyocera Corporation is prohibited. Any copies made of all or part of this guide, any copyrightable subject
must contain the same copyright notice as the material from which the copying is done.

Regarding Tradenames

Microsoft, and Windows are registered trademarks of Microsoft Corporation. PCL is a registered trademark of Hewlett-Packard
Company. PostScript is a registered trademark of Adobe Systems Incorporated. Microdrive is trademark of International Business
Machines Corporation. CompactFlash is a trademark of SanDisk Corporation. All other brand and product names are registered
trademarks or trademarks of their respective companies.

©2001, 2002 KYOCERA CORPORATION. All rights reserved.
Revision 1.1 February 2002
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Preface

This guide contains information on how to install, configure, and use the
printer drivers for the Kyocera Mita F'S-1900 printer. The printer drivers
and other utility software are supplied on the Kyocera Mita Digital Library
CD-ROM, other additional CD-ROM, and from the Internet. The driver
CD-ROM’s is included with the printer.

The CD-ROM'’s supports different printer drivers for the following
operating systems:

* Microsoft Windows 95, Windows 98, and Windows Me
* Microsoft Windows NT 4.0, and Windows 2000
* Apple Macintosh OS 7 or greater
« IBM OS/2 Version 2.0 or greater
* Linux
The guide focuses on using the printer driver on Windows Me.

The latest Kyocera Mita printer drivers and utilities are readily available
at the following web site:

http://www.kyocera.com/w2k.
For improvement purpose, the user interface design and functionalities

of the printer driver may vary depending on the version. The diagrams
used throughout this guide are only for examples.
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Installing the Printer Driver

Chapter 1 Installing the Printer Driver

= If you want to use the printer as a USB printer, you should install the USB
— device driver first. See Using USB Interface on page 1-8 for instruction.

Using Parallel Interface

When you insert the Kyocera Mita Digital Library CD-ROM supplied with
the printer into your computer, the setup screen is automatically displayed.
To install the printer driver, follow the on-screen instructions.

1 Set the Kyocera Mita Digital Library CD-ROM in your computer’s
CD-ROM drive.

After a few moments, the License Agreement window opens.
If this screen does not appear, click the Windows Start button and select

Run. Type the following in the Command Line text box:
[CD drive letter] :\setup

Fy

Click the OK button. After a few moments, the License Agreement
window appears.

2 Click View License Agreement. The License Agreement PDF opens.
Read the terms and conditions.

i\ Kyocera Mita Digital Library

el
Bi,gialry

By using or installing the device drivers
and Software included on this CD-ROM,
you agree to become bound by the terms
and conditions of this License Agreement.
Please open and read.

License Agreament

[View License Agreement ]

Wigw the terns and condftions of the License Agreement Accept

E B

If you do not have Adobe Acrobat Reader installed on your computer,
the following dialog box will open. Click the Yes button and install
it.

Install Acrobat Reader [<]

This PDF fammat file requires Adobe Acrobat Reader.
‘Wiould you like b install it now?

1-1
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Installing the Printer Driver

3 Close the License Agreement PDF. On the previous License

Agreement window, click Accept to accept the agreement. After a
few moments, the Main Menu appears.

4 Click Install Drivers. The Kyocera Mita Setup Wizard begins. Click
the Next button.

1 Kyocera Mita Digital Library

Main Menu

Install Drivers

fent7 Server
Driver Tools
Printer Utilities
Networking
Documentation
Select Language

Install Kyoceras Mita printer drivers for Windowws 95,98, Me, XP, NT &

5 In the Select a device model window, click FS-1900.

Setup

Select a device mode!

If your model is not listed, click on the Classic Models buttor for
additional selections.

Available models:

Cit100
F5-1000+
Fs-1010
F5-1714M b

-
—————
=

=

Fo-1300
E5 2713k

1’_3 FS-3000
e (R =
-

Madel description;

4 e 19-PPM Workaroup laser printer
.

Classic Models | < Back I Mext » I Exit
Click the Next button.
1-2
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Installing the Printer Driver

6 In the Select a driver language window, click the language you want.

Setup
Select a driver language

Select the driver language, then click Mext.

Available languages:

Portuguese

< Back I Mext » I Exit

Click the Next button.

7 Kyocera Mita FS-1900 KX is highlighted in the Available drivers list

box.

Setup [ %]
Select a driver type

Select the diver type pou wish to use with this device, and click
et

Available diivers:

< Back I Nexst > I Exit

Click the Next button.

8 In this window, you can choose whether you want to install TrueType
screen fonts and/or Prologue/Epilogue tab. Click the appropriate

option(s).

Setup
Select driver options

Select from the list below the options that pou want to install with
thig ditver. Multiple options may be selected.

Available options:
TrueTyp:
] Prologue/E pilogue Module

+ Thiz option will install TrueT ype screen fonts that match the:
, resident printer fonts. This will insure that the fonts displayed on
the screen and the fonts on the printed page will lool the same.

< Back I Mext » Exit

- .

Click the Next button.

1-3

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing the Printer Driver

In the Device connection window, select the type of connection
between the printer and your computer.

If you want to connect to a network, contact your network
administrator.

Setup

Device connection

Select the type of connection between the device and pour
computer. Once selected, click Next

The device is connected directly to a serial
or parallel port on the computer,

The device is connected thiough & netwark.
interface card. The device also may be
attached to anather computer on the:
network,

< Back I MNeut > I

Exit

Click the Next button.

In the Select a device port window, select the interface you want to
use for connecting to the printer.

1

Setup

Select a device port

Select the desired communications port on the computer far
connection to the device. Once selected, click Next.

Available ports:

COMI:

Exit

< Back I MNeut > I

Click the Next button.

1-4
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1

printer, if desired.

Setup

Select a device name

Kyocera Mita F5-1900 KX

Thiz device name is already in uze.

P
~= ™ Use the esisting device name
- il

Enter a unique name far this device or use the name supplied
below. Once selected, click Next.

< Back I Mext > I

Exit

Click the Next button.

12

button.

Question

@ Do pou want ko use this device model as the default device?

Ho

Installing the Printer Driver

In the Select a device name window, enter a unique name for the

If you want to use the printer as the default printer, click the Yes

1 3 In the Begin installation window, click the Next button.

Setup

Begin installation

The Setup Wizard can now commence installation.

Cuent settings:

Driver Language = English

Emulation = PCLKPDL

Model = F5-1900

Frinter Port = LPT1:

Printer Mame = Kyocera Mita FS-1900 kx

< Back I Mext > I

Exit

1-5
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Installing the Printer Driver

1 4 Click the Finish button to restart the computer.

Setup

Setup complete

Setup has finished copying files ta pour computer.

Before you can use the device, you must restart your computer.

9 ¥ ies. | want to restart oy Cormpuber now.;

. Remave any disks from their ditves, and then click Finish to
* complete setup.

Confirming the Installation

After you restart the printer, follow the instructions below to make sure if
the printer driver has been installed correctly.

1 Click the Windows Start button, point Setting, and click Printers to

make sure the Kyocera Mita FS-1900 KX icon has been added to the
Printers window.

B3 Printers =

J File Edit View Favortes Toolz Help ‘

J 4= Back + = - ‘ @Seamh [ Folders gHislmy |[E' 5 ¥ @ | =
JA_ddless I@ Printers ﬂ WGD

1 __

Add Printer

Printers

This Folder conkains information about
prinkers that are currently installed,
and a wizard to help you install new
printers,

To get information about & printer that
is currently installed, right-click the
printet's icon.

To install a new printer, click the Add
Printer icon.

Select an item ko view its description.

|2 abiect(s)

1-6
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Installing the Printer Driver

2 Right click the Kyocera Mita FS-1900 KX icon and select Properties.
The following dialog will open. Click the Details tab to make sure the
port you have selected in step 11 on page 1-5 is shown in the Print to
the following port list.

Kyocera Mita FS-1900 KX Properties EHE

General  Details | Calor Managamenll Medial Laynutl Imagmgl Dutputl Device Sattmgsl About I

ﬁj@ Kyoera Mita F5-1900 K4

PFrint ta the following port:

Add Port... |
Delete Port... |

Print wsing the following driver.
Kyorera Mita F5-1800 KX ¥|  MewDriver |

Lapture Printer Port, I End Capture. |

Timeout setting:

Mot selected: 15 seconds
Transmission fetry: 45 seconds

Spool Settings. I Part Settings. I

oK I Cancel | Lpply | Help: |

Click the OK button to close the window. Proceed to Adding
Optional Devices on page 2-1 to make default settings.

1-7
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Installing the Printer Driver

Using USB Interface

You can print to the printer’s USB connector if Windows 98/Me or Windows
2000 is running on your computer. You need to connect the printer to your
computer using a USB cable.

Installing the USB Printing Support

This section explains you how to install the USB Printing Support as well
as the printer driver onto your Windows Me computer. If you are using
Windows 98 or 2000, you can use the similar procedure. Follow the
instructions displayed on the screen.

1 Turn on the computer and the printer, then insert the Kyocera Mita
Digital Library CD-ROM into the computer’s CD-ROM drive

2 Connect the printer and the computer using a USB cable.

3 The Windows Plug and Play function will detect the printer
automatically and the Add New Hardware Wizard will open. Select
Automatic search for a better driver.

Add New Hardware Wizard

‘Windows has found the following new hardware:

Kyacera Mita F5-1900
‘Windows can automatically search for and install software
that supports pour hardware. | your hardware came with

installation media, inser it now and click Mest

“What would you like to do?

1% dutomatic search for a better driver [Recommended]

1~ Specify the location of the driver [Advanced)

< Back I Mext > I Cancel

Click the Next button.

4 The following dialog box will open when the installation has been
completed. The above completes installing the USB Printing
Support. Proceed to the next section.

Add New Hardware Wizard
% USE Printing Support

‘Windaws has finished installing the new hardware device.

T Carcel

< Back

Click the Finish button.

1-8
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Installing the Printer Driver

Installing the Printer Driver for USB

1 Subsequently the installation of the printer driver will begin. Select
Automatic search for a better driver.

Add New Hardware Wizard

‘Windaws has found the fallowing new hardware:
KyoceraF5-1300

‘wWindows can automatically search for and install software:

that supparts wour hardware. |F pour hardware came with

installation media, insert it now and click Nexst.

‘wWhat would you like to da?

1= utomatic search for a better diiver [Fecammended)

" Specify the location of the diver [Advanced)

< Back I Mext > I Cancel

Click the Next button.

2 Select the printer driver to be used. Normally, select the Kyocera
Mita FS-1900KX driver displayed at the lower part.

Select Other Driver

‘windows has found more than one driver that may work for your hardware. Please select the driver that
matches pour language and device.

I Diriver D escription I Lacation I Driver Dat
it EADRIVERSWOTHERAVPCLAWING_MEMEMGLISHYMITA..  10-22-200
EADRIVERSWULTISOEMSETUP.INF 1121200

|l

Cancel

Click the OK button.

3 Add Printer Wizard will open. Follow the instructions shown on the
wizard and complete the installation of the printer driver.

Add New Hardware Wizard
Windows driver file search for the device:
Add Printer Wizard
ek . “Y'ou can type a hame for this printer, or you can use

the name supplied below. When pou have finished,
click Mest.

Printer name:

Do pou want your Windows-based programs to use this
printer as the default printer?

i Yes
i+ No
< Back I MNest > I Cancel
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Installing the Printer Driver

4 Click the Windows Start button, point Setting, and click Printers to
make sure the Kyocera Mita FS-1900 KX icon has been added to the
Printers window.

B3 Printers H=

J File Edit View Favortes Toolz Help |
J G Back w = - ‘ @i 5earch [ Folders €8 History | R X @ | =
JA_ddless I@ Printers j @Gﬂ

Add Printer

Printers

This Folder conkains information about
prinkers that are currently installed,
and a wizard to help you install new
printers,

To get information about & printer that
is currently installed, right-click the
printet's icon.

To install a new printer, click the Add
Printer icon.

Select an item ko view its description.

|2 abiect(s) VA

5 Right click the Kyocera Mita FS-1900 KX icon and select Properties.
The following dialog will open. Click the Details tab to make sure
USB 001 (Virtual printer port for USB) is selected for the Print to the
following port list.

Kyocera Mita F5-1900 KX Properties EHE
Output I Device Settings I About I
General Details I Color Management I Media I Layout I Imaging I Prologue/Epilogue

ﬁj@ Kyoera Mita F5-1900 K4

PFrint ta the following port:

SEO0T [Virtual printer port for USB)| Add Pot... |
Delete Part...
Print wsing the following driver.
Kyorera Mita F51300 KX ¥|  MewDriver |

Lapture Printer Port, I End Capture.

Timeout setting:

Mot selected: 15 seconds
Transmission retry: 45 seconds

Spool Settings. I Part Settings. I

oK I Cancel | Lpply | Help: |

Click the OK button to close the window. Proceed to the next section.

1-10
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Adding Optional Devices

Chapter 2 Adding Optional Devices

This section explains how to set defaults on option units installed on the
printer. Setting made in this way will become effective for all application
software. To temporarily change the settings, make printer settings from
the application. See Chapter 3, Printing from Windows Applications.

The printer driver online help will describe the printer settings in more
detail.

The Device Settings tab enables you to setup optional devices such as
paper feeders so that the printer can recognize them. Each printer has a
unique set of options that are listed in the Device Settings window. If you
have attached one or more printer options, check that option.

Installing the Paper Feeder (PF-60)

Check that the option paper feeder (PF-60) is installed on the printer
correctly.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

I W atermark. |
About

General | Details I Color Management I

Prologue/E pilogue | Output

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

CHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

Paper Feeder

oK I Cancel Lipply Help

2-1
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Adding Optional Devices

4 Check Paper Feeder in the Device Options list box. Paper Feeder
(Cassette 1) is the standard printer cassette. If three optional paper
feeders have been installed, check Paper Feeder (Cassette 2), Paper
Feeder (Cassette 3), and Paper Feeder (Cassette 4) sequentially.

Kyocera Mita F5-1900 KX Properties

2]
General I Details I Calor Management I Media | Layout | Imaging I \Watermark. I
Prologue/E pilogue I Output Device Settings I About
Device Options:
W Paper Feeder (Cassette 1] -
aper Feeder [Cassette 3]
[ Paper Feeder (Cassette 4]
Bulk Feeder
[ Duplex Urit
[ Sarter Stacker
Bulk Stacker
CIHard Disk, |
User M emary: |15 ME ﬂ
Admiristrator R Diisk: |7 MB ﬂ
U2 KYOCERE
mnita
e
oK I Cancel Lpply Help

5 Click the OK button.

2-2
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Installing the Duplexer (DU-60)

Check that the option duplexer (DU-60) is installed on the printer correctly.
1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-1900 KX Properties [ 7] ]

General | Details I Color Management I
Prologue/E pilogue | Output

I W atermark. |
About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

CHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

Duplexer

oK I Cancel | Lipply | Help |

4 Click Duplex Unit in the Device Options list box.

Kyocera Mita F5-1900 KX Properties [ 7] %]
General | Details I Color Management I Media | Layaut | Imaging I W atermark. |
Prologue/E pilogue | Output Device Settings About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]

Bleme-Ehashs
Bulk Stacker
CHard Disk....

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel Lipply Help

5 Click the OK button.
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Installing the Sorter (SO-60)

Check that the option sorter (SO-60) is installed on the printer correctly.
1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-1900 KX Properties [ 7] ]

General | Details I Color Management I
Prologue/E pilogue | Output

I W atermark. |
About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

CHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel | Lipply | Help |

4 Click Sorter Stacker in the Device Options list box.

Kyocera Mita F5-1900 KX Properties [ 7] %]
General | Details I Color Management I Media | Layaut | Imaging I W atermark. |
Prologue/E pilogue | Output Device Settings About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

CHard Disk....

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel Lipply Help

5 Click the OK button.
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Installing the Envelope Feeder (EF-60)

Check that the option envelope feeder (EF-60) is installed on the printer
correctly.

Browse through Windows Start > Settings > Printers.

Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

N —

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-1900 KX Properties [ 7] ]

I W atermark. |
About

General | Details I Color Management I
Prologue/E pilogue | Output

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

CHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

Envelope Feeder

oK I Cancel | Lipply | Help |

4 Click Envelope Feeder in the Device Options list box.

Kyocera Mita F5-1900 KX Properties [ 7] %]
General | Details I Color Management I Media | Layaut | Imaging I W atermark. |
Prologue/E pilogue | Output Device Settings About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3

T ——

O Duplex Unit
O Sorter Stacker
[CIBulk Stacker
CHard Disk....

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

KN

oK I Cancel Lipply Help

5 Click the OK button.
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Download from Www.Somanuals.com. All Manuals Search And Download.



Adding Optional Devices

Installing the Microdrive (Hard Disk)

For details of available Microdrives, see your dealer. Check that the option
Microdrive is installed in the printer correctly.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-1900 KX Properties [ 7] ]

General | Details I Color Management I
Prologue/E pilogue | Output

I W atermark. |
About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

CHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel | Lipply | Help

4 Click Hard Disk in the Device Options list box.

Kyocera Mita F5-1900 KX Properties [ 7] %]
General | Details I Color Management I Media | Layaut | Imaging I W atermark. |
Prologue/E pilogue | Output Device Settings About

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]

[l

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel Lipply Help

5 Click the OK button.
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Selecting the Printer Description Language and Entering User Name

Select the printer description language adequate for the data to be printed
from among PCL XL, PCL 5e and KPDL (PostScript compatible). When
using the virtual mailbox function, select PCL XL or PCL 5e. The default
setting is PCL XL.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-1900 KX Properties [ 7] ]

I W atermark. |
About

General | Details I Color Management I
Prologue/E pilogue | Output

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]
OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

CHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel Lipply Help
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Adding Optional Devices

4 Click the User button. The User Settings dialog box is displayed.

Kyocera Mita FS-1900 KX Properties EHE
General I Details I Calor Management I Media | Layout | Imaging I \Watermark. I
Prologue/E pilogue I Output Device Settings Ahout

Device Options:

W Paper Feeder (Cassette 1
OPaper Feeder [Caszette 2
[El Paper Feeder (Cassette 3
[ Paper Feeder (Cassette 4
OEnvelope Feeder

)
)
)
)

CBulk Feedsr
[ Duplex Urit
[ Sarter Stacker
CBulk Stacker
[IHard Disk. |
I User ]«emow; B ﬂ
Adminktatar | e, Fan 2
User Settings [ 7] ]
Y KYOCERA ~ Identification
mnita
e — User Mame: ||

Cancel Department: I
r~Page Description Languan:

L= =] ™ GDI compatible mode
Settings |

~Uni

¥ Inches = Milimeters

|

5 Select PCL XL, PCL 5e, or KPDL in the Page Description Language
drop down list, and click the OK button.

User Settings (2]
| dentification
[UselNama I F— 6
Department: I

GDI compatible mode

Settings |

¥ Inches = Milimeters

|

6 Enter the user name in User Name. This name is used to identify
your print job on the printer operator panel as part of job retention
function. For details, see e-MPS on page 1-56 in the Operation
Guide.

7 Click the OK button.

2-8
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Printing from Windows Applications

Chapter 3 Printing from Windows Applications

Basic Printing Task

This section will discuss how to print from Windows applications using a
Microsoft Word document as an example.

This section will explain only the minimum task that is required to print
from Windows applications. You can select various options in the printer’s
Properties dialog box to customize your print job as explained in section
Setting Custom Paper Size on page 3-3 and later.

1 Set the paper of the size specified in the application for the document
into the printer’s paper cassette. For details on how to set paper,
refer to the Installation Guide.

Using the operator panel, make sure if each paper source has paper of
the proper size. If not, set the appropriate paper into the source (see
Setting the Paper Size in Paper Cassette on page 7-24 in the Operation
Guide). If they have different paper, the output may not be printed
correctly.

2 Open the document you want to print. The following example shows
how to print a Word document.

3 Select Print from the File menu of Word. The Print dialog box will

appear.
Print HE
rPrinter
Mame: [| 56 Kyocera Mita F5-1900 KX LII Properties — 7
Status: ol
Type: Kyocera Mita FS-1900 KX |
Where: LPT1: T PR e 4
Camment;
Bae rana Conj
(¢ al [Number of copies: = H— 6
5 —— " Current page € Selection
" Pages: I— Iﬁ' Iﬁ' W Collate
Eniter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12
[Zaom
Print what: IDocument h Pages per sheet: m
Print: W Scale to paper size: lm
Options... Cancel

4 From the Name drop down list, select Kyocera Mita FS-1900 KX

printer if it is not selected.

5 Enter the page range of the document you want to print. To print the
whole document, select All.

6 Enter the number of copies, 1 to 999, you want to print in the
Number of Copies combo box.

3-1
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Printing from Windows Applications

Click the Properties button. The Properties dialog box opens.

On the Media tab, select the paper size that matches the paper size
of the document from the Page Size drop down list. The printer will
automatically switch to the paper source (the paper cassette, MP
tray, or the option paper feeder, if installed) so that the correct paper
will be used.

o0 N

Kyocera Mita FS-1900 KX Properties EHE

Media | Layﬂull Imagingl Walelmarkl F’mlngue.pri\ﬂgueI Dutputl About I

Page Size: Ad - 210 % 297 mm
<] | Gwon.

Frint Size: Ad - 2105 297 mm
ISame as Page Size ﬂ

Orientation:

& Portrait
I Rotated
© Landscape
Source: IAulo Source Selection j
Media Type: IAulu Media Selection j
Settings | Restare Defaults |

oK I Cancel | Help |

Click the OK button to close the Properties dialog box and return to
the Print dialog box.

10 Click the OK button to start printing.

3-2
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Printing from Windows Applications

Setting Custom Paper Size

This printer can feed non-standard size of paper. The paper cassette can
accommodate paper whose sizes are ranging from 148 to 216 mm in width
and 210 to 297 mm in length as well as Legal size. Note the MP tray can
accommodate paper whose sizes are ranging from 70 to 216 mm in width
and 148 to 297 mm in length.

To set the custom size

1 Display the printer driver’s Properties dialog box from the printer’s
properties dialog box. Browse through Windows Start > Settings >
Printers > right click on the Kyocera Mita FS-1900 KX icon > click
Properties > click the Media tab.

2 Click the Custom button on the Media tab. The Custom Paper Sizes
dialog box appears.

Custom Paper Sizes [ 7] ]

Customized Paper Sizes

Lo Add

e |
Edit... |

0K | Lancel |

3 Click the Add button. The Edit Paper Size dialog box appears.

Custom Paper Sizes

Customized Paper Sizes

Eemove

Edit.... |

Edit Paper Size [ 2] %]

j
Height  [1100 ﬂﬂidth 850 ﬂ

4 Enter a descriptive name for the custom size in Name.

3-3
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Printing from Windows Applications

5 Enter the height and width of the custom size in Size.

Edit Paper Size EHE
~ Mam:
IDncumenlm
(o N
Height I ﬂ wiidth IS [ ﬂ

You can select the unit of measurement; inches or millimeters, on the
User Settings dialog box to be accessed by clicking the User button on
“Note  the Device Settings tab.

6 Click the OK button. The custom paper size is added to the
Customized Paper Sizes list.

7 Click the OK button. The Media tab is displayed again.

8 Select the Custom Size from the Page Size drop down list.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Lawull Imagingl Walelmarkl F‘lologue!Epi\oguel Dutputl About I

Page Size: DocumentD] - 8.500 % 10.00in.

Crocument(T1 =] Custom

Envelope #3 -
Envelope Monarch 0% 10.00n.
Envelope #E6
Envelope Co
Envelope DL
| Dfici Il

& Portrait
I™ Botated
€ Landsoape
Source: IAulu Source Selection j
Media Type: IAum Media Selection j
Settings. | Restare Defaults |

oK I Cancel | Help |

9 Click the OK button again to return to the Print dialog box.

10 Click the OK button to start printing.
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Printing from Windows Applications

Advanced Media Settings

Cover Mode

Making the Advanced Media settings allows you to activate the following
advanced printer functions.

e Cover mode: Adds the front cover and/or the back cover to the
document.

* Page insert: Inserts a blank or printed page before any page(s) of the
document.

* Transparency interleaving: Inserts a blank or printed page between
the transparencies to be printed.

These functions are explained on the following pages.

In the Cover mode, the first cover page, or the first and back cover pages of
a document will be added to the document using the different paper from
the paper used for the body of the document. The rest of the document will
be printed on the paper specified in the Media tab. This will allow you to
add the covers of the document using special paper, for example thick
paper or colored paper, so that the printed document looks more
professional.

You can also print the first page of the document on the front cover by
checking Print Outside Cover.

Cover Mode can be used with Page Insert but not with Transparency
Interleaving.

3-5
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Printing from Windows Applications

To print the cover pages on the different paper.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Settings button on the Media tab. The Advanced Media
Settings dialog box opens.

Kyocera Mita F5-1900 KX Properties EHE
Media | Layﬂull Imagingl Walelmarkl F’mlngue.pri\ﬂgueI Dutputl About I
Page Size: Ad - 210 % 297 mm
v] _ Gwon.
Frint Size: Ad - 2105 297 mm
ISame as Page Size ﬂ
Drigntation: Advanced Media Settings [Z]x]
(O o
A - Flint Gtz
4  Front I~ | Front Butside
I Frort Inside
€ Front and Back T Back Inside
Source: - .
lm I Back Outside
Media Type: W Wexdis for Cover [Cassetie 1 =l

Y KYOCERA o I Page Insert
nifa &I = Frint onto Front = Frint ot Back
S —
0K | InsetBefme Pages |

Wedi for Page: [Cassete =]

= Transparency Interleaving

’ ™| Frint onto Backing

MediaforBaching: [Fseeten I|

Fleset Cancel

3 Click the Cover Mode check box.

Advanced Media Settings EHE
3 —
W
& Front ¥ Front Dutside 5
]]] Frant Inside
B € Front and Back I Eeck gside 4
I Back Outside
Media for Cover: UMulti-Purpose Feeder j 6
I~ Page Insert
I™ Print orta Front ™| Biint anta Back
Inzert Before Pages I
Idedia for Fage: IEasselle 1 j
I Transparency [ntereaving
I | Fiint onto Backing
Idedia for Backing ICasselle 1 j
Rezet | LCancel |

4 To add only the front cover using different paper, click Front, or to
add both the front and back covers using different paper, click Front
and Back.
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Printing from Windows Applications

To print the first page on the cover, click the Front Outside check
box. Note that the Front Inside, Back Inside, and Back Outside are
not applicable for model FS-1900.

Select the paper source for the cover(s) from the Media for Cover list
box. Note that thick paper, colored paper, etc., should be loaded on
the MP tray.

o O

Click the OK button. The Media tab is displayed again.
Click the OK button to return to the Print dialog box.

Load the paper you want to use for the cover(s) onto the paper source
specified in step 6.

Click the OK button to start printing.

= (O 00 ~
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Printing from Windows Applications

Page Insert

With Page Insert, the printer inserts a blank or printed page before any
page(s) of the document that you specify. This function will allow you to
insert a page that can be used to clearly separate a chapter, etc., from the
previous chapter.

It is also possible to print the chapter cover page on the separate sheet.

Page Insert can be used with Cover Mode but not with Transparency
Interleaving.

|y

Note
To include a separator sheet in the document.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Settings button on the Media tab. The Advanced Media
Settings dialog box opens.

Kyocera Mita FS-1900 KX Properties EHE

Media | Layﬂull Imagingl Walelmarkl F’mlngue.pri\ﬂgueI Dutputl About I

Page Size: Ad - 210 % 297 mm
EESRIRIN ~|  Cuon.
Print Size: A4 - 210 297 mm
ISame as Page Size ﬂ
Orientation: Advanced Media Settings 1=

(O o

A - Piirt Orto
4  Front I~ | Front Butside
I~ Frort nside
€ Front and Back I Eack Inside

Source: At - .

l_u I Back Outside
Media Type: W Wexdis for Cover [Cassetie 1 =l

I~ Page Insert
[ KYDCERA . E
. g I™ Print anto Front I™ Pint onto Back
e —
0K | InsetBefme Pages |
Wedi for Page: [Cassete =]
I~ | Transpareney Interlzaving
’ ™| Frint onto Backing
Media far Backing: [Caseette =
R B
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Printing from Windows Applications

3 Click the Page Insert check box.

Advanced Media Settings [ 7] ]

I~ Cover Mode

Fint Orita:

™ Front Outside
I™ Front Inside

= Front and Back I™ | Back [nside

I Back Outside

) Erart

Idedia for Cover: I Multi-Purpose Feeder j

3 _{|7 Paae Insert }

[ Print onta Front ) _— —_—

Insert Befare Pages [|5,1 11318

(=2~ |

tedia for Page: [ I Multi-Purpose Feeder j

I Transparency [ntereaving

I | Fiint onto Backing

I edia for Backing ICassellE 1 j

Rezet | LCancel |

4 Enter the page numbers before which you want to insert a page in
the Insert Before Page box. The page number range you can specify
is from 2 to 255. If you want to specify more than one page numbers,
separate them with commas. To specify a range of pages, use a
hyphen between the starting and ending numbers in the range. For
example, to insert separators before pages 5, 11, 12, 13, and 18, type
“5, 11-13, 18.

5 Select the Print on to Front check box to print on the separators.
Note that the Print onto Back is not applicable for model FS-1900.

If you check this check box on, each separator sheet is printed with
data reflecting its position in the entire print job. For example, the
separator between pages 9 and 10 will be printed as page 10 when
you select this check box.

Select the paper source for the separators from the Media for Page
drop down list. Note that thick paper, colored paper, etc., should be
loaded on the MP tray.

(o))

Click the OK button. The Media tab is displayed again.
Click the OK button to return to the Print dialog box.

Load the paper you want to use for the separator(s) onto the paper
source specified in step 6.

Click the OK button to start printing.

== O 00 ~
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Printing from Windows Applications

Transparency Interleaving

This function is available when the current media type is Transparency
and the source is MP Tray (see Setting the Paper Type in MP Tray on
page 1-31 in the Operation Guide). It inserts a blank (or printed) backing
sheet between the transparencies to be printed. You can print the same
content of the transparency on the backing sheet.

Transparency Interleaving cannot be used with either Cover Mode or
Page Insert.

To insert sheets between transparencies.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Select Multi-Purpose Feeder (MP Tray) from the Source list box and
Transparency from the Media Type list.

Kyocera Mita FS-1900 KX Properties EHE

Media | Layﬂull Imagingl Walelmarkl F’mlngue.pri\ﬂgueI Dutputl About I

Page Size: Documentd] - 8.500 % 10.00in.
IDocumentUT ﬂ m
Frint Size: DocumentD - 8500 10.0in.

ISame as Page Size ﬂ

Orientation:
& Portrait
I Rotated
© Landscape

Source: IMuIt\-Purpose Feeder j

Media Tupe:

Settings | Restare Defaults |

oK I Cancel | Help |

3 Click the Settings button on the Media tab. The Advanced Media
Settings dialog box opens.
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Printing from Windows Applications

4 Click the Transparency Interleaving check box.

Advanced Media Settings [ 7] ]

= Cover Mode
Fint Orita:

I | Front Outside
I™ Front Inside
= Front and Back I™ | Back [nside

I Back Outside

) Erart

Idedia for Cover: IMulti-F‘urpose Feeder j
I~ Bage lnsert
I™ Print orta Front ™| Biint anta Back
Irisert Before Pages |5,1 1121318
[edia for Fage; IMu\lirPulpﬂse Feeder j
4 ——{F Transparency \ntsr\eawng)

& 6
ABC!

Media for Backing, [ICasselle 1 j 5

Rezet | LCancel |

Select the source for the backing sheet from the Media for Backing
list box, for example Cassette 1.

Select Print onto Backing if you want the same data to be printed on
the backing sheet as on the transparency.

Click the OK button. The Media tab is displayed again.
Click the OK button to return to the Print dialog box.

Load the paper you want to use for the backing(s) onto the paper
source specified in step 5.

Click the OK button to start printing.

= OOoO~N O O
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Printing Multiple Pages per Sheet

You can print multiple pages on a single sheet of paper, in groups of 1, 2, 4,
6,9, 12, 16, or 25 pages. You can also select the layout of the pages printed
on a sheet.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Layout tab.

3 Select the number of pages to be printed from the Pages per Sheet
drop down list. You may select 1, 2, 4, 6, 9, 12, 16, or 25 pages. The
graphic on the left will change to reflect your selection. If you want to
add borders to each page printed on the sheet, click Print Borders.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media Layout Ilmagingl Walelmarkl F‘lologue!Epi\oguel Dutputl Abaut I

[Pagss per Sheet: ']I [l- FErint Burders]

Layout: IAulo j

Scaling (20 - 500CZ): {1003 ﬂ Gutter Settings

I™ Print o Bath Sides (Duplex):
£~ Fiin on Long Edoe

€= Flig om Short Edge

™ Ennklet Mode:
£ Left Edge Binding
£ Right Edae Binding

Restare Defaults
oK I Cancel | Help |

4 To select the relative position of each page printed on the sheet,
select an option from the Layout drop down list.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media Layout Ilmagingl Walelmarkl F‘lologue!Epi\oguel Dutputl Abaut I

Pages per Sheet; 4 'I ™ Print Borders

Layout: IBollom ta Top and Right j

Bottom to Top and Left
S caling [20 - 500): | Bottomn to Top and Right
caiing ) Left to Right and Dawn
Left to Right and Up =
Right ta Left and Down

Right ta Left and Up k=4

I= Prirt on Bath 4id
£~ Fiip o Long E}

€= Flig om Short Edge

™ Ennklet Mode:
£ Left Edge Binding
£ Right Edae Binding

Restare Defaults
oK I Cancel | Help |

5 Click the OK button to return to the Print dialog box.

6 Click the OK button to start printing.
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Changing the Size of the Document

When you choose the Scaling option, both the height and width of the page
will be scaled according to the percentage selected. The range for the
scaling percentage is 20 % to 500 %.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Layout tab.

3 Select the desired percentage from the Scaling box.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media Layout Ilmagingl Walelmarkl F‘lologue!Epi\oguel Dutputl Abaut I

Pages per Sheet; 1 'I ™| Brint Borders
Layout: IAulo j

I™ Print o Bath Sides (Duplex):
£~ Fiin on Long Edoe

Scaling (20 - 500%). [ERES

Gutter Settings

€= Flig om Short Edge

™ Ennklet Mode:
£ Left Edge Binding
£ Right Edae Binding

Frestore Defaults
oK I Cancel | Help |

4 Click the OK button to return to the Print dialog box.

5 Click the OK button to start printing.
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Changing the Resolution

You can set the resolution of the print job. Available options are: High

Quality (Fast 1200 mode), Proof (600 dpi), Draft (300 dpi), and Custom.

1 Display the printer driver’s Properties dialog box from the

application software.

2 Click the Imaging tab.

3 Select the resolution of the print job from the Print Quality drop

down list.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Lapout | Walelmarkl F‘lologue!Epi\oguel Dutputl Abaut I

Frint Quality:
Ingh Quality i

Grapscale Adjustment:

-m— Brghtness _J— ID—

(P Contrast — J— ’ IU_

TrueTupe Fonts:

¢ Download TrueType fonts as outline
€ Download TrueType fonts as bitmap

) Substitute with Device fants

Font Substitution... | Frestore Defaults |

oK I Cancel | Help |

4 If you want to set Resolution, Kyocera Image Refinement, and
EcoPrint individually, choose Custom and click the _]| button next to
the Print Quality drop down list. Select the options you need in the

Print Quality Settings dialog box.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Layout  Imaging |Walelmark| F‘lologue!Epi\oguel Dutputl Abaut I

Frint Quality:

Grapscale Adjustment:

-m— Brghtness _J— ID_

(P Contrast — J— ’ IU_

TrueTupe Fonts: v

% Download TrueType fi -
] Print Quality Settings

€ Download TrueType fan

i~ Resolution

(7] x]

) Substitute with Device fi .
1200 dpi Fast

£ BO0 dpi
Font Substitution... P

€ 300 dpi

a £ On
Lol

" On
* Off

0K - Kyocera lmage Helinement—‘ "EcoPrnl
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5 Click the OK button. The Image tab is displayed again.
6 Click the OK button to return to the Print dialog box.

7 Click the OK button to start printing.

Adjusting Grayscale

You can adjust the appearance of the graphic images of your printed job by
using the options under Grayscale Adjustment. The Grayscale
Adjustment options are useful if the printed graphic images are too light,
too gray, or too dark.

g Text is unaffected by the Grayscale Adjustment settings.

Note

1 Display the printer driver’s Properties dialog box from the
application software.

Click the Imaging tab.

To lighten or darken the graphic images, drag the Brightness slider.

Wi

Kyocera Mita FS-1900 KX Properties EHE

Mad\al Layout f'maginQ‘l Walelmarkl F’mlngue.pri\ﬂgueI Dutputl About I

Print Quality:
IHigh Quiality hd J

Grayscale Adjustment:

{:} Brightness -—J— IU_

(P Contrast —_— J— ’ IU—

TrueType Fonts:

% Download TrueType fonts as outline
" Download TrueType fonts as bitmap

€= Substitute with Device fonts

FEont Substitution | Restore Defaults |

oK I Cancel | Help |

4 To control the levels of gray, use the Contrast slider.
5 Click the OK button to return to the Print dialog box.

6 Click the OK button to start printing.
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TrueType Fonts

You can specify how TrueType fonts will be sent to the printer. Also you can
substitute a certain font in your document with a specified font. The
selected method will affect the speed at which your print job is produced
and may resolve some font printing issues.

1
2

(& ¢ -5

Display the printer driver’s Properties dialog box from the

application software.
Click the Imaging tab.

To specify how TrueType fonts are sent t
the options from TrueType Fonts:

o the printer, select one of

Kyocera Mita F5-1900 KX Properties [ 7] %]
Media | Layaut : | Walelmarkl F‘lologue!Epi\oguel Dutputl Abaut I
Frint Quality:
Ingh Quality i J
Grapscale Adjustment:
-m— Brghtness = —— J— ID
= +
(P Contrast B —— J— IU
TrueTupe Fonts:
¢ Download TrueType fonts as outline
€ Download TrueType fonts as bitmap
1 Substitute with Device fants
Font Substitution... | Frestore Defaults |
oK I Cancel | Help |

* Select Download TrueType fonts as outline to reduce the file size
for printing a large document, especially if it contains several
fonts or several font sizes. This is the default setting.

* Select Download TrueType fonts as bitmap for a print job with
fewer fonts and similar font sizes, though file size will be larger.

Click the OK button to return to the Print dialog box.

Click the OK button to start printing.
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Watermark Printing

A watermark can be printed in a document. In addition to the existing
watermarks Confidential 1, Confidential 2, Copy, and Sample, a new
watermark can be created. Also the print position, font, size, etc. can be
specified freely.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Watermark tab.

3 Remove the check mark of Disable Feature.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Lawull Imaging W atermark |F‘|ologue.r‘Epi\ogue| Dutputl Abaut I

wiatermark 5election

ICUnhdsnt\al 1 j

Add, Bemove | Edit |

Page Specification:
= Al pages
£~ First page only
£~ All pages except first page
£~ Only on specified pages

Enter page number(s] and/or page ranges
separated by commas. For example 13512

oK I Cancel | Help |

4 Select the desired watermark type from the Watermark Selection
drop down list.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Lawull Imaging W atermark |F‘|ologue.r‘Epi\ogue| Dutputl Abaut I

[ Disable Feature

W

Confidential 2
Copy
Page Bp) Sample

£ Y

oo

£~ First page only
£~ All pages except first page
£~ Only on specified pages

Enter page number(s] and/or page ranges
separated by commas. For example 13512

oK I Cancel Help
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~N O

When creating or changing the watermark, click the Add or Edit
button. The Watermark Properties dialog box opens. Specify the
print position, font, size, etc. The graphic on the left will change to
reflect your selection. Click the OK button. The new watermark will
be added to the Watermark Selection drop down list.

Select All pages, First page only, All pages except first page, or
Only on specified pages for Page Specification.

Kyocera Mita FS-1900 KX Properties EHE
Media I Layﬂull Imaging  Watermark. |F'mlngue.z‘Epi\ﬂgue| Dutputl About I

[~ Disable Featue

watermark. Selection

IConfident\aI 1

[

Add Remove | Edit. |

Page Specification:
& Al pages
€ First page only
€ Al pages except first page
€ Only on specified pages

-

r
I
Enter page number(s] and/or page ranges

separated by commas. Forexample 1.25-12

oK I Cancel | Help |

If you have selected Only on specified pages, enter the numbers of
the pages on which the watermark is to be printed. If you want to
specify more than one page numbers, separate them with commas.
To specify a range of pages, use a hyphen between the starting and
ending numbers in the range. For example, to print the watermark
on pages 5, 11, 12, 13, and 18, type “5, 11-13, 18.”

Click the OK button to return to the Print dialog box.

Click the OK button to start printing.
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Using the Duplexer (DU-60)

You can print on both sides of paper by using the paper cassette, or option
paper feeder if installed.

You can use long-edge or short-edge binding combined with either
landscape or portrait printing. Use Orientation options on the Media tab to
select the page orientation as follows.

These are: (1) portrait, long-edge, (2) portrait, short-edge, (3) landscape,
long-edge, and (4) landscape, short-edge. The figure below shows these

binding setups.
1@
1 I 2 Portrait,
r;?]ﬂtglé, . short-edge
Bin%ingg \ Binding
2 5
(4)
3 Landscape,
3) . 5 short-edge
Landscape, —T Binding
long-edge
Binding
— 2 =

Also if you use the booklet mode, two pages will be printed on one side. You
can make a book type document by folding the output document together.

For the booklet mode, you can specify left edge binding or right edge
binding.

Left edge binding Right edge binding
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1 Display the printer driver’s Properties dialog box from the
application software.

Click the Layout tab.
When printing on both sides, click Print on Both Sides (Duplex) and

then check the Flip on Long Edge or Flip on Short Edge radio
button. The graphic icon will change to illustrate your selection.

WN

Kyocera Mita FS-1900 KX Properties EHE

Media Lapaut Ilmagingl Walelmarkl F’mlngue.pri\ﬂgueI Dutputl About I

Pages per Sheet: |1 'I I Erint Borders

Layout: IAum j
Scaling (20- 500} [100% jl Gutter Settings
I F

& Flip on Long Edge
£~ Flip on Short Edge

™ Booklst Mode:
% [ eft Edge Binding

© Right Felge Binding

Restare Defaults
oK I Cancel | Help |

When using the booklet mode, click Booklet Mode and then check
the Left Edge Binding or Right Edge Binding radio button. The
graphic icon will change to illustrate your selection.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media Layout Ilmagingl Walelmarkl F‘lologue!Epi\oguel Dutputl Abaut I

Fages per Sheet: 2 'I ™| Brint Borders

Layout: IAulo j

Scaling (20 - 500CZ): {1003 ﬂ Gutter Settings

I Print o Bath Sides (Duplex):
£~ Fiin on Long Edoe

{%' Fiig or Short Edge

¥ Booklst Mode:
oy

£ Right Edge Binding

Restare Defaults
oK I Cancel | Help |
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Using the Sorter (SO-60)

Printing from Windows Applications

To set the width of the gutter, click the Gutter Settings button and
enter the desired value in the Gutter field. The width of the gutter
ranges from 5.00 to 25.4 mm or from 0.20 to 1.00 inch.

Gutter Settings EHE
Guiter [ ﬂ i (0.20t01.00)
Click the OK button.

To change the default setting to duplex printing, make this setting
from Windows.

The Print dialog box is displayed again. Click the OK button to start
printing.

When outputting to the sorter, you can select one of the collate mode, group
mode, and mailbox mode. For the function of each mode, see Sorter modes
on page 3-23.

1
2

Display the printer driver’s Properties dialog box from the
application software.

Click the Output tab.

Select Mailbox [Face-down] as Output to drop down list. To
understand sorter modes, see page 3-23.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Lawull Imagingl Walelmarkl Pralogue/Epilogue  Dutput |Ahoul I

bl ~Lopies:

IF'nntsr Default ﬂ I ﬂ

Jaob Settings... | Frestore Defaults |

oK I Cancel | Help |
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4 To use the collate mode, check mark the Collate check box.

Kyocera Mita F5-1900 KX Properties EHE
Media I Layﬂull Imagingl Walelmarkl Prologue/Epilogue  Dutput |Ahﬂul I
Output ko Copies:
IMa\Ibox [Face-down) ﬂ I1 é’
Finishing O ptions:
™ Maibox: Mailboz 1 =
Job Settings. | Restare Defaults |

oK I Cancel | Help |

To use the group mode, remove the check mark of Collate.

Kyocera Mita F5-1900 KX Properties [ 7] ]

Media | Lawull Imagingl Walelmarkl Pralogue/Epilogue  Dutput |Ahoul I

Output bo: Copies:
IMa\Imb [Face-down)] j I‘I ﬂ
Finighing Options:

™ Maibox: tailbos 1 -
Jaob Settings... | Restare Defaults |

oK I Cancel | Help |

To use the mailbox mode, check mark the Mailbox check box and
select a mailbox in the Mailbox drop down list.

Kyocera Mita F5-1900 KX Properties [ 7] %]
Media | Lawull Imagingl Walelmarkl Pralogue/Epilogue  Dutput |Ahoul I

Output bo: Copies:
IMa\Imb [Face-down)] j I‘I

Finighing Options:

I Collate
~

M Maibox: Mailbax 1 o

Jaob Settings... | Restare Defaults |

oK I Cancel | Help |
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Printing from Windows Applications

Sorter Mode

Description

Collate mode

Tray 1
Tray 2
Tray 3
Tray 4
Tray 5

The collate mode delivers the output pages by copy as
shown in the example. This mode is useful when you
need several independent copies of a document.

The maximum number of copies is 5. If a tray becomes
full (approximately 200 pages), the printer pauses and
indicates the Option tray # paper full
message. Then, you will need to remove all the printed
pages from the tray indicated by # in the message.

Inthe example, three copies of a document of 200 pages
long are made, and each copy is stacked in trays 1, 2,
and 3, respectively.

Group mode

200 Copies
of page 1

y

The group mode delivers the output pages by page as
shown in the example. When multiple copies of a file
are printed, all copies of a single page are delivered
together to a single tray.

Tray 1 The maximum number of copies is 200. If a tray
Tray 2 becomes full (200 pages), the printer pauses and
Tray 3 indicates the Option tray # paper full
Trav 4 message. Then, you will need to remove all the printed
ray pages from the tray indicated by # in the message.
Tray 5
In the example, we make 200-copy stacks of each page
200 Copies of an 4-page long document.
of page 4
Mailbox mode 1 to 5 The mailbox mode delivers the printed pages to the
tray you specify on the printer driver.
Tray 1 . -
Trav 2 When the sorter tray becomes full, the printer indicates
ay theOption tray # paper full message and pauses
Tray 3 until you remove all the pages in the sorter tray
Tray 4 indicated by # in the message.
Tray 5

In the example, sorter tray 5 is specified to receive the
printed pages.

Click the OK button in the Properties dialog box. The Print dialog
box is displayed again. Click the OK button to start printing.

Download from Www.Somanuals.com. All Manuals Search And Download.



Printing from Windows Applications

e-MPS

Job Retention

This function allows you to save print jobs to the option Microdrive and
print them out as desired at the operator panel.

When printing, select a Job Retention mode at the printer driver. The
following four modes are available:

*  Quick Copy Printing ..........ccccceeveennnen. See page 3-26
* Proof and Hold Printing ...................... See page 3-28
* Private Printing ........cccccceeeevveeeeeennnen. See page 3-30

* Stored Job Printing (Job Storage) ...... See page 3-32
For how to make the settings, see the pages of the respective modes.
Four Job Retention modes have the following benefits:

*  Quick Copy: When you need another copy of a finished print job, you
can print it out at the printer operator panel. There is no need to print
from the computer again.

* Proof and Hold: When printing multiple copies, this mode first prints
only one copy for proofing, allowing you to decide whether to continue
printing the remaining copies or cancel printing at the operator panel.
In this way, you can reduce the waste of paper.

* Private Print: Confidential print jobs can be printed out when you are
at the printer. This mode saves print jobs in the printer without
printing until you instruct the printer to do so at the operator panel.
Printing using this mode requires the 4-digit PIN number you set using
the printer driver.

+ Stored Job (Job Storage): This mode allows you to store print jobs
that are frequently needed, such as fax cover pages, checklists, and
order forms, for printing later. Using the operator panel, you can then
print them out as required at anytime and at any number of copies.
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Virtual Mail Box

Virtual mailbox is the ability to store print jobs in the virtual mailboxes on
the Microdrive, enabling you to retrieve and print it later from the printer's
operator panel.

You can later print out only the jobs you desire using the operator panel on
the printer.

When printing, make the settings at the printer driver. For how to make
the settings, see Virtual Mailbox Printing on page 3-34.

You can send a print job either to all the virtual mail box trays at the same
time or to the desired trays only.

Since you perform printing by selecting the desired trays using the
operator panel, you can print out only the jobs you desire.

Code Job (Temporary and Permanent)
Job Storage reduces the time to print multiple copies.

When printing, select a type of code job at the printer driver. The following
two types of code jobs are available:

* Permanent Code Job
* Temporary Code Job
For how to make the settings, see Printing a Code Job on page 3-39.

You can print out frequently needed print jobs, such as fax cover pages,
checklists, and order forms.

You can print a list of code jobs at the operator panel. There are two types
of code jobs: permanent code job and temporary code job. When the storage
memory becomes insufficient, temporary code jobs will be automatically
deleted in order from the oldest and permanent code jobs will not.
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Using Job Retention

Quick Copy Printing

This allows you to print as many additional copies as you want until the
printer is turned off, it is useful in cases such as when there are sudden

increases in the required number of copies during a meeting.

To print, proceed as follows.

1
2

Display the printer driver’s Properties dialog box from the
application software.

Click the Output tab and then click the Job Settings button.

Kyocera Mita F5-1900 KX Properties

Media | Layout | Imaging | Wwatermark | F'mlngue./‘Epi\ﬂguhnul |

Output ko Copies:

a4

IF'rinter Diefaul

Finishing O ptions:

I” Collate

Restare Defaults |

oK Cancel | Help |

The Job Settings dialog box will appear.

[Z]x]

Job Settings

[ Job Storage [=MPSE

1% Temporany

| Permanent:

€ Vittual il Bo (YMB]
= Quick Copy

| Proct and|Held

1= Priate Pt

= ot Storage

- ot N ame

1% fipplication Defined

= Custom

—

Reset |

|
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3 Check the Job Storage (e-MPS) checkbox and then check the Quick
Copy.

Job Settings [ 7] ]

L3

" Temporary
' Peimanent:

 Yittuel bzl B [MB]

& LuckCond

" Proof and Hold

" Private Print
 Job Storage
~Job Mame

1+ Application Defined
1~ Custom

4 Click the OK button. The Print dialog box is displayed again. Click
the OK button to start printing. The print job will be saved to the
Microdrive as it is printed.

If additional copies are required, print using the Quick Copy menu
in the e-MPS menu at the printer operator panel. For details, see
page 1-57 in the Operation Guide.

3-27

Download from Www.Somanuals.com. All Manuals Search And Download.



Printing from Windows Applications

Proof and Hold Printing

You can check the first copy before printing the remaining copies, paper
wastage can be avoided. The print jobs will be deleted when the printer is
turned off.

To print, proceed as follows.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Output tab and then click the Job Settings button.

Kyocera Mita F5-1900 KX Properties

Media | Lawull Imagingl Walelmarkl F‘lologue!Epi\oguhoul I

Output bo: Copies:

[Frinter Detaut = =

Finighing Options:

I Collate

Restare Defaults |

oK Cancel | Help |

The Job Settings dialog box will appear.

Job Settings HE

¥ | Tiemporany

1= Bemmarient:

=1 irtual Ml Bax [VME]
) Quick Copy

€ Piost and Hold

= Fiiyate Fiirt

) Job Storage

- Job e

% Application Defined

= Custom
Reset | Lancel |
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3 Check the Job Storage (e-MPS) checkbox, and then check the Proof

and Hold.

Job Settings

[Z]x]

l* v Job Storage (e-MPS) ||

" Temporary

' Peimanent:

€ Vittual il Bo (YMB]
" Quick Copy

& Proof and Held

" Private Print

" Job Stojage

@ED

i~ Job Name

1+ Application Defined

1~ Custom

—

Reset |

|

4 Click the OK button. The Print dialog box is displayed again. Click
the OK button to start printing. The print job will be stored to the
Microdrive as it is printed.

The printer will first print only one copy if you set to print multiple
number of copies, allowing you to check the printouts. If there is no
problem, resume printing the remaining copies using the Quick
Copy menu in the e-MPS menu at the printer operator panel. For
details, see page 1-59 in the Operation Guide.
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Private Printing

You need to enter a password at retrieving the job, confidentiality is
assured even if you share the printer with others. Print jobs will be deleted
when they are printed or when the printer is turned off.

To print, proceed as follows.

1
2

Display the printer driver’s Properties dialog box from the
application software.

Click the Output tab and then click the Job Settings button.

Kyocera Mita F5-1900 KX Properties

Media | Lawull Imagingl Walelmarkl F‘lologue!Epi\oguhoul I

Output bo: Copies:

[Frinter Detaut = =

Finighing Options:

I Collate

Restare Defaults |

oK Cancel | Help |

The Job Settings dialog box will appear.

Job Settings HE

¥ | Tiemporany

1= Bemmarient:

=1 irtual Ml Bax [VME]
) Quick Copy

€ Piost and Hold

= Fiiyate Fiirt

) Job Storage

- Job e

% Application Defined

= Custom
Reset | Lancel |
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3 Check the Job Storage (e-MPS) checkbox, and then check the
Private Print.

Job Settings [ 7] ]

'* v Job Storage (e-MPS) ||
EC=

" Temporary
' Peimanent:

= Yittuel izl B [MB]

" Quick Copy
" Proot and Held
—
1+ Private Print Access Code:
© Job Storage [1z=4 4
~Job Mame

& application Defined
1~ Custom

Reset | LCancel |

4 Set the desired 4-digit access code using any numbers between 0 and
9. This number is synonymous to user ID which is required to enter
at the printer operator panel when retrieving.

5 Click the OK button. The Print dialog box is displayed again. Click
the OK button. The print job will be stored to the Microdrive without
printing.

To print, use the Private/Stored menu in the e-MPS menu at the
printer operator panel. For details, see page 1-61 in the Operation
Guide.
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Stored Job Printing (Job Storage)

Select this if you want to store frequently needed print jobs, such as forms,
to print them later as required. The print jobs will not be deleted when the

printer is turned off.

To print, proceed as follows.

1 Display the printer driver’s Properties dialog box from the

application software.

2 Click the Output tab and then click the Job Settings button.

Kyocera Mita F5-1900 KX Properties

Media | Lawull Imagingl Walelmarkl F‘lologue!Epi\oguhoul I

Output bo: Copies:
[Frinter Detaut = =

Finighing Options:

I Collate

Restare Defaults |

oK Cancel | Help

The Job Settings dialog box will appear.

Job Settings HE

¥ | Tiemporany

1= Bemmarient:

=1 irtual Ml Bax [VME]
) Quick Copy

€ Piost and Hold

= Fiiyate Fiirt

) Job Storage

- Job e

% Application Defined

= Custom
Reset | Lancel |
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3 Check the Job Storage (e-MPS) checkbox, and then check the Job

Storage.
Job Settings EHE
'* v Job Storage (e-MPS) )
—_— n
)= ﬂ
" Temporary
' Peimanent:
€ Vittual il Bo (YMB]
" Quick Copy
" Proot and Held
" Private Frirt I™ Access Code:
- B
~Job Mame
& application Defined
1~ Custom
Reset | LCancel |

4 You can add security to the print job. To do so, check the Access
Code checkbox and enter the desired 4-digit access code using any
numbers between 0 and 9. You must enter this number at the printer
operator panel when printing.

Job Settings

v Job Storage [e-MPS)]

" Temporary

' Peimanent:

€ Vittual il Bo (YMB]
" Quick Copy

" Proot and Held

[Z]x]

s ()

" Private Print W ficcess Coded
' Job Storage |1234
~Job Mame
& application Defined
1~ Custom
Reset | LCancel |

5 Click the OK button. The Print dialog box is displayed again. Click
the OK button. The print job will be stored to the Microdrive without

printing.

To print, use the Private/Stored menu in the e-MPS menu at the
printer operator panel. For details, see page 1-63 in the Operation

Guide.
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Virtual Mailbox Printing

Virtual Mailbox function is available only when PCL 5e or PCL XL is
selected as emulation.

Virtual mailbox is the ability to store print jobs in the virtual mailboxes on
the Microdrive, enabling you to retrieve and print it later from the printer's
operator panel. A maximum of 255 virtual mailboxes can be set up, making
it possible to allocate documents not just for individual departments or
groups, but even for individual people. The print jobs will not be deleted
when the printer is turned off.

Before Using Virtual Mailboxes

To use the virtual mailbox function, select PCL XL or PCL 5e emulation
and then set the Mailbox Name and Virtual Output Tray beforehand. Follow
these procedures.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1900 KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-1900 KX Properties [ 7] ]

I W atermark. |
About

General | Details I Color Management I
Prologue/E pilogue | Output

Device Options:

@ Paper Feeder (Cassette 1)
[JPaper Feeder [Casselte 2]
[ Paper Feeder (Cassette 3
ElPaper Feeder (Cassette 4]

OEnvelope Feeder

[(JBulk Feeder

O Duplex Unit

O Sorter Stacker

[CIBulk Stacker

BAHard Disk.... ;I

User... M emany: |1EME é’
Ldministrator.... Fish Disk |7 MB é’

oK I Cancel Lipply Help
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4 Click the User button. The User Settings dialog box is displayed.

Kyocera Mita F5-1900 KX Properties

Details

General I
Prolague/E pilogue:

2]
I Calor Management I Media | Layout | Imaging I \Watermark. I
| (Output i Device Settings Ahout
Device Options:
[ Paper Feeder [Cassette 1] -
[Paper Feeder (Cassette 2)
[l Paper Feeder [Casselte 3]
[ Paper Feeder (Cassette 4]
OEnvelope Feeder
CBulk Feedsr
[ Duplex Urit
[ Sarter Stacker
CBulk Stacker
Hard Disk. |
[ User Memay:  [1EWE =]
A Disk [T =

Adminidtratar.

Cancel ||

User Settings [ 2] x]
i~ Identification
User Name:
Department

5

User Settings

[Z]x]

- Identification

User Mame:

Department:

— Page Description Languaae

GDI compatible mode

Settings |

¥ Inches

= Milimeters

|

~Pags Desciption Languag

PCLKL +| I GDI compatible mode
Settings...

1 Milimeters

Uni
’76‘ Inches

Select PCL XL or PCL 5e in the Page Description Language drop
down list, and click the OK button.
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Double-click Hard Disk in the Device Options list. The Hard Disk
Settings dialog box will be displayed.

Kyocera Mita FS-1900 KX Properties EHE
General I Details I Calor Management I Media | Layout | Imaging I \Watermark. I
Prologue/E pilogue I Output Device Settings About I

Device Options:

W Paper Feeder (Cassette 1
OPaper Feeder [Caszette 2
[El Paper Feeder (Cassette 3
[ Paper Feeder (Cassette 4
OEnvelope Feeder

[ Sarter Stacker

Hard Disk Settings [2]x]

— Wirtual Mail Box [VMB]

Mailbox Name: Defined Names:

User.

administrator “irtual Output Tray:

> Enter trap numbers and/or tray ranges

separated by commas.
For example: 1, 3,512,

Delete | Save |

|

7 Enter the mailbox name in the Mailbox Name, and the tray number
in the Virtual Output Tray, and then click the Save button.

Hard Disk Settings EHE

—irbual b ail Box [¥MB)
TMabox Mame: . Pefined Mames:
[me1

“irtual Output Tray:
[

Enter bray v cobiecs andfor bay ey
separated by commas.
For example: 1, 3,512,

Delete | Save |

|

Multiple virtual mailbox tray number can be specified at a time using
commas (,) and hyphen (-).

“Note
The mailbox name will be displayed in the Defined Names list box.

Hard Disk Settings [2]x]

— Wirtual Mail Box [VMB]
Mailbox Name: Defined Names:

| =D

“irtual Output Tray:

Enter trap numbers and/or tray ranges
separated by commas.
For example: 1, 3,512,

LCancel |
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Using VMB Printing

Click the OK button.

To print, proceed as follows.

1
2

Kyocera Mita F5-1900 KX Properties

Med\al Lawull Imagingl Walelmarkl F‘lologue.r‘Epi\ogu

Output bo:

Printing from Windows Applications

Click the OK button to quit the Hard Disk Settings dialog box.

Display the printer driver’s Properties dialog box from the
application software.

Click the Output tab and then click the Job Settings button.

Copies:

IF'nntsr Default

|

Finighing Options:

I Collate

Restare Defaults |

0K

Cancel | Help |

The Job Settings dialog box will appear.

Job Settings

[2]x]

¥ | Tiemporany

1= Bemmarient:

=1 irtual Ml Bax [VME]
) Quick Copy

€ Piost and Hold

= Fiiyate Fiirt

) Job Storage

o ham:
% Application Defined
= Cystom

—

Reset |

|

3-37

Download from Www.Somanuals.com. All Manuals Search And Download.



Printing from Windows Applications

3

Check the Job Storage (e-MPS) checkbox, and then check the Virtual
Mail Box [VMB].

Job Settings [ 7] ]

' v Job Storage [e-MPS) ||
Hl-= g

" Temporary

" Peimanent:

" Quick Copy
" Proot and Held

" Private Print
" Job Stojage Selection, |
~Job Nam
% Application Defined
1~ Custom
Reset | LCancel |

Click the Selection button. The Virtual Mailbox Selection dialog box
will appear. Select one or more mail-boxes from the list of Defined
Names.

Job Settings [ 7] ]
v Job Storage [e-MPS)]
O |—c=2 gg
" Temporary
' Peimanent:

" Quick Copy
" Proot and Held

" Private Print
" Job Stojage Selection, |
~Jab Nam . *
& Application Defined Virtual Mailbox Selection HE
7 Custom Defined Names
Y]
Reset | LCancel
G|

Click the OK button. The Print dialog box is displayed again. Click
the OK button. The print job will be stored to the Microdrive without
printing.

To print, use the Print VMB Data menu in the e-MPS menu at the
printer operator panel and specify the virtual mail box numbers. You
can also print the list of virtual mail box trays. For details, see page
1-68 in the Operation Guide.
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Printing from Windows Applications

A unique number is automatically assigned to each job as it is stored on the
printer. The number appears when jobs are listed in utilities included in
the CD-ROM such as Printer Disk Manager or KM-NET VIEWER. The
number is also printed on the Job List that can be printed using the List
of Code Job menu of the printer.

To print, proceed as follows.

1
2

application software.

Kyocera Mita F5-1900 KX Properties

Media | Layout | Imaging | Wwiatermark. | Prologue/E piloous

Display the printer driver’s Properties dialog box from the

Click the Output tab and then click the Job Settings button.

Lol

Output ko Copies:
IF'rinter Diefaul ﬂ I1 :
Finishing O ptions:

I™ Collate I ! ]

Restare Defaults |

Cancel | Help |

The Job Settings dialog box will appear.

Job Settings

[ Job Storage [=MPSE

[Z]x]

1% Temporany

| Permanent:

€ Vittual il Bo (YMB]
= Quick Copy

| Proct and|Held

1= Priate Pt

= ot Storage

ot s
1% fipplication Defined
= Custom

—

Reset |

|

3

Permanent radio button.

Check the Job Storage (e-MPS) checkbox and then the Temporary or
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Printing from Windows Applications

Click the OK button. The Print dialog box is displayed again. Click
the OK button to start printing. The print job will be stored to the
Microdrive as it is printed.
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